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CHAPTER

1

MAXPRO®VMS R
ABOUT MAXPRO® VMS
Introducing MAXPRO® VMS
MAXPRO® Video Management System (MAXPRO® VMS) is an enterprise-class 
video management and hybrid solution. It enables you to operate the traditional 
analog, network and IP based video equipment in the same surveillance network. 
You can deploy thousands of cameras in number of locations, and add many video 
devices such as recorders and monitors. 

Intended Audience
This guide is intended for the operators of MAXPRO VMS system.

Advantages
• Scalable and Future Oriented – Over time, the video surveillance system must 

be capable of scaling up or down to meet the changing organization 
requirements. MAXPRO VMS’s client-server architecture can easily adapt to the 
changing requirements. Expanding or downsizing your video surveillance 
system is easier. In addition, MAXPRO VMS's architecture focuses on 
implementing and integrating more features. For example, more recorder types 
can be integrated to MAXPRO VMS in the near future.

• Robust and Capable – MAXPRO VMS can be configured to manage video feeds 
from thousands of cameras. You can add multiple recorders and switchers to 
your video surveillance network and remotely monitor the locations. Refer to 
Performance Capacity Document (PCD) for more information.

• Open Architecture - MAXPRO VMS is built using industry standard protocols 
and technologies, which give you the added advantage of selecting the best 
available IP cameras and streamers for your video surveillance network. 

• Integration Capability - MAXPRO VMS is designed to integrate seamlessly with 
other enterprise systems like access and intrusion control in the near future.
670 Operator’s Guide 9



• User Friendly and Feature Rich – MAXPRO VMS’s user access based and easy-
to-use user interface enables you to configure and manage every element of the 
video surveillance network. Using the user interface, you can easily add 
cameras, recorders, and other devices, and create new video surveillance 
locations and users.

• Effective Site Monitoring locations is more effective through features like color 
correction, digital zoom, operator messaging, logical partitioning of video 
devices, analytic features like motion detection, and others.

• Redundancy support - MAXPRO VMS software includes support for 
Redundancy where you can configure a redundant recorder for unforeseen/
maintenance scenarios. It allows you to configure the Redundant recorder using 
various Failover constraints. There are various Failover constraints that you can 
configure (Automatically/Manually) to trigger the Failover. Refer the MAXPRO® 
VMS Installation and Configuration Guide for more details on how to configure the 
Redundancy recorder.

• Search for Recorded Video and Events - Search feature enables you to search for 
recorded video and events in various recorders.

• Event Handling - Events such as failure of camera or loss of video can be logged 
and event reports can be generated. You can retrieve and view video pertaining 
to specific events. In addition, you can configure alarms to notify the operators 
when events occur.

• Reports - You can also generate reports to view user activities such as creation 
of clips, configuring of devices, and other activities performed by a user.

MAXPRO VMS Features
The following are the new features in MAXPRO VMS:

New Features in R670 Release

Mask Compliance Detection 
Mask Compliance Detection feature detects the people who are with and without 
Masks in a given scene. This feature detects in a real time scenario and generates an 
event for People with/without mask. It helps in monitoring the people those who are 
violating the compliance of not wearing a mask in public places. This feature 
requires dedicated license to configure and use. 

Social Distancing Violation Detection 
Social Distancing Violation detection feature detects distance between two people 
and raises an alarm if the social distance norm is violated. This feature helps to 
ensure social distancing is followed in your premises. This feature requires dedicated 
license to configure and use.
10 MAXPRO®VMS R670 Operator’s Guide 



Non-Compliant Social Distancing Regions
This feature helps user to identify the areas in which the sub regions/areas of cam-
era views where the most number of Non-complaint social Distancing violations are 
happening.
In order to generate this alarm, user need to create at least one region. The system 
monitors the Social distancing violations and then monitors in to each region how 
many social distancing violations are occurred. The algorithm calculates the most 
violated regions and raises an alarm. This alarm is displayed in percentage of viola-
tion for a given time. This alarm is generated periodically every 5 hours (Configu-
rable). A maximum of 6 ROI’s can be created.

Analytic Alarms In NVR
The below screen displays the list of alarms that are generated in NVR for Mask 
Detection, Social Distancing violation and Non-Compliant Social Distancing 
Regions features.

Analytics Tab
In VMS R670 release LPR tab is changed to Analytics tab to display LPR, Facial 
Recognition and Social Distancing Violation alarms in one place. You can view real 
time alarms fetched from the Analytics camera and take specific actions on the 
alarms.
MAXPRO®VMS R670 Operator’s Guide 11



Scalable Analytic Server
This feature is introduced to manage the load on a NVR box while rendering analyt-
ics based cameras. Earlier only one local analytics server was available for multiple 
cameras that support analytics. This results in high consumption of CPU and low 
rendering capability of live video in NVR cameras. 
Scalability feature helps customer to share the analytics server load on different 
remote machines and utilize the analytic algorithms efficiently. User can map the 
required cameras to each remote server and view the alarms in VMS,,

Bulk configurations of cameras from NVR
This feature allows you to perform Bulk camera configuration for main and sub 
stream’s, to ease the effort of configuring multiple cameras at the customer site. This 
feature improves the productivity for dealers and system integrators while configur-
ing many NVRs. The configuration of cameras from the NVR is done one by one 
today (either post discovery or manual addition). This leads to higher lead time to 
configure and setup customer sites. Refer to the MAXPRO VMS R670 Installation 
and Configuration Guide on how to configure and use this feature.

Bi-Directional Audio Support for MAXPRO NVR
This feature helps an operator to send Bi-directional audio warnings/messages to 
any audio output of cameras from MAXPRO VMS machines. Currently Mic and 
speech is supported from VMS viewer only.

This feature supports standard audio Codec format G.711 ulaw and only Honeywell 
ONVIF Camera model are supported.

Series 60 Camera Integration
MAXPRO VMS R670 supports Series 60 Camera integration with MAXPRO NVR 6.7 
recorder. The following tables explain the list of supported camera models and firm-
ware details.
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Support for Ex-Proof Camera models
MAXPRO VMS R670 supports Ex-Proof Camera integration with MAXPRO NVR 6.7 
recorder. The following tables explain the list of supported camera models, Codec 
and Resolutions supported.

Support for Video Analytics Server - AllGovision
MAXPRO R670 released supports Allgovision Analytics Server for non Facial and 
License Plate Recognition features. The following alarms are supported and dis-
played in Analytics tab. Refer to the MAXPRO VMS R670 Installation and Configura-
tion Guide on how to configure and use this feature and view these alarms.

Type Camera Models Firmware Details

Premium Model

HC60W35R2

Honeywell_60-
Series_IPC_HC60WXXRX_V1.0.21.20200
828

HC60W35R4

HC60W45R2

HC60W45R4

HC60WB5R2

HC60WB5R5

HC60WZ2E30

Mainstream Model

HC60W34R2L

HC60W34R2

HC60W44R2L

HC60W44R2

HC60WB4R2L

HC60WB4R2

Series60 IR PTZ HC60WZ5R30

Series30 HC30W25R3-12V

Camera Models Codec & FPS 
Supported Resolutions Supported

HEIPTZ-2201W-IR H264, H265, MPEG
FPS: 50 for PAL 
FPS: 50 for NTSC

1920 x 1080, 1280 x 960, 1280 x 720, 
704 x 576, 640 x 480, 352 x 288

HEICC-2301T H264, H265, MPEG
FPS: 50 for PAL 
FPS: 60 for NTSC

1920 x 1080, 1280 x 960, 1280 x 720, 
704 x 480, 640 x 480, 352 x 240

Alarms Alarms Alarms
Trespass Vehicle Counting Safety Gear Detection

Loitering Wrong Way Detection Jaywalking

Tripwire Over speeding Detection Pedestrian Counting

Left Object Detection Traffic Signal Detection Pedestrian Dwell Time
MAXPRO®VMS R670 Operator’s Guide 13



IDEMIA Server Integration for FR 
IDEMIA server allows you to Integrate the VMS/NVR and Cameras with Facial Recog-
nition based analytics server for leveraging the facial recognition and analytics 
capability (ability to blacklist/white-list). This server handles the FR based analytics 
alarms/events on the VMS thick client. Also integrates the additional analytics 
events of IDEMIA in Analytics tab. Refer to the MAXPRO VMS R670 Installation and 
Configuration Guide on how to configure and use this feature
User can perform the following: 

• Monitor FR analytics server alarms MAXPRO VMS Analytics tab

• Enable/disable alarms per FR Analytics server

• Access the details related to Analytics server 

• View Bounding boxes on the analytics tab for the events coming in.

• Acknowledge events coming into the analytics tab

• Search the events with description or confidence score and filter based on 
specific analytics type

• View the associated clip with the event

• View additional analytics events from IDEMIA

• Real-time alert based on face/body /clothing identification

• Crowd analysis

• Intrusion detection

• Person and object counting

People Counting License Plate Recognition Yellow Box Violation

Camera Tampering License Plate Detection Illegal Lane Change

Missing Object 
Detection

Vehicle Halt Detection Wrong Lane Violation

Illegal Parking Speed Drop Detection No Flame Detection

Vehicle Congestion Face Recognition Social Distancing Violation

Tailgating Auto PTZ Tracking No Mask Detection

Crowd Detection Graffiti Detection Accident Detection

Counter Flow Garbage Detection

Video Smoke Detection Video Loss Alarm

Fire Detection Slot Based Parking 
Management

Slip and Fall Detection Fog Detection

Face Detection Gesture Recognition

Queue Management Crowd Behavior Analysis
14 MAXPRO®VMS R670 Operator’s Guide 



Intelligent Command Support
MAXPRO Intelligent Command is a common user interface that provides valuable 
enhancements to security systems. These ensure compliance with stringent industry 
regulations. For instance, Intelligent Command enables operators to respond rapidly 
and effectively to alarms or incidents by providing a Standard Operating Procedure 
(SOP) that shows the process that should be followed. This reduces both compliance 
exceptions and security risks. 

The MAXPRO interface gives users a stronger situational awareness of the whole 
security system through a single map view of all the access, video and intrusions 
solutions. See IC User guide for detailed information.

New Features in R630 Release

Mask Compliance Detection 
Mask Compliance Detection feature detects the people who are with and without 
Masks in a given scene. This feature detects in a real time scenario and generates an 
event for People with/without mask. It helps in monitoring the people those who are 
violating the compliance of not wearing a mask in public places. This feature 
requires dedicated license to configure and use. See Mask Compliance 
Detectionsection how to configure and use this feature.

Social Distancing Violation Detection 
Social Distancing Violation detection feature detects distance between two people 
and raises an alarm if the social distance norm is violated. This feature helps to 
ensure social distancing is followed in your premises. This feature requires dedicated 
license to configure and use. See Social Distancing Violation Detectionsection how 
to configure and use this feature.

Alarms for both Mask Detection and Social Distancing
Following are the list of alarms that are generated in NVR for Mask and Social Dis-
tancing detection features:

• Person Detected with Mask

• Person Detected without Mask

• Social Distancing Violation

Operating Conditions
There are various recommendation with respect to operating conditions for both 
Mask Detection and Social Distancing to give good results. It is recommended to 
refer these operating conditions before using these feature. See Recommended 
Operating Conditions For Mask Detection and Recommended Operating Conditions 
For Distancing Violation detectionsection for more information.
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Support for Remote Analytics Server 
MAXPRO R630 released support for Remote analytics Server configuration for Mask,   
Social Distancing and SVMD on i8700 Machines. This configuration is required if the 
existing systems are not capable to take up the load of Analytics and to avoid over-
shoot of system resources memory. Refer to the MAXPRO NVR R630 Installation and 
Configuration Guide on how to configure.

Note: Analytics server is supported only on Windows 10 OS platform.

People Counting Dashboard Utility 
VMS Occupancy Dashboard Utility allows you to track the number of people entered 
or exited from a specific area or premises or pathway. This utility helps to manage the 
space in commercial buildings to take appropriate actions based on the number of 
people entered or exited. The Occupancy Dashboard displays the Occupancy Sum-
mary and Trend based on the cameras configured and duration. This utility needs to 
be used along with MAXPRO VMS and HVA.
The actions are:

• Monitoring/Managing parking area/building

• Space management in big stadiums/shopping mall

See People Counting VMS Dashboard Utility section for more information on config-
uration.

VMS in VMS support for Mask and Social Distancing Detection
MAXPRO VMS R630 release supports Mask and Social Distancing Violation Detec-
tion support for VMS in VMS scenario with Bounding boxes. User can view bounding 
boxes in both Master and Child VMS recorders. This enhancement allows user to 
track the Mask and Social Distancing alarms and events in a wide range of recorders 
For Master VMS both Alarm and events along with attributes are supported. For 
Child VMS attributes are not supported.

User need to enable View Annotations in Preference dialog box after configuring 
VMS in VMS.

Faster Drag and Drop for MAXPRO NVR cameras in MAXPRO VMS 
client 

The time taken for the video to render in VMS client after drag and drop on to the 
video panel has been considerably improved. This feature requires a configuration to 
be enabled.
To enable this feature user need to configure the values in config files based on 32/
64 bit rendering modes. Refer to the MAXPRO VMS R630 Installation and Configu-
ration Guide on how to configure.
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Series 60 Camera Integration
MAXPRO VMS R630 supports Series 60 Camera integration with MAXPRO NVR 6.3 
recorder. The following tables explain the list of supported camera models, and 
events/alarms supported.

Supported Events/Alarms 
Series 60 Camera models support the following events/alarms:

Supported key Features
• HTTPS integration: The camera supports complete HTTPS protocol while 

integrating with NVR.

• Smart Stream III

• Smart Codec

Type Camera Models Firmware Details

Premium Model

HC60W35R2

Honeywell_60-
Series_IPC_HC60WXXRX_V1.0.21.20200
828

HC60W35R4

HC60W45R2

HC60W45R4

HC60WB5R2

HC60WB5R5

HC60WZ2E30

Mainstream Model

HC60W34R2L

HC60W34R2

HC60W44R2L

HC60W44R2

HC60WB4R2L

HC60WB4R2

Event
Tampering

Image too bright

Image too dark

Image too blur event

Motion Detection

Intrusion Detection

Loitering Detection

Line crossing Detection

Unattended Object 
Detection

Missing Object Detection

Face Detection
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• Smart FPS

• Dynamic intra Frame Period (DIF)

• Alarms

• Profile S compliant

• Multicast

• Edge Sync Recording Support

• Full Encrypted Communication (including Encrypted Profile G communication)

Thermal Camera Integration - HRCF-FD384H/HRCF-FD640H
MAXPRO R630 supports integration of Silent Sentinel and Thermal Cameras. Fol-
lowing are the cameras and firmware details:

Refer the MAXPRO integration with MODUM Technical Notes for detailed informa-
tion on the how to integrate the HRCF-FD384H/HRCF-FD640H Thermal cameras 
with MAXPRO NVR.

New Features in R600 Release

SSA - Software Service Agreement for MAXPRO
Software Service Agreement (SSA) is a flexible version specific licensing process 
which allows a user to get the support on the MAXPRO VMS licenses across multi-
ple versions. From R600 release user need to buy a valid license to upgrade or for 
fresh installation. In addition, user can buy SSA support license for a specific dura-
tion which helps to get support from Honeywell.

Please contact Honeywell Customer support. See the back cover for the contact 
information in respective regions. Refer to the MAXPRO® VMS Installation and 
Configuration Guide.

Type Camera Model Firmware Details

Silent Sentinel
HRCF-FD640H

V4  : v1.0.1D20200603HRCF-FD384H

Thermal Camera
HVCT-B4010I

V5.5.26 build 200514HVCT-B4020I

HVCT-D4010I
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License Plate Recognition (LPR) 
Enhancements has been made in LPR feature to support events with cropped 
images, categorization and details pane. LPR scans can be monitored through a 
dedicated window in MAXPRO thick client. This new windows also supports filter-
ing and searching events based on camera and category (White/Black listed/
unknown).In addition you can also view the specific event video from the LPR feed. 
Refer to the MAXPRO® VMS Installation and Configuration Guide and LPR User 
Guide.

NDAA Series 30 camera Integration in MAXPRO NVR & VMS
Series 30 Camera integration is supported in R600 release with MAXPRO NVR 
recorder. The following tables explain the list of supported camera models, firm-
ware version and events.

Note: HC30WF5R1 model camera does not support HTTPS.

Supported Events
Series 30 Camera models support the following events:

# Camera Models Firmware Details

1 HC30W42R3

v1.0.18.20190523
Note: If a camera has older firmware, please 
upgrade to this firmware version or above   
and perform factory default once.

2 HC30W45R3

3 HC30W45R2

4 HC30WB2R1

5 HC30WB5R1

6 HC30WB5R2

7 HC30WE2R3

8 HC30WE5R3

9 HC30WE5R2

10 HC30WF5R1

Event

Motion Detection 

Tamper

Image too blur

Image too dark

Image too bright

People Detection

Intrusion
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Supported key Features
• Smart Stream III

• Smart Codec 

• Smart FPS

• Dynamic intra Frame Period (DIF)

• HTTPS

• Alarms

• Profile S compliant

• Multicast

Secure video communication with Series 30 Cameras
Refer to the 800-25609-A_Honeywell 30 Series IP Cameras Network Security 
Guide for complete details.

MPEG2 Encoder Support with MAXPRO NVR and VMS
R600 supports legacy MPEG2 Encoders with Live and playback, Alarms and VMS in 
VMS functionalities. The following encoders are supported. 

• ENC8M2 

• VE8M2

Supported Firmware Version: 1.2.261
Supported Features are:

• Alarms

• VMS in VMS

• Live

• Playback

• Export 

• Only Multi casting streaming address

User Experience Improvements in MAXPRO VMS Thick Client
A complete user interface reskin (Black theme) for MAXPRO VMS thick client with 
improved user experience based is implemented in R600 release.

This includes the following:

• Main Panels 

• Left Panel 

• Calendar look and feel 

• Alarm flashing: Controlled on Thick client using config file
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• Clip buttons

• Icons

• Docking controls 

• Utility Drop-down, Digital correction and Create Salvo window

• Preferences drop-down, preferences window and all popup windows

• About box

• Clip Export window and clip export status window

• License window

Recorders Supported
Following are the default supported recorders for R600. Other recorders are not 
part of the installation. Please contact Honeywell Tech support team for support. 
See the back cover for contact information.

• MAXPRO NVR

• Performance Series Embedded NVR

• ADPRO XO

• VMS in VMS

Video Guard service for SIRA compliance
MAXPRO R600 release supports SIRA compliance with Video Guard Agent. This is 
to meet the specifications defined as part of the City wide Surveillance initiative by 
the Security Industry Regulatory Agency (SIRA) of Dubai, UAE, and being adopted 
across Middle-East countries. Refer to the MAXPRO® VMS Installation and Con-
figuration Guide.

New Features in R560 Release

Smooth Reverse Playback
This is an enhancement to the existing reverse playback feature in MAXPRO VMS 
and it is recommended for the sites with lower GOP settings. Smooth reverse play-
back allows user to view the reverse playback operation without any jerk in the 
playback video. Depending on the FPS and GOP setting in NVR camera properties, 
smooth playback video is displayed. Its is recommended to set the GOP value in 
the range of 5 to 10 to experience smooth reverse. This helps to view the best in 
class playback video during site monitoring and investigation without dropping 
video frames. This enhancement is supported only with MAXPRO®NVR recorder 
and user can enable this option in MAXPRO VMS > Preferences tab. User can per-
form and experience the following reverse playback functions smoothly.

Note: For smooth reverse playback, it is recommended to use lower GOPs (i.e less than FPS. 
For Example: 30FPS/5GOP, 30/10,10/10 and so on)
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• Smooth playback in reverse direction for speeds upto 2x

• Key frame reverse playback at 4x, 8x and 16x speed

• Reverse playback on slow speed (1/8x to 1/2x)

• Reverse playback for multiple cameras

• Reverse playback for multiple cameras in Sync mode (Sync playback)

• Step reverse for cameras (frame-by-frame)

Enhanced Inter NVR Sync playback 
Inter recorder sync playback for cameras across MAXPRO NVR is improved from 
previous releases. Inter NVR sync playback features helps user to synchronize the 
playback video feed across multiple cameras and recorders. In R560 release user 
can experience sync playback with both forward and reverse direction with high 
speeds (and smooth playback upto 2x speed). User can also perform other opera-
tions such as step reverse and step forward in sync playback mode and can view 
smooth video.This feature is supported with MAXPRO NVR and Enterprise record-
ers only.

Note: It is recommended to remove camera loops before performing Sync Playback.

Support for Equip-S Series V2 Cameras
The following is the list of Equip Series V2 camera integration is supported in MAX-
PRO VMS:

Note: Recommended to use NVR 5.6 and above to connect to the below camera firmwares

.

# Camera Model Type

1 H2W2GR1

WDR cameras

2 H3W2GR1V 

3 H3W4GR1V 

4 H4W2GR1V 

5 H4W4GR1V

6 HBW2GR1V 

7 HBW2GR3V

8 HBW4GR1V 

9 HCW2GV

10 H4L2GR1V 
Ultra Low Light11 HCL2GV

12 HBL2GR1V
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The below table details the Firmware version compatible with the NVR 5.6 Build 
572:

The above Equip S Series V2 Firmware version supports the following features:

• New VA events added with Annotation support

• Xtralis IntrusionTrace™ 

• Xtralis LoiterTrace™

• Intrusion Detection 

• Loitering Detection 

• Trigger Line Detection 

Note: Annotation feature is supported only with Xtralis XO packages.

• Profile -G Edge Sync recording

• Mulitcast

Introduced Advanced Rendering settings
This feature provides flexibility to select different rendering combinations between 
CPU and GPU modes for decompression and rendering process. Earlier only GPU 
Rendering capability was available to handle the camera video packets along with 
decompression. With Advance Rendering settings user can choose to distribute the 
load on CPU and GPU accordingly. This helps the user to improve the rendering 
performance of the system.

• CPU Decompress + CPU Render: This option executes low performance 
because entire video rendering process will be on CPU. This option is for 
debugging purpose and is recommended not to be selected.

• GPU Decompress + CPU Render: By default this option is selected and 
decompression/rendering process is shared between GPU and CPU.

Camer
a 
Model

Firmware Web 
Version

Onvif 
Versio
n

ISOM 
Versio
n

Xtralis 
Intrusi
on 
Trace

Xtrali
s 
loiteri
ng 
Trace

Intrusio
n 
Detectio
n

Loiterin
g
Detectio
n

Trigger 
Line 
Detection

Equip S Series V2 Firmware version VA Packages

Low 
Light

1.000000
00.18, 
2019-04-
23 Or 
above

3.2.1.72
2805

16.1.2 1.3.1, 
2019-
04-21

1.01.19 1.01.1
9

1.0.8, 
2019-01-
15

1.0.8, 
2019-01-
15

1.0.8 2019-
01-15

WDR 
cameras

1.000000
00.18, 
2019-04-
09 Or 
above

3.2.1.71
6054

16.12 1.3.1, 
2019-
04-04
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• GPU Decompress + GPU Render: This option is for high resolution cameras 
and for cameras with 60 FPS on 4K monitors. Selecting this option may 
reduce the number of cameras but the video quality will be best. 

Note: GPU Decompress + GPU Render option has some limitations such as Flip/Mirror/
Digital corrections features may not be supported.

Change in UI Naming Convention
• In Preferences dialog box: 

• Enabled GPU Rendering is now renamed as Support 64 Bit Rendering with more granular 
control with advanced rendering options.

• Set FPS Limit for Unselected Panel is now renamed as Switch to I Frames for unselected 
panels.

Enhancements in ADPRO XO Recorder
• Export HBOX clip player with clips: MAXPRO VMS integration with ADPRO 

XO recorder allows user to export clip (HBOX format) along with the HBOX 
clip player. This helps the user to play the clip in any machine without 
depending on supported clip format player. See section "Export HBOX clip 
player with clips" on page 4-225s.

• Capability to playback associated videos for Input Alarms: This feature 
enables user to playback the associated video with input alarm. User can 
view the video for an input alarm from all the associated cameras. This 
feature is support only from ADPRO XO recorder integration with VMS. See 
section"Playback associated videos for Input Alarms" on page 4-227s.

Enhancements in Time line color in Viewer
Timeline in Viewer tab is improvised to identify various recordings using colors. 
Based on the legends user can identify recordings such as Continuous, Event, User 
based, Archival and Failover. The following are the various timeline indicators 
introduced.

For Recording

Color Indicates...

Continuous recording.

Event based recording.

User based recording.

On Device
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For Archival

Enhancements in VMS in VMS Discovery
VMS in VMS discovery will now help to discover and add sites with same IDs (under 
different Child VMS) in order to maintain the logical grouping of cameras in Master 
VMS. Consider an example as explained below:

Example Scenario:
• CameraA of Site1 (Site ID 1) in VMSA

• CameraB of Site1 (Site ID 1) in VMSB

Before R560: 
• After VMS in VMS discovery: Both VMSA and VMSB is displayed in “Master 

VMS”. CameraA and CameraB displayed in Site1 of “Master VMS”

After R560:
• After VMS in VMS discovery:

• CameraA will appear under Site1 in “Master VMS”

• CameraB will appear under Site1_VMSB in “Master VMS”

New Features in R550 Release

Edge Analytics Annotation Support
Annotations support for Intrusion Trace and Loiter Trace in Live and Playback 
video is supported in MAXPRO® VMS with MAXPRO® NVR recorder integration. 
This feature helps to trace and locate the moving subjects in live/recorded video 
and generates an alarm if intrusion or loitering is detected.

Synced from Device

Redundant

Color Indicates...

Color Indicates...

Archival of Continuous recording

Archival of Event based recording
MAXPRO®VMS R670 Operator’s Guide 25



Equip-S series camera supports Annotation feature along with Intrusion trace and 
Loitering Trace alarms. These alarms are in-built with Equip-S series camera and 
are made available by installing required analytics licenses.

See Annotations section for more information.

ADPRO XO Recorder Integration Support
ADPRO XO Recorder is integrated with MAXPRO VMS in R550. In MAXPRO VMS 
user can also see the Annotation bounding boxes with XO recorder integration. 
User needs to update new license to avail the features of XO recorder in VMS.

Note: It is recommended to change the default username and password after the first login.

The following are the qualified XO Recorder models and the Firmware versions 
supported with MAXPRO VMS R550.

Following are the features supported with ADPRO XO Recorder integration.:

# XO Recorder Model (Version) Firmware 
Version

1 ADPRO IFT IFT XO 04.02.0010

IFTE XO 04.02.0010

2 Fast Trace 2 XO 04.02.0010

3 ADPRO IFT Gateway XO 04.02.0012

# Features Supported

1 Add/delete/modify AdproXO recorder in VMS

2 Discover Cameras, Relays and Sensors

3 Live Video

4 Multi Stream

5 Snapshot save, digital correction, Mirror and Flip.

6 PTZ operations

7 Playback Operations
Note: Reverse playback operation is not 
supported. Playback operation may start a few 
seconds behind the selected time because of 
GOP settings.

8 Camera Status/Alarms

9 Events Search

10 Anonymization

11 HVA
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Patches Merged in SP1

5.0 T Patch
• Refer to the 800-23558-E_MAXPRO™ VMS R500 SRB T-Patch for complete 

information on new features in R500 T Patch.

Windows Expiry Patch
This patch is to make MAXPRO VMS application not to apply password expiry 
option for windows users. Refer to the MAXPRO VMS_ Windows Expiry_Patch_Re-
lease Notes for detailed information.

Include Archived Clips
This feature allows user to search Archived clips including the recording clips. User 
needs to select Include Archived Clips check box under Filter area while searching 
for recorded clips. Based on the search criteria the archived clips are displayed in 
Grey color as shown below. When user drag and drop the archived clips in to the 
panel then camera name and clips status is displayed. To play the Archived clips 
through a client machine, refer to the MAXPRO® VMS Installation and Configuration 
Guide for details.

Primary and Archived Location
The location of Archived clips is now displayed in the Result windows in Location 
column as highlighted below. The type of status is explained below.

• Archived: The clip is available only in Archived path.

• Primary, Archived: The clips is available in both primary storage and Archived 
path.

Camera Name & Clip status
In Viewer screen following are the improvements:

• Under Snapshots/clips, the folder naming structure is changed to camera 
name.

• When a user drag and drops a archived clip into panel, the archival camera 
name with clip status Rec is displayed as shown below.

• If Archived clips are played in MAXPRO clip player then the camera name and 
clip status is also displayed.

Improved GPU rendering
GPU Rendering capability is now enhanced to handle camera video packets along 
with decompression technique. User can view smooth and clear live video through 
GPU rendering. User should modify the registry value in client or server machine to 
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enable GPU rendering mode. Refer to the MAXPRO® VMS Installation and Configuration 
Guide for complete details on How to configure the Registry value to experience the 
improved GPU rendering mode.

GPU Rendering Combinations
The below table explains the combination settings between Enable GPU Rendering 
option and Registry settings

60FPS support for EQUIP-S 1080P cameras
EQUIP-S 1080 P Model cameras are now supported with 60FPS rendering through 
GPU Mode. The following are the list of cameras support 60 FPS.

Note: Cameras beyond 1080 resolution will not support 60 FPS rendering.
• H4L2GR1V

• HBL2GR1V

• HCL2GV

• H4W2GR1V

• HBW2GR1V

• HBW2GR3V

• H3W2GR1V

• HCW2GV

• H2W2GR1

IF And IF Then

user enables Support GPU 
Rendering check box in 
Preferences > Rendering options 
tab

user sets 
GPU_Rendering_Value 
flag to 1

Both Decompression and 
Rendering will be processed 
through in GPU mode.

user enables Support GPU 
Rendering check box in 
Preferences > Rendering options 
tab

user sets 
GPU_Rendering_Value 
flag to 0

Decompression process will 
happen through GPU and 
Rendering will be processed 
in CPU mode.

user does not select Support GPU 
Rendering check box in 
Preferences > Rendering options 
tab

user sets 
GPU_Rendering_Value 
flag to 1

Both decompression and 
Rendering will be processed 
through CPU.
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Video Anonymization Environment selection options
This feature allows you to configure or mask identifiable objects based on the 
scene environment. User need to select the required environment from the drop 
down list based on the camera mounting position. See Video Anonymization on page 
214 for complete details How to configure and view anonymized video based on the 
environment. 

The following are the Environments supported in this T-Patch

• Variable Scene: If the scene contains both stationary and moving people or 
objects then select this option to anonymize the objects in the scene.

• High Motion Scene: To anonymize the objects in high motion in the scene.

• Still Scene: To anonymize the objects in a scene where the scene 
predominantly contains stationary people and objects.

New Column for Anonymization in Video Inputs
A additional column Anonymization in Video Inputs screen is introduced to view 
the list of camera associated/configured with anonymization feature. User can also 
apply filter True/False to view the list of cameras associated, where True is associ-
ated camera and False is not associated.

Platform Refresh: R500 Installation is supported on Windows 2016 Operating sys-
tems (Server)

Privacy Protection Settings (GDPR)
Anonymization Support: Anonymization feature is to help the business owner to 
meet the EU GDPR compliance standards easily. The objective of this feature is to 
hide the identifiable personal data or personal identity in a video surveillance sys-
tem using masking techniques. This feature is specific to European Union region. 
MAXPRO VMS R500 release enables user to configure and experience this feature. 
The configuration can be done in Configurator tab and only an Administrator can 
use this feature and grant access. EquipIP Series cameras supports this feature 
and user can associate the required cameras to anonymize. Anonymization is also 
implemented on HVA streams. Refer MAXPRO® VMS Installation and Configuration 
Guide for more information
The Anonymization feature supports the following type of masking:

• Blur: Blurs the Identifiable object

• Pixelize: Pixelizes the Identifiable object

Note: This feature is license based and it is not supported in Viewer Edition. In R500 
Enterprise Edition for both (GDPR) features, 60 days trial license is enabled. For R500 
Viewer Edition these features are not available in the permanent demo license.

• New User Privilege: Introduced new user privilege “Hide Subject Identity” to 
control the accessibility to view Anonymized video. An Administrator can 
decide to enable this option to hide the subject identity for a specific 
Operator. By default this check is enabled for all the operators.
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• Clip Export with Anonymization is supported: Anonymization feature is 
supported for both Playback and Clip Export operation. 

Note: If a user exports a clip using Clip Export option then only WMV format is supported.

Four Eye Authentication: This feature is also part of Privacy Protection setting and 
to meet the EU GDPR compliance standards easily. This is to restrict all users in a 
surveillance system to perform Playback operation. While performing playback 
operation at least two people from different roles should authenticate. For an 
Administrator, authentication is not required and can perform any playback opera-
tion. However, using license; authentication for an administrator can be config-
ured. 
For a non Administrator user, by default a pop up is displayed and an Administrator 
user or a User from some other group needs to authenticate to perform playback 
operation. Refer MAXPRO® VMS Installation and Configuration Guide for more informa-
tion

Note: This feature is license based and it is not supported in Viewer Edition. For R500 
Enterprise Edition 60 days of trial license is applicable for both (GDPR) features. For 
R500 Viewer Edition these features are not available in the permanent demo license.

The following table explains the Four eye authentication based on the user and 
roles

I18N Localization Support
• I18N support includes new strings from R410 to R490 and in MAXPRO VMS 

R500 release additional Turkish Language is supported.

VMS in VMS Enhancements
• Apart from cameras, relays and sensors, user can now discover sites, 

workstations, partitions and users from child VMS. This feature helps user to 
import the configurations instead of reconfiguring and in turn saves time for 
Large scale deployments. Refer MAXPRO® VMS Installation and Configuration Guide 
for more information.

Extended Salvo layouts
• Additional 5X5, 6X6, 7X7 and 8X8 salvo layout combinations are introduced 

in this release to reduce the cost involved in monitors.

Default Events Association
• After upgrading to R500, if user discovers the recorders then for only newly 

added recorders, by default all the events will not get associated to cameras. 

User Authenticating User Valid 
Authentication

User 1 [of Group 1] User 1 [of Group 2] Yes

User 1 [of Group 1] User 2 [of Group 1] No
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Only few events will be associated with the devices and cameras. The 
following are the list of events associated by default. If user need more 
events to be associated then it needs to be configured manually. Refer 
MAXPRO® VMS Installation and Configuration Guide for more information on 
Associating Events

New Equip 1080p and 4MP Camera Integration
• Configuration is done through Honeywell proprietary ISOM APIs

• After integrating the new EquIP Camera, system will be able to support the 
following
• H.264, H.265 and MJPEG coded support

• HTTPS support

• New events supported: EquIP series Camera integration generates the 
following additional events.
• Abandoned Object detection

• Object Missing detected

• Trigger Line detection

# Event Name

1 CAMERA_VIDEO_LOSS

2 CAMERA_DISABLED

3 CAMERA_ENABLED

4 DISCONNECTED

5 CONNECTED

6 CAMERA_DELETED

7 CAMERA_ADDED

8 CAMERA_VIDEOLOSS_ALARM

9 CAMERA_VIDEOLOSS_CONFIGURATIONFAILE
D

10 CAMERA_VIDEOLOSS_CONFIGURATIONOK

11 CAMERA_VIDEOLOSS_OK

12 CONNECTION_LOST

13 OFFLINE 

14 VIDEO_LOST

15 VIDEO_RESTORED
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The following EquIP series camera models are supported using ISOM API’s.

Multicast Support
Allows you to view the Live video continuously in VMS clients despite of any inter-
ruption in NVR recorders. Previously without Multicast, only one camera can see 
only 16 times now this limit is broken. User can view live video in N number of cli-
ents. However, the camera should be Multicast capable. Multicast cameras should 
be accessed from client network and only Equip-S model cameras are supported. 
Ensure that Multicast is enabled in the Network switch. 

See Settings for Video Rendering section on how to enable this option. Refer to MAXPRO® 
VMS Installation and Configuration Guide for more information on various configu-
rations.

Enhancements in Network Throttling
Depending on the available network bandwidth at site, for better user experience 
and to improve the performance of Live video streaming, user needs to manually 
configure the config file and the Registry Entries. Refer to MAXPRO VMS Installa-
tion and Configuration Guide for more information on how to configure.

Custom Branding Utility
A distributable utility to customize the brand parameters of a business organiza-
tion is introduced. User can contact to Honeywell Dealer or Tech support to obtain 
this utility. Please see the back cover for contact information.

# Camera 
Model Description Firmware Version Details

1 H4L2GR1V 2MP Lowlight outdoor dome Version: 1.000.0000.10, Build Date: 
2018-05-29
ISOM Version 1.2.1_Build 20180529
VA Package Version: 1.0.8_build20180529

2 HBL2GR1V 2MP Lowlight IR bullet

3 HCL2GV 2MP Lowlight box camera

4 H4W2GR1V 2MP WDR outdoor dome

Version: 1.000.0000.9, Build Date: 2018-05-
25
ISOM Version:  V 1.2.1_Build 20180524

5 H4W4GR1V 4MP WDR outdoor dome

6 HBW2GR1V 2MP WDR bullet, 2.7-13.5mm

7 HBW2GR3V 2MP WDR bullet, 5-60mm

8 H3W2GR1V 2MP WDR indoor dome

9 H3W4GR1V 4MP WDR indoor dome

10 HCW2GV 2MP WDR box camera

11 H2W2GR1 2MP Pancake camera
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Global Bookmarks
Bookmarks tab is included in Viewer to create bookmarks on a live video and save 
under the bookmarks tab. This window and options are displayed based on the 
user privileges. User can Create Bookmarks, Play video from Bookmarks time, send 
operator and monitor messages to the user and configure the bookmark retain and 
recycle settings in Preference > Bookmarks Settings tab.

Third Party ONVIF Profile G supported cameras:
Following new Third Party ONVIF compliance Profile-G cameras are now sup-
ported in NVR 4.7.

MAXPRO Web Configurator
Enhanced the Web configurator user interface with new themes, for a better user 
experience while configuring the System, Server and Security configurations for 
Web client and mobile.

Network Throttling
Introduced the following options for better management of resolution and frames. 
This feature automatically measures the latency in streams periodically and man-
ages the stream with lower resolution and lower frame rate in low network band-
width sites. This enables user to view smooth video without fluctuations. This 
feature is applicable for Live streaming only. 

• Mange Resolution

• Manage Frames

Rendering Options
• Show Stream Details: Allows you to view the stream details such as type of 

camera Resolution, FPS on the video panel.

Inter-NVR Sync playback
Enhancements made in Inter NVR Sync Playback feature, where user can sync the 
playback video across MAXPRO NVR recorders. This feature is supported from 
R450 release and only supported for MAXPRO NVR recorder.

Profile G Cameras Camera Type Firmware Details

Tyco ADCi350-B111 V3.1.0.170215

Samsung QNO-7010R 1.04_170224

Panasonic WV-SFV631L 2.41
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On Demand live Streaming (VOD)
On Demand live Streaming (VOD): On Demand Live Streaming / recording feature 
enables you to configure and store recordings at camera level. This feature saves 
the bandwidth for remote sites with limited and costly connectivity (e.g. using 4G). 
MAXPRO NVR configured as On Demand Live Streamer will stream video from 
cameras only. Later when a client requests a live stream for viewing, the recordings 
at the camera level can be synced back to view in NVR viewer. VOD is used to pull 
video streams only when you want the stream for viewing or analysis (such as 
Smart VMD, HVA Analytics in VMS and so on). When this feature is enabled, record-
ing will not take place in MAXPRO NVR.This feature is compatible from MAXPRO 
NVR Viewer, MAXPRO NVR Web Clients and MAXPRO NVR Mobile app clients.

Profile-G or Edge Sync Support: 
Allows you to synchronize the recordings from the camera SD card to NVR. This 
features enables the user to playback only those recording which are saved on 
demand in the SD card. Flexibility to enable the Edge sync in Camera page and 
configure the day/ time for Edge Sync Settings in System window to get the 
recordings from the camera. This feature is supported only for equIP 1080p WDR, 
4MP WDR and IR PTZ model cameras

H.265 Codec Support
H.265 Codec cameras now supports GPU based Rendering. You can render upto 
23 H.265 cameras with 1080P Resolution at 30 FPS/30 GOP. Refer MAXPRO NVR 
Desktop Client - Workstation Specifications and Performance Metrics for more 
information.

Low bandwidth Stream Settings:

Use Low Resolution Stream
This feature is for low bandwidth sites and to view the low resolution video in any 
size of salvo layout. User needs to configure the low resolution for any stream in 
NVR camera page. Select the Low Resolution check box in VMS > Preference > 
Advanced Settings tab, to view the low resolution video in single or multiple salvo 
layout.

Note: Either you can select the Enable Switch Stream feature or Use Low Resolution stream 
feature.

Receive Only I Frame/Low Bandwidth Streaming
This feature allows user to receive and view only I Frame considering the band-
width at the site. User needs configure the low resolution and choose to render only 
I Frame in NVR. This enables user to view the required clips even with low band-
width.
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Use Extended time Outs
This helps in increasing the default time outs for NVR connections, stream connec-
tions and snapshots retrieval. This feature is only supported for MAXPRO NVR.

Optimize Stream Usage Settings: 

Enable Stream Switch
Enable stream switch automatically switches between low and high resolution 
streams in the salvo layout based on the current video panel size. User should have 
minimum two streams available to use this feature. By default camera will stream 
in high resolution video in single salvo layout and the same camera when it is drag 
and dropped in multiple salvo, it streams with low resolution video. User needs to 
configure the Primary and secondary streams with high or low resolutions or vice 
versa in MAXPRO NVR camera page. Based on the configuration, user can drag 
and drop the camera in VMS, in single or multiple salvos.

Note: Either you can select the Enable Switch Stream feature or Use Low Resolution 
stream.

Manual Archival support for Primary and Failover Recorders
Manual Archival feature enables you to manually Archive the clips of both Primary 
and Redundant Recorders. You can search the required recording clips in Search 
tab and then archive. Before performing the manual archive ensure that you con-
figure the Drive path in NVR and then map the Archival storage drive path in VMS > 
Viewer tab. 

Embedded NVR Recorder (Embedded Recorder) Support
User can configure and use the Embedded Recorder features. Refer to the MAX-
PRO® VMS Software Release Guide for the list of features supported.

New EquIP Series Camera Models Support
Additional 8 new EquIP camera models are now supported (HFD6GR1, HSW2G1, 
HCD8G, HBD8GR1, H4D8GR1, HDZ302DE, HDZ302D, HDZ302DIN) in MAXPRO 
NVR 4.1 and the same can be accessible in MAXPRO VMS R410. In addition the fol-
lowing are the advanced features that are offered through these cameras:

• Intrusion trace (Need to purchase separate license to enable this feature in 
camera)

• Face Detection

• Audio Detection (For cameras with Built-in Microphone or External 
Microphone)

• SD Card Failure
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3D Positioning
3D Positioning feature enables you to view a specific object in a live video in 3-
dimensional view. On a live video you need to draw a region to view a specific 
object. This feature is supported only with New EquIP PTZ (HDZ302DE, HDZ302D, 
HDZ302DIN) camera models. If the camera is added in NVR box then you can per-
form 3D positioning in MAXPRO VMS.

New EquIP Camera Model Dewarping
New EquIP FishEye Camera (HFD6GR1) is capable of delivering FishEye view of 
the surrounding and which can also be dewarped to different view types depending 
on the mounting position. User needs to configure this feature in NVR box.

H.265 Codec Support
H265 codec type is supported to optimize the storage requirements for higher 
solution cameras. H265 is only supported for New EquIP model cameras. 
(HFD6GR1, HSW2G1, HCD8G, HBD8GR1, H4D8GR1, HDZ302DE, HDZ302D and 
HDZ302DIN). You can view these higher resolution cameras in MAXPRO VMS 
R410 if it is added in MAXPRO NVR box.

Limitations of H.265 Codec Type:

• H.265 is not supported in MAXPRO Mobile app

• H.265 is not supported in Web client

• H.265 cameras utilizes CPU based Rendering

Meta Data Conversion Utility
Meta data conversion utility allows you to replace or update the unique system ID 
number of the recorded clips and Meta data details for all or specific cameras in a 
Primary/Redundant NVR box. You can use this utility only if you are opting for 
Redundancy feature.

You need to run this utility before configuring the Redundancy feature in MAXPRO 
VMS and ensure that all the Primary NVR boxes are updated with proper unique 
IDs for the cameras.

This utility helps you to retain your recorded clips and Meta data details during 
Failover /Failback operations. This allows a user to effectively playback the 
recorded clip without loss of video.

MAXPRO VMS architecture
MAXPRO VMS is based on the client-server architecture. The following diagram 
illustrates the client-server architecture and different components that can be 
added to constitute the MAXPRO VMS system.
36 MAXPRO®VMS R670 Operator’s Guide 



MAXPRO VMS Client Workstation
The user interface installed on a workstation acts as the client and enables you to 
monitor sites and configure the video devices such as cameras, monitors, key-
boards, and others. Up to four digital monitors can be connected to each client 
workstation.

MAXPRO VMS Server
The server consists of the trinity framework and database of all the connected 
recorders, users and system data. Typically the client is also installed on the server 
to allow local management if desired.

The trinity framework for MAXPRO VMS is designed to provide a central platform 
for video products such as Rapid Eye, Fusion and Embedded Recorders. A central 
platform gives you the capability to manage diverse video products through the 
same user interface. This brings in the advantage of a similar look and feel across 
video products. Trinity is a service oriented framework, which means that each 
video product can use certain services and components from MAXPRO VMS. The 
long term objective of developing the service oriented trinity framework is to sup-
port more technologies and other video products in the future. 

The recorder is used for video storage in the MAXPRO VMS server and is one of 
many recording engines that can be chosen. The other core components in the 
server act as the system controller and manage the communication among the 
components of the MAXPRO VMS system such as the camera server, database 
server, recorders, cameras, workstations, and other devices in the network.
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Other Components
Additional components such as switchers, recorders, analytics servers, camera 
servers, and other devices can be added according to your needs to constitute the 
MAXPRO VMS architecture. Presently, you can view video from the switchers Vicon, 
Burle, American Dynamics, Pelco, VideoBlox, and MAXPRO. You can also view video 
and play recordings from the digital recorders Rapid Eye, Fusion, Intellex and 
Embedded Recorders. More recorders will be compatible with MAXPRO VMS in the 
future versions.

Examples of MAXPRO VMS Configuration
The scalable architecture enables you to expand or downsize the video surveillance 
network as and when needed. You can downsize the video surveillance network to a 
single client workstation and server configuration. It can also be expanded to 
include multiple client workstations and servers

The following diagram shows the single workstation architecture. 

The following diagrams shows the multiple workstation architecture. 
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Typographical Conventions
This guide uses the conventions listed in the following table.

Font What it represents Example

Honeywell Sans 
Medium

Words or characters that you must type. The word 
“enter” is used if you must type text and then press 
the Enter or Return key.

Enter the password.

Menu titles and other items you select Double-click Open from the File menu.

Buttons you click to perform actions Click Exit to close the program.

Honeywell Cond 
Extrabold

Heading Installation

Honeywell Sans 
Extrabold

Cross-reference to external source Refer to the System Administrator 
Guide.

Honeywell Sans 
(Italic)

Cross-reference within the guide See Installation.
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CHAPTER

2

MAXPRO®VMS R
SYSTEM REQUIREMENTS AND 
LICENSING
System Requirements
The following tables list the system requirements for MAXPRO VMS Server and Cli-
ent computers.

Note: 32 bit systems are not supported.

MAXPRO VMS Server (Performance Spec with Windows 2012 Server Standard R2 64 
bit, Windows 2016 Server Standard 64 bit, Windows 2019 Server Standard 64 bit up 
to 10 Clients)

Specification Description

Processor Intel Quad Core Xeon E3 1225V3 3.2GHz S1150 

Recommended Operating Sys-
tem

Microsoft Windows® 2012 Server STD 64 Bit (for only 
Upgrade)
Microsoft Windows® 2016 Server STD 64 Bit (Recom-
mended for Fresh installation)
Microsoft Windows® 2019 Server STD 64 Bit (Recom-
mended for Fresh installation)

Recommended Computer Type 
(Server or Workstation)

Server - dual power supply suggested

Recommended System Memory 
(RAM)

16GB

DVD Drive (RW (Read Write) is 
required if workstation is used for 
exporting recordings)

DVD +/- RW
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MAXPRO VMS Server (Performance Spec with Windows 2012 Server Standard R2 64 bit, 
Windows 2016 Server Standard 64 bit, Windows 2019 Server Standard 64 bit up to 25 Clients)

Disk Two separate hard drives or two sets of RAID arrays
Disk / RAID set 1 utilizes 10K RPM SATA 150GB or 
10K-15K RPM SCSI 146GB for Windows operating 
system, MAXPRO VMS Server Software, Microsoft SQL 
Server software
Disk / RAID set 2 utilizes 10K RPM SATA 150GB or 
10K-15K RPM SCSI 146GB for MAXPRO VMS data-
base files Microsoft SQL Server database files 
Note: if fault tolerance is required RAID set one is 
RAID 1, 10 or 0+1 and RAID set two is RAID 10 or 0 + 1.

Multiple Monitor Card -Display 
Adapter (Video
Resolution)

Display Adapter with Video resolution 1024x768 pix-
els; 32-bit color or higher

Serial Ports Only required if serial device are to be connected - 
Suggested 8 Port MOXA PCI-e serial RS232

Network Connection 1Gbit/sec or greater.

Specification Description

Specification Description

Processor Intel 6 Core Xeon E5 2630V2 2.6GHz S2011

Recommended Operat-
ing System

Microsoft Windows® 2012 Server STD 64 Bit (for only 
Upgrade)
Microsoft Windows® 2016 Server STD 64 Bit (Recom-
mended for Fresh installation)
Microsoft Windows® 2019 Server STD 64 Bit (Recom-
mended for Fresh installation)

Recommended Com-
puter Type (Server or 
Workstation)

Server - dual power supply suggested

Recommended System 
Memory (RAM)

32 GB (add “/pae” to boot.ini file to recognize more than 4GB 
of RAM)

DVD Drive (RW (Read 
Write) is required if 
workstation is used for 
exporting recordings)

DVD +/- RW
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MAXPRO VMS Server (Performance Spec with Windows 2012 Server Standard R2 64 bit, 
Windows 2016 Server Standard 64 bit, Windows 2019 Server Standard 64 bit above 25 Clients)

Disk Two separate hard drives or two sets of RAID arrays
Disk / RAID set 1 utilizes 10K RPM SATA 150GB or 10K-15K 
RPM SCSI 146GB for Windows operating system, MAXPRO 
VMS Server Software, Microsoft SQL Server software
Disk / RAID set 2 utilizes 10K RPM SATA 150GB or 10K-15K 
RPM SCSI 146GB for MAXPRO VMS database files Micro-
soft SQL Server database files 
Note: if fault tolerance is required RAID set one is RAID 1, 10 
or 0+1 and RAID set two is RAID 10 or 0 + 1.“

Multiple Monitor Card -
Display Adapter (Video
Resolution)

Display Adapter with Video resolution 1024x768 pixels; 32-
bit color or higher

Serial Ports Only required if serial device are to be connected - Sug-
gested 8 Port MOXA PCI-e serial RS232

Network Connection 1Gbit/sec or greater.

Specification Description

Specification Description

Processor Intel two Quad Core Xeon E5 2630V2 2.6GHz S2011

Recommended Operat-
ing System

Microsoft Windows® 2012 Server STD 64 Bit (for 
only Upgrade)
Microsoft Windows® 2016 Server STD 64 Bit (Rec-
ommended for Fresh installation)
Microsoft Windows® 2019 Server STD 64 Bit (Rec-
ommended for Fresh installation)

Recommended SQL Full version of SQL for 2014/2016/2017.
For Fresh installation, if the machine does not have 
the latest version of SQL then the installer will install 
SQL 2017 Express version.
For Upgrade scenario, the system will retain the pre-
viously installed SQL version.

Recommended Com-
puter Type (Server or 
Workstation)

Server - dual power supply suggested

Recommended System 
Memory (RAM)

32 GB (add “/pae” to boot.ini file to recognize more 
than 4GB of RAM)
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MAXPRO VMS Workstation Computer (Standard Spec with Windows 10 Enterprise 64-Bit 
(Upgrade Only) up to 1 monitors)

DVD Drive (RW (Read 
Write) is required if 
workstation is used for 
exporting recordings)

DVD +/- RW

Disk Two separate hard drives or two sets of RAID arrays
Disk / RAID set 1 utilizes 10K RPM SATA 150GB or 
10K-15K RPM SCSI 146GB for Windows operating 
system, MAXPRO VMS Server Software, Microsoft 
SQL Server software
Disk / RAID set 2 utilizes 10K RPM SATA 150GB or 
10K-15K RPM SCSI 146GB for MAXPRO VMS data-
base files Microsoft SQL Server database files 
Note: if fault tolerance is required RAID set one is 
RAID 1, 10 or 0+1 and RAID set two is RAID 10 or 0 + 
1.

Multiple Monitor Card -
Display Adapter (Video
Resolution)

Display Adapter with Video resolution 1024x768 pix-
els; 32-bit color or higher

Serial Ports Only required if serial device are to be connected - 
Suggested 8 Port MOXA PCI-e serial RS232

Network Connection 1Gbit/sec or greater.

Specification Description

Specification Description

Processor Intel(R) Core(TM) i7-8700 CPU @ 3.4GHz

Recommended Operat-
ing System

Microsoft Windows® 10 Enterprise (64 bit)

Recommended Com-
puter Type (Server or 
Workstation)

Workstation

Recommended System 
Memory (RAM)

8GB.

DVD Drive (RW (Read 
Write) is required if work-
station is used for 
exporting recordings)

DVD +/- RW.

Disk Single Disk or RAID 0 or 0+1 10K SATA 80GB or 10K to 
15K SAS 73GB: Windows Operating System
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MAXPRO VMS Workstation Computer (Standard Spec with Windows 10 Enterprise 64-Bit 
(Upgrade Only) up to 2 monitors)

Multiple Monitor Card -
Display Adapter (Video
Resolution)

1 x 1024 MBPCIe x16 NVIDIA NVS510, DVI or VGA or 
HDMI Intel® HD Graphics Version 25.20.100.6617

Network Connection 1Gbit/sec or greater.

Video Resolution 1920*1080P and 4k

Specification Description

Specification Description

Processor Intel(R) Core(TM) i7-8700 CPU @ 3.4GHz

Recommended Operat-
ing System

Microsoft Windows® 10 Enterprise (64 bit)

Recommended Com-
puter Type (Server or 
Workstation)

Workstation

Recommended System 
Memory (RAM)

8GB.

DVD Drive (RW (Read 
Write) is required if work-
station is used for 
exporting recordings)

DVD +/- RW.

Disk Single Disk or RAID 0 or 0+1 10K SATA 80GB or 10K to 
15K SAS 73GB: Windows Operating System

Multiple Monitor Card -
Display Adapter (Video
Resolution)

2 x 1990MB PCIe x16 NVIDIA NVS 300, Dual DVI or 
Dual VGA or DVI+VGA. This is for a four monitor setup 
with each monitor requiring 1024 MB approximately 
Intel® HD Graphics Version 25.20.100.6617

Network Connection 1Gbit/sec or greater

Video Resolution 1920*1080P and 4k
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MAXPRO VMS Workstation Computer (Standard Spec with Windows 10 Enterprise 64-Bit 
(Upgrade Only) up to 4 monitors)

Viewing the Version and License Information of 
MAXPRO VMS

You can view the version and license information of MAXPRO VMS from the user 
menu.

1. Click the User menu. The user menu options appear. 

2. Click About. The version and license information of MAXPRO VMS displays.

Specification Description

Processor Intel(R) Core(TM) i7-8700 CPU @ 3.4GHz 

Recommended Operat-
ing System

Microsoft Windows® 10 Enterprise (64 bit)

Recommended Com-
puter Type (Server or 
Workstation)

Workstation

Recommended System 
Memory (RAM)

16GB.

DVD Drive (RW (Read 
Write) is required if work-
station is used for 
exporting recordings)

DVD +/- RW.

Disk Single Disk or RAID 0 or 0+1 10K SATA 80GB or 10K to 
15K SAS 73GB: Windows Operating System

Multiple Monitor Card -
Display Adapter (Video
Resolution)

4 x 4038 MB PCIe x16 NVIDIA NVS 510, Dual DVI or 
Dual VGA or DVI+VGA. This is for a four monitor setup 
with each monitor requiring 1024 MB approximately. 
Intel® HD Graphics Version 25.20.100.6617

Network Connection 1Gbit/sec or greater

Video Resolution 1920*1080P and 4k
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Figure 1-1    About MAXPRO VMS

Generating and Installing the License for MAXPRO VMS
The MAXPRO Video Management System (MAXPRO VMS) setup comes with a 90 
day trial period and enables you to add up to 10000 cameras across all Digital 
Video Recorders (DVR) and 25 clients. MAXPRO VMS supports 17 integrations. You 
need to purchase license to continue using MAXPRO VMS. You can purchase 
license for any number of cameras and clients.

Before you begin 
Procure the voucher number from the MAXPRO VMS sales support team. To con-
tact the MAXPRO VMS sales support team, USA customers go to the URL: http://
www.honeywellvideo.com/contact/sales/index.html and European customers 
send an email to HISHelp.Europe@honeywell.com.

To purchase and install MAXPRO VMS license

1. Click the About option in the user menu. The About MAXPRO Video Manage-
ment System dialog box appears.

2. Click License. The License Management Console dialog box appears. 
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Figure 1-2    License Management Console

3. In the License window, click  Create Host ID File. The Browse For Folder 
dialog box appears. 

4. Select the path where you want to generate Host ID file, and then click OK.

Note: Host ID is a unique ID generated for the computer. 

5. Send the Host ID file with the voucher number as the subject 
videolicenserequests@honeywell.com through email. For example, if the 
voucher number is 4356-6754-0000-78556-985436 type, VOUCHID: 4356-
6754-0000-78556-985436 in the subject.

6. Honeywell reverts with a unique license certificate to your email. Copy the file 
and paste it in a folder.

7. Perform step 1 and step 2 and then select Install License in the License window. 
The New License Configuration Wizard dialog box appears. 

8. Click Next. The Locate Your License File dialog box appears. 

9. Click the Browse button to locate your license certificate, and then click Next. 
The License Comparison dialog box appears. 

10. The License Comparison dialog box displays the details of the existing license 
and the newly procured license. Compare the columns Existing License and 
Selected License corresponding to General Features and Devices, and then 
click Next. The Device Configuration Changes dialog box appears. 

Note: Any discrepancy in the license must be notified to Honeywell Sales Support. For 
example, the maximum supported cameras row under Selected License column 
displays the number of cameras for which the license is purchased. If the number of 
cameras is less or more than number of cameras for which the license was 
purchased, contact the Honeywell Sales Support immediately. 
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11. Check for the accuracy of details, and then click Next. The Confirm New License 
dialog box appears. 

12. Click Finish. The New License Configuration Wizard dialog box appears. 

13. Click Yes. 

Note: You can install the License only in Server Machines. If you try to install the license in 
Client machine it will fail.

Terminating the License 
You can terminate the license when you do not want to use MAXPRO VMS or when 
you want to use the existing license on a different computer.

To terminate license

1. Click the About option in the user menu. The About MAXPRO Video Manage-
ment System dialog box appears.

2. Click License. The License Management Console dialog box appears. 

3. In the License window, click Terminate License. A message asking for 
confirmation appears.

4. Click Yes. The Browse for Folder dialog box appears.

5. Select the path to save license terminate certificate file. 

To use the existing license in a new computer

1. Generate the Host ID file for the new computer. 

2. Send the Host ID file, license terminate certificate file, and the voucher number 
to videolicenserequests@honeywell.com. 

3. Honeywell reverts back with a unique license certificate. Copy the file and paste 
it in a folder. 

4. Perform step 9 through step 13 of To purchase and install MAXPRO VMS license 
procedure. 

Note: You can upgrade the number of clients and cameras by purchasing the upgrade 
license. Upgrade license helps you to add more clients and cameras along with the 
existing clients and cameras. You can also purchase supersede license if you do not 
want to continue with the existing clients but add new clients to the MAXPRO VMS 
unit.

To use the existing license in a new computer

1. Generate the Host ID file for the new computer. 

2. Send the Host ID file, license terminate certificate file, and the voucher number 
to videolicenserequests@honeywell.com. 

3. Honeywell reverts back with a unique license certificate. Copy the file and paste 
it in a folder. 
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4. Perform step 9 through step 13 of To purchase and install MAXPRO VMS license 
procedure.

Note: You can upgrade the number of clients and cameras by purchasing the upgrade 
license. Upgrade license helps you to add more clients and cameras along with the 
existing clients and cameras. You can also purchase supersede license if you do not 
want to continue with the existing clients but add new clients to the MAXPRO VMS 
unit.

SSA - Software Service Agreement for MAXPRO
Software Service Agreement (SSA) is a flexible version specific licensing process 
which allows a user to get the support on the MAXPRO VMS licenses across multi-
ple versions. From R600 release user need to buy a valid license for R600 to 
upgrade or for fresh installation. In addition user can buy SSA support license for a 
specific duration which helps to get support from Honeywell.

Please contact Honeywell Customer support. See the back cover for the contact 
information in respective regions.

Note: license is valid only for a specific release. When applied, on a wrong version, the 
license will be rejected. For example if you install R500 license on a R600 installed 
machine, then a message Selected license is invalid for MAXPRO VMS R600. 
Please select correct license file is displayed.

To install the procured license see Generating and Installing the License for 
MAXPRO VMS for more information. Once the SS A license is procured and 
installed, the License console Management window displays the SSA info entry as 
shown below.
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Viewing the Version and License Information for 
Recorder

To view license information of a recorder

1. Click the Configurator tab.

2. Expand Devices in the navigation area and then click Recorders. The Recorders 
screen appears in the display area.

3. Double-click the recorder or select the recorder, and then click Update. The 
general settings for the recorder appear.

4. Click the Advanced Settings tab.

5. Click the About tab. The version and license information is displays. The 
following table lists the version and license details.

Version Information

Version The version of recorder.

Host Information

Host Name The name of the EBI, Experion, or HSS 
server, if the recorder is used in conjunction 
with EBI, Experion, or HSS server. None, if 
the recorder is not used in conjunction with 
EBI, Experion, or HSS server.

General License Information

Cameras The number of cameras licensed for your 
system.

IE Clients The number of Microsoft Internet Explorer 
clients licensed for your system.

Redundancy Indicates whether database server 
redundancy is licensed for your system.

Video Analytics License Info

Premium Algorithm Indicates whether the premium algorithm is 
licensed for your system.

Object Tracking Algorithm The number of cameras licensed to use the 
object tracking algorithm.

Object Tracking and 
Classification Algorithm

The number of cameras licensed to use the 
object tracking and classification algorithm.

Stationary Object Detection 
Algorithm

The number of cameras licensed to use the 
stationary object detection algorithm.

Third Party License Information
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Third party licenses Click View Licenses to see the license 
details of third party products used by the 
recorder for functions, such as video 
compression.
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CHAPTER

3

MAXPRO®VMS R
LOG IN AND FAMILIARIZATION
Logging on using profiles
The MAXPRO VMS server addresses are saved in profiles. You need to select the 
profile before logging on. You can set a profile as the default profile. When a profile 
is set as default, you do not need to select the profile each time you log on to MAX-
PRO VMS. You can also modify and delete profiles.

Logging on to MAXPRO VMS

1. Double-click  in the desktop. The Log On dialog box appears.
or 
Click Start -> Programs -> Honeywell -> MAXPRO VMS. The Log On dialog box 
appears.

Figure 2-1    MAXPRO VMS Log on 

2. Click the Language option, and then select the required language. 
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3. In the User Name box, type the user name. The default user name is “Admin”.

4. In the Password box, type the configured password.

Note: Honeywell recommends you to change the default Password before you logon to 
MAXPRO VMS. See Changing the Default Password  section. Refer to Securing MAXPRO® 
VMS Technical Notes for further details. Logon as Administrator only when an 
administrative activity need to be performed, Operator is preferred for all other 
activity.
Select the Windows Logged-In User check box for logging on using the Windows user 
name and password. If the Windows Logged-In User check box is cleared, the 
MAXPRO VMS user name and password is used for authentication. 

5. In the Profiles box, select the profile corresponding to the MAXPRO VMS server 

you want to connect to and press ENTER or click .

Changing the Default Password
Honeywell recommends you to change the default password and create a new 
password before logging on to MAXPRO VMS software. Refer to Securing MAX-
PRO® VMS Technical Notes for further details

To change the default password:

1. In the client workstation, double-click  in the desktop to display the Log On 

dialog box.

2. Click Change password. The Change Password dialog box appears.

3. Select the Profile from the drop-down list for which you want to change the 
password.

4. Type the Username. For Fresh installation admin is the user name.
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5. Type the Old Password.

Note: Old password is blank for Fresh installations.
In upgrade scenarios, enter the old password which is configured before upgrading. 
Refer to Securing MAXPRO® VMS Technical Notes for further details. Logon as 
Administrator only when an administrative activity need to be performed, Operator is 
preferred for all other activity. 

6. Type the New password. The new password should meet the following 
requirements:

• minimum character Length should be 12

• one number

• one uppercase letter and 

• one special character

7. Type the new password once again to Confirm Password.

8. Click Save.

Password Requirement
Ensure that the new password must meet the following requirements.

1. Minimum length – 12 and Maximum length – 20

2. Password should consists one number, one uppercase letter and one special 
character.

a. Number– a digit zero through nine in any script except ideographic scripts.
b. Uppercase letter – any kind of letter from any language which has 

uppercase variant.
c. Special character – any kind of punctuation character – any kind of hyphen, 

dash, opening bracket, closing bracket, quotes, underscore etc

Saving a Server Address in a Profile

1. In the client workstation, double-click  in the desktop to display1 the Log 

On dialog box.

2. Click Server Settings. The Server Settings dialog box appears.

1.
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Figure 2-2    Server Settings

3. Click Add.

4. In the Profile Name box, type a name to identify the profile.

5. In the Server IP/Name box, type the numerical IP address or the network name 
of the MAXPRO VMS server.

6. Click Save.

7. Click OK. The server address is saved in the profile.

Note: You can click Set Default to set the profile as default profile.

Setting the Default Profile
To set the default profile

1. Select the profile you want to set as default before logging on to MAXPRO VMS.

2. In the user menu, click Profiles and select Set Default Profile. The profile is set 
as the default profile. The default profile appears selected in the Profile box in 
the Log On dialog box.

Modifying a Profile
You can modify the profile name and the server address saved in the profile. 

To modify a profile

1. In the client workstation, double-click  in the desktop to display the Log On 

dialog box. 

2. Click Server Settings. The Server Settings dialog box appears.
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3. In the Choose Profile box, select the profile you want to modify. The profile 
details appear under Configuration in the Server Settings dialog box.

4. In the Profile Name box, you can change the profile name.

5. In the Server IP/Name box, you can change the server address.

6. Click Save.

7. Click OK.

Deleting a Profile
To delete a profile

1. In the client workstation, double-click  in the desktop to display the Log On 

dialog box. 

2. Click Server Settings. The Server Settings dialog box appears.

3. In the Choose Profile box, select the profile you want to delete.

4. Click Remove.

5. Click OK. The profile is deleted.

Logging Off
You can log off from MAXPRO VMS from the user menu. The name of the currently 
logged in user is displayed as the user menu on the top right of each screen.

To log off from MAXPRO VMS

1. Click the User menu. The user menu options appear.

2. Click Log Off. The log on dialog box is displayed after logging off from MAXPRO 
VMS.

Closing the MAXPRO VMS User Interface
You can close the MAXPRO VMS user interface from the user menu. The name of 
the currently logged in user is displayed as the user menu on the top right of each 
screen.

To close the MAXPRO VMS user interface

1. Click the User menu. The user menu options appear. 

2. Click Exit. A dialog box appears prompting you to confirm the action.

3. Click Yes.
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Familiarizing with the MAXPRO VMS user interface
The user interface of MAXPRO VMS is easy-to-use because of its intuitive icons 
and user friendly features. You can monitor the sites and configure the devices in 
the video surveillance network through the MAXPRO VMS user interface. The user 
interface consists of tabs, tree-structures, status bar, floating windows, and icons. 
On opening the user interface, you see five tabs, namely the Viewer, Configurator, 
Search, Report and Analytics. Based on the tab you select, windows, tree struc-
tures, and other settings relevant to the tab appear on the screen.

A status bar is displayed in the lower part of the user interface. The status bar indi-
cates the connection status with the MAXPRO VMS server and controller, the MAX-
PRO VMS server name, status of clip creation, role of the user, number of 
unacknowledged alarms, number of messages sent to you, the CPU usage, and 
time. In addition, you can turn on the Virtual Keyboard feature to select salvo lay-
outs, panels, cameras, and monitors. 

Viewer tab
The following figure illustrates the Viewer tab. 

The following components are displayed on the screen.
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Component Description

Devices window A floating window that displays recorders, switchers, and cameras 
in a tree structure. You can select one or more devices from the 
Devices window to view video in the Salvo Layout. 
A drop-down list on the top of the Devices window lists the 
partitions. You can select a partition in the drop-down list to view 
the devices from the particular partition. Selecting the All 
Partitions option in the drop down box displays the devices from 
all the partitions in the tree view. 
The status of the devices also appear in the window. See . You can 
right-click on the devices to display context menu.
Intellisense search
The Intellisense search option makes the search of cameras 
simpler and easier. When a part of the camera name is types in the 
text box, the Intellisense search displays the list of cameras that 
are connected to various recorders in the Devices window. For 
example, if you are searching for Camera 2 connected to particular 
recorder, then type Ca in the text box, the list of camera names 
that contain 'ca' are displayed. 
Intellisense search also supports wild characters while 
searching. For example, 

• ca* — camera names that begins with the 'ca' are 
displayed. 

• *ca — camera names that ends with the 'ca' are 
displayed. 

• *ca* — camera names that contain the 'ca' are displayed. 
• ! ca — cameras that does not have 'ca' in their name are 

displayed. 
Select the required filter string and click on the filter button.You 
can toggle between the Filter On and Off mode using the option 

or right-click , and select between Filter ON and Filter OFF. 
The hot key to activate intellisense search is F4.
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Devices window 
continued...

The context menu options in the Devices window include:

• Show Live - to view live video.
• Preview - to view the preview of a particular camera for 

different timings in a day.
• Calender - to view the video for the current month.
• Snapshot View - to view the snapshots from the 

recorded video. You can view the snapshots from 1 
second, 5 seconds, 15 seconds, 1 minute, 5 minutes, 15 
minutes, 30 minutes, 45 minutes, 1 hour, 3 hours, 6 
hours, 12 hours, and 1 day. 

• Show Device ID - to display the device ID. The ID is 
specified while adding the device and is useful to 
perform operations using virtual keyboard. 

• Hide Device ID - to hide the display of device ID.
• Refresh - to refresh the camera status.
• Refresh from Device - to refresh the camera status from 

device. 
• Reload Device - to reload device. 
• Group By - to group the cameras based on the site or 

device. 
• Sort By - to sort the list of devices by name or callup 

number. By default, names and callup numbers are 
sorted in ascending order. 

• Add to MyDevices - to add devices to MyDevices. 
• Collapse All - to collapse the device tree. 
• Expand All - to expand the device tree. 

Monitors window Click to display a floating window that lists the monitors. You can 
view both analog and digital monitors from this window. 
A drop-down list on the top of the Monitors window lists the 
partitions. You can select a partition in the drop-down list to view 
the monitors from the particular partition. Selecting the All 
Partitions option in the drop down box displays the monitors from 
all the partitions in the tree view. 
You can right-click on the Monitors to display context menu. The 
context menu options include: 

• is specified while adding the device and is useful to 
perform operations using virtual keyboard. 

• Show Device ID - to view the device ID. The ID Add to 
MyDevices - to add devices to MyDevices. 

• Sort By Name - to sort the list of devices by name. By 
default, names are sorted in ascending order.

• Expand All - to expand the monitors tree. 
• Collapse All - to expand the monitors tree. 

Alarm Window Click to display a floating window that lists the alarms. You can 
acknowledge and clear the alarms from this window. 

Component Description
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Image/Clip Window Click to display a floating window that lists the images and clips in 
a tree structure. You can select the images and clips to view. 
You can right-click on the images folder or the images to display 
context menu. The context menu options include:

• Refresh - to refresh the images/clips in the respective 
folder.

• Verify Package - to extract the package clip 
• Image View - to view the images.
• Show In Folder - to view the folder in which the images 

are stored.
• Add New Location - to add a new location other than 

default location to store the clip export
• Remove Location - You can remove the newly added 

location
• Search For Multiple Clips - to search for multiple clips 
• Switch To List View - to view the images/clips in list view 

other than folder view
• Delete - to delete an image. 

Bookmarks Window Click to display a floating window which includes the list of 
bookmarks created by the user.These bookmarks are displayed 
based on the user privileges.
You can right-click on the any Bookmark to display context menu. 
The context menu options include:

• Play From Bookmark Time - to view the video from the 
specific bookmark time. You can also drag and drop any 
bookmark on to the video panel to view video from that 
bookmark time.

• Send Message - to send Bookmark to the desired users 
in the form of operator message 

• Delete - to delete the selected bookmark.

Component Description
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My Devices 
Window

A floating window that lists in a tree structure, the devices such as 
cameras, monitors, and sequences.
You can drag and drop devices from the Devices, Sequences and 
Monitors window to MyDevices window You can group these 
devices according to your preferences in separate folders. 
To create a folder 

1. Right-click on MyDevices or SharedDevices in the 
My Devices window and select Add New Folder. A 
new folder appears with a default name. 

2. Type a name for the folder and press ENTER.
Note: Ensure that the folder name should not contain & character. 
If the folder name contains & character you cannot drag drop the 
folder in VMS viewer.
This feature is useful to group video sources which are frequently 
selected. The video sources can be selected easily when needed 
instead of looking in the Device window which generally consists 
of many video sources.
The status of the devices also appear in the window. 
The devices are displayed only when the user who included the 
devices in My Devices window logs on.
You can copy a device from MyDevices to Shared Devices and 
from Shared Devices to MyDevices using the drag and drop 
option.
Devices grouped under shared devices are displayed on all client 
workstations irrespective of the logged in user. To group devices 
under SharedDevices, drag and drop the devices from MyDevices. 
Similarly you can drag and drop to copy devices from 
SharedDevices to MyDevices. This ensures that you retain the 
device even if an operator deletes the device in SharedDevices. 

My Devices window 
continued...

You can right-click on my devices to display a context menu. The 
context menu options include:

• Show Live - to view live video.
• Preview - 
• Show Device ID - to display the device ID. The ID is 

specified while adding the device and is useful while 
performing or using virtual keyboard.

• Remove - to remove the device from the list. 
• Refresh - to refresh the camera status.
• Refresh Tree - to refresh the tree list. 
• Refresh from Device - to refresh the camera status from 

device. 
• Sort By Name - to sort the list of devices by name. By 

default, names are sorted in ascending order.

Component Description
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Messages window You can right-click on the devices to display a context menu. The 
context menu options include:

• Review - to review the message.
• Show Live - to view live video.
• Send To - to forward the message to operators or digital 

monitors. 
• Clear - to clear the message. 
• Clear All - to clear all the messages. 

Sequences window Click to display a floating window that lists the sequences. You can 
play the sequence using the play sequence action. 
You can right-click on the devices to display a context menu. The 
context menu options include:
• Play Sequence - to play any sequence.

• Show Sequences ID - to display the device ID. The ID is 
specified while adding the device and is useful to perform 
operations using virtual keyboard.

• Add to My Devices - to add sequences to My Devices 
list. 

• Sort By Name - to sort the list of sequences by name. By 
default, names are sorted in ascending order. 

Views window A floating window that lists the salvo views. View window consists 
of My Salvo Views and Shared Salvo Views. Salvo views 
corresponding to the logged on user are listed under My Salvo 
Views in Views window. You can copy a salvo view from My Salvo 
Views to Shared Salvo Views using the drag and drop option or 
right-click and select Add to Shared Salvo Views. Similarly, you 
can copy a salvo view from Shared Salvo Views to My Salvo Views 
using the drag and drop option. Devices grouped under Shared 
Salvo Views are displayed on all client workstations irrespective of 
the logged in user.
To add a salvo view to Shared Salvo Views, right-click on a salvo 
view, and then click Add to Shared Salvo Views. You can copy a 
salvo view from Shared Salvo Views to My Salvo Views by 
dragging and dropping a salvo view. 
You can right-click on the devices to display a context menu. The 
context menu options include:

• Show - to view the salvo view. 
• Rename - to rename a salvo view. 
• Remove - to remove a salvo view. 
• Save - to save a salvo view. 
• Add to Shared Salvo Views - to add a salvo view to the 

Shared Salvo views. 
• Show View ID - to display the view ID. The ID is specified 

while adding the device and is useful to perform 
operations using virtual keyboard. 

• Refresh Tree- to refresh the tree list. 
• Sort By Name - to sort the list of salvo views by name. By 

default, names are sorted in ascending order. 

Component Description
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Configurator tab
The following figure illustrates the Configurator tab.

The settings in the Configurator tab enable you to add and configure the video 
devices and setup the MAXPRO VMS system.

Search tab
The following figure illustrates the Search tab. 

Salvo Layout An arrangement of panels in which video is displayed. 

Timeline window A window that enables you to view recorded video from a specific 
date and time. It also consists of other features such as loop 
playback of video using mark in and mark out and selective 
viewing through bookmarks. You can also view the Redundant 
recorder recordings in a different color. You can also create clips 
from video recordings. You can select between the scrub mode or 
full timeline mode using

 .

Component Description
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You can search for recorded video and events from various recorders from the 
Search tab. 

Components Description

Device View Window (Navigation 
Area)

Displays branches in a tree structure namely, Devices, 
User Management, Groups, Server, Association, 
Migrator, IP Camera Management and Scheduling. 
Each branch can be expanded to display more items. 
For example, the Devices branch when expanded 
displays items such as Recorders and Cameras. 
Selecting an item displays the relevant settings in the 
display area. For example selecting the Recorders 
displays the settings to add, update, and delete 
recorders. 

Display Area Displays the settings based on your selection in the 
Device View window.
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Report tab
The following figure illustrates the Report tab. 

You can generate the event history and operator log report from the Report tab.
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Analytics Tab
The following figure illustrates the Analytics tab.
MAXPRO®VMS R670 Operator’s Guide 67



Introducing Web Client
The MAXPRO VMS Web Client allows you to remotely access the MAXPRO VMS 
server and perform video surveillance using a web browser such as Internet 
Explorer. It gives you the flexibility to view live video and perform the basic video 
surveillance functions remotely over the web. 

MAXPRO VMS Web client is available with MAXPRO VMS R310 Build 321 or above. 
By default MAXPRO VMS installs the Web client and MAXPRO Web Configurator 
along with the VMS R310 installation. You can use the web client once you have 
installed the VMS R310 Build 321 or above.

MAXPRO VMS Web Client functions involve the following tasks:

• Viewing the live video

• Viewing Recorded Video (Playback)

• Taking Snapshot

• Viewing Presets

Installing Web Client
By default MAXPRO VMS R310 Build 321 or above installs the Web Client compo-
nent on your machine. It also installs the MaxproWEBConfigurator utility to 
change or update the system and server configuration. If you want to access the 
MAXPRO VMS Server using Web Client remotely through a supported web browser 
then you should install Silverlight on the remote machine.

Note: If the VMS install or upgrade prompts to install the MAXPRO Web component 
manually, refer to steps in appendix B for manual install

Prerequisites to access MAXPRO VMS Server through Web Client
The following are the prerequisites to access the MAXPRO VMS server through 
Web Client.

• Silverlight: Ensure that Silverlight version 5 and above is installed on your 
machine. If you don't have the Silverlight plug-in on your machine, you can 
download it from the following Microsoft link. “http://www.microsoft.com/
getsilverlight/Get-Started/Install/Default.aspx”

• Web Browsers Supported on Windows Systems: Ensure that Internet 
Explorer version 8 or above, or Firefox version 15.0.1 or above or Chrome 
version 32.x or above is installed on your PC.

• Web Browsers Supported on MAC systems: Ensure that Safari version 7 or 
above is installed on your MAC machine.
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Caution:  For better security, close the browser upon logout.

Setting the MAXPRO Web Configurator

MAXPRO VMS by default installs the Web Configurator and  is displayed on 
your desktop.

MAXPRO VMS Web Configurator is a utility and it allows you to perform the follow-
ing:

1. System Configuration 

2. Server Configuration

3. Security Configuration

System Configuration tab: The system configuration tab allows you to:

• update the administrator user credentials used by the web server. By default 
admin is the username and type the configured password. It is 
recommended not to change the default settings.

Note: You can update only the Administrator credentials used by Web Server only. The 
Administrator credentials used by the Web Server should be configured as a non-
Windows Administrator user in the MAXPRO VMS through the desktop client.

• allows you to enable the operations for cameras from web client. It is not 
recommended to use this feature in the current release.

• allows you to select the FPS for a better Stream quality. It is recommended 
not to change the default settings.

• select the protocol for secure communication. The available options are 
HTTP and HTTPS. By default HTTP is set.

Server Configuration tab: The server configuration tab allows you to update the 
Web Server and MAXPRO VMS Server IP details.

Security Configuration tab: The Security Configuration tab automates the manual 
process of Creating Self Signed Certificate, Installing the Certificate, Binding the generated cer-
tificate with https and registers the same with IIS to use the same. It also allows you to 
configure the Silverlight control to access a service in another domain.

Note: Honeywell recommends you to use a valid certificate from a Certificate Authority that 
would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.
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To set the Web Configurator

1. Double-click  on the desktop. The MAXPRO Web Configurator dialog box 
appears.

Figure 2-3    System Configuration

Note: By default the System Configuration tab is selected.

2. Under User Configuration: When the (non-window) Administrator login name 
and password is changed then you can update the credentials here to change 
the login and password of MAXPRO VMS Web Client to logon to web client.

• Type the Username and Password and then click Update.

Note: You can update only the Administrator credentials used by the Web Server. If you are 
changing the default administrator user credentials in VMS through the desktop 
client, then you should change and update the credentials in 
MaxproWEBConfigurator as well for Web Server to communicate with VMS and Web 
Clients to work. 
The Administrator credentials used by the Web Server should be configured as a non-
Windows Administrator user in the MAXPRO VMS through the desktop client. As a 
good security practice, it is recommended to update the default credentials on your 
system.

3. Under Stream Quality Configuration:

• Select the required FPS options as applicable and then click Save. The 
available options are:
70 MAXPRO®VMS R670 Operator’s Guide 



• As Per Frame: Select this option to view the video as per the camera stream 
settings. If the camera supports 30 frames per second to stream the video 
then you can view 30 frames per second and accordingly your bandwidth is 
consumed. By default As Per Frame option is selected and it is 
recommended not to change this option, because this provides you with the 
best quality video.

• Only IFrame: select this option if your bandwidth is low and if you want to view only 
one IFrame per second.

Note: MAXPRO VMS Web Client supports streaming quality resolution up to 1080p. 
Cameras configured above 1080p resolution are not supported. If you drag and drop 
a camera configured with megapixel resolutions (above 1080p) resolution then a 
message appears and video is not displayed as shown below.

4. Under Protocol Configuration:

• Click the appropriate Protocol options for secure communication. The 
available options are HTTP, HTTPS and HTTPs (Only Video). By default HTTP 
protocol is selected.
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Note

• Video to the Web Client is always transmitted over HTTP. Non-video data is 
transmitted over HTTPS/HTTP based on the protocol configuration settings.

• Please ensure ports required for both video and non-video data are considered 
in any port forwarding settings required.

Note: If you want to access the web client using secured connection then click the HTTPS 
option. When you access the MAXPRO VMS server using the URL https://<MAXPRO 
VMS Server IP or Machine /Computer name>/MAXPROWEB/ then the following 
message is displayed. Click Continue to this website to proceed.

The above message appears by default when you access the VMS server for the first 
time. You can choose to buy a domain name specific certificate, create it and then 
install it. See Creating Self Signed Certificate and Installing the Certificate. sections. 
Honeywell recommends to use a valid certificate from a Certificate Authority that 
would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.
Or 
You can create a self signed certificate and then install it. See Creating Self Signed 
Certificate and Installing the Certificate sections.
The above settings are applicable to Internet Explorer, Chrome, Firefox and Safari 
web browsers and these settings are valid if the web client is accessed using the 
Domain/Host Name. If you access the web client using the IP then the above settings 
are not valid.

5. Under PTZ Configuration:

• Select the Enable PTZ check box to perform PTZ operations on a camera 
from Web Client. Enable PTZ will help in performing PTZ operations for 
DOME camera from Web Client. It is not recommended to use this feature in 
the current release.

Note: This feature is not supported and It is not recommended to use this feature in the 
current release.

6. Click Save.
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7. Click the Server Configuration the following screen appears.

Figure 2-4    Server Configuration

Note: The Web Server and MAXPRO Server are both installed on the VMS server machine 
by default and the IPs are set by default to local IP or computer/machine name. It is 
recommended to change these settings to VMS Server (local) computer/machine 
name, if it is not set by default in your system. For Honeywell supplied VMS boxes, 
default computer/machine name is MAXPRO-VMS and can be updated in the 
configuration from the tool.

8. Under Server Configuration: 

• Web Server IP: If the MAXPRO VMS server computer/machine name or IP (as 
applicable) is changed then you should change the Web Server IP. Type the 
new computer/machine name or IP (as applicable) in this box.

• MAXPRO Server IP: If the MAXPRO VMS server computer/machine name or 
IP (as applicable) is changed then you should change the MAXPRO Server IP. 
Type the new computer/machine name or IP (as applicable) in this box. 

• Server Public IP: If you want to host the MAXPRO Web client via Internet (or 
Public) then you need to provide the Public Server IP.Type the new Public IP 
(as applicable) in this box.

Note: Both Web Server IP and MAXPRO Server IP should be same.

9. Under Port Configuration:

• Http Port: If you want to change the http default port 80 to some other port 
number then type the required port number and click Apply.
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• Https Port: If you want to change the https default port 443 to some other 
port number then type the required port number and click Apply.

Note: Port change option in the configurator tool is available only in R310 Build 292 or 
higher version.

10. Under MUSS Deployment, click the MAXPRO VMS or NVR option to deploy.

• MAXPRO VMS

• MAXPRO NVR

11. Click Save.

12. Click the Security Configuration tab. The Security Configuration screen 
appears.

Figure 2-5    Security Configuration

13. Under SSL Certificate Configuration:

• Type the Port number in the box provided if the Https binding is other than 
443 and the click Apply. The default port is 443. 

14. Under Transport Security, select the Enable Strict Transport Security check box 
to avoid or protect from hacking.

15. Under Client Policy Configuration: Allows you to modify the 
C:\inetpub\wwwroot\clientaccesspolicy.xml & 
C:\inetpub\wwwroot\crossdomain.xml file.
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• Click the required Silverlight Client Policy option. The available options are 

• Auto Generate (Default): This options makes entries to the above files such that 
the local Silverlight application (Web client) is able to make request to local ISOM.

• Manual: If Web Client and ISOM are on different machine or any other Silverlight 
application is trying to access ISOM then the above xml file need to be modified. 
Choose manual to make the modification manually. For more information on 
configuring Cross Domain or Client Access Policy browse the below websites: http:/
/www.adobe.com/devnet/articles/crossdomain_policy_file_spec.html 
https://msdn.microsoft.com/library/cc197955(v=vs.95).aspx

• Allow All (non Secure): Non secure mode. If you want to allow all Silverlight clients 
to connect to ISOM hosted on the machine then you can click this option. Use with 
caution. This options also helps to troubleshoot the wrong configurations by 
providing full access temporarily.

Note: Auto mode is flexible and is the recommended mode.
Caution:  Ensure that you exercise caution while choosing the options other than the Default.

16. Click Save.

Logging on to MAXPRO VMS Web Client

To log on to MAXPRO VMS Web Client

1. Type the URL https://<MAXPRO VMS Server IP or Machine/Computer name>/
MAXPROWEB/ in your web browser and then press Enter. The login page 
appears.

Note: <MAXPRO VMS Server IP or Computer/Machine name> needs to be replaced by the 
IP address or computer/machine name (as applicable) of the MAXPRO VMS Server 
machine on which both the Web Server and VMS Server are installed by default.
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Figure 2-6    MAXPRO WEB Login page

Note: If Silverlight is not installed on your machine then a message

is displayed. If you are using Internet connection then you can click 
the link Get Microsoft Silverlight to download the Silverlight. See Prerequisites to access 
MAXPRO VMS Server through Web Client section to install Silverlight.

2. Type your Username. The default user name is “admin”.

3. Type your configured Password.

Note: Enter the user credentials that are configured in VMS.
By default the Start In drop-down list is selected with View Video option.

4. Click Login. The below MAXPRO VMS Web page appears if your credentials are 
successfully validated. The name of the currently logged in user is displayed as 
admin on the top left of the page.
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Figure 2-7    MAXPRO VMS Web Page -Initial View

5. Under Live Video pane, click the MAXPRO VMS node. The list of cameras 
configured in the MAXPRO VMS server is displayed.

Note: The list of cameras displayed is based on the user or operator permissions configured 
in the MAXPRO VMS Server.

Sign out
To sign out from the MAXPRO VMS Web Client page

• Click Sign out on the top right corner of the page.
Caution:  For better security, close the browser upon logout.

Familiarizing with the Web Client Page
The web page of MAXPRO VMS Web client consists of tree-structure, floating win-
dow, and icons. On opening the page, you see the following: Live Video Pane and 
default Salvo view.
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MAXPRO VMS Web Page
The following figure illustrates the MAXPRO VMS Web Page. 

Figure 2-8    MAXPRO VMS Web Client Page-Familiarization

The following components are displayed on the screen.

Component Description

Live Video or Camera 
Pane

Displays the list of cameras which are configured in 
MAXPRO VMS.

Configured Cameras List of configured cameras which are available to render 
video.
To view the list of cameras in Live video pane, you 
should configure the cameras in MAXPRO VMS, refer to 
MAXPRO® VMS Installation and Configuration Guide. 
The list of cameras listed is based on the user or 
operator permissions configured in the MAXPRO VMS.

Accessing over LAN or 
WAN

Select this check box if you want to access web client 
using LAN connection.
Clear this check box if you want to access web client 
using WAN connection.
By default this check box is selected when you login the 
web client page.

Salvo Layout An arrangement of panels in which video is displayed. 
Select the required layouts to view the video. The Salvo 
views can be resized. See Resizing the Salvo section.
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Video Control Options
The toolbar that appears on top of a panel enables you to view the name of the 
video source and take snapshot for a particular video panel. The toolbar that 
appears on the bottom and on the right of a panel consists of icons that enable you 
to perform the following actions:

Snapshot Icon Click to take a snapshot of entire salvo layout.

Floating Window Click to display different salvo layouts and snapshot 
icon. You can select the required salvo view to view the 
video in the panel.

Close Button Click to close all the panel at once.

Component Description

Icon Click to...

set the date and time for playback. See Viewing Recorded Video 
section.

view the live video. See Live Video section.

displays a drop-down list of presets. You can select a preset for the 
camera. See Viewing Presets and Creating Self Signed 
Certificate sections.

display the playback settings. See Viewing Recorded Video 
section.

view the live video while you are in playback. See Viewing 
Recorded Video section.

take a snapshot for the required panel. You can view this icon 
when you hover the mouse on the top of a panel. See Taking a 
Snapshot section.

close the required panel. You can view this icon when you hover 
the mouse on the top of a panel
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MAXPRO VMS Web Client Features
MAXPRO VMS Web Client features includes viewing live video, playback, taking 
snapshots and viewing presets.

Live Video
You can view live video using the option available in MAXPRO VMS web client. The 
panels in the salvo layout display video. You can select the video source from cam-
eras on the Live Video pane.

select the required salvo view to arrange the panels. See Resizing 
the Salvo section.

close all the panels in a salvo layout.

Icon Click to...
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Note: To view the list of cameras in Live video pane, you should configure the cameras in 
MAXPRO VMS refer to MAXPRO® VMS Installation and Configuration Guide. The list 
of cameras listed is based on the user or operator permissions configured in the 
MAXPRO VMS.

To view live video

• Drag and drop the required video source from the Live video pane on a panel 
in the salvo layout. 
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Figure 2-9    Web Client - Live Video

Note: Anonymization is not supported in Web. If user is tries to see Anonymized video and 
also camera Anonymized option is enabled then an error message “Trying to access 
Anonymized Stream” is displayed.

Troubleshooting Tip. If the video is not streaming through web client then perform 
the below steps to reset Internet Explorer (browser) to default settings except user 
specific settings like favorites, bookmarks etc: 

1. In Internet Explorer navigate to Tools -> Internet Options -> Advanced tab and 
then click the Reset button. The Reset Internet Explorer Settings dialog box 
appears.

2. Select ‘Delete personal settings’ check box and then click the Reset button.

3. Close and then open the Internet explorer.

Note: MAXPRO VMS Web Client supports streaming quality resolution up to 1080p. 
Cameras configured above 1080p resolution are not supported. If you drag and drop 
a camera configured with mega-pixel resolutions (above 1080p) then a message 
appears and video is not displayed as shown below.
82 MAXPRO®VMS R670 Operator’s Guide 



You can view live video in different panels of the salvo layout. When you hover the 
mouse over a video display, a toolbar appear over the panel. The toolbar enables 
you to perform actions such as Playback, Live video, taking snapshots and viewing 
Presets.

Note: Each MAXPRO VMS box has a limit of 32 streams for both live and playback feature 
combined. Even if the same camera is opened for live in multiple web clients then it 
consumes only 1 stream. Each playback function consumes 1 additional stream 
always.

Resizing the Salvo
You can view the salvo layout when you select the available options on the floating 
window tab. At a time, you can select one of the salvo layout. For example: If you 
want to view video from two cameras, select a salvo layout with two or more panels.

To resize the salvo layouts

• Click the required salvo layout options available on the floating window.

Viewing Recorded Video
You can easily retrieve and view recorded video using the date and time controls in 
the panel toolbar. When you select a camera from the live video pane to view video, 
a toolbar appears.

Note: Each MAXPRO VMS box has a limit of 32 streams for both live and playback feature 
combined. Even if the same camera is opened for live in multiple web clients then it 
consumes only 1 stream. Each playback function consumes 1 additional stream 
always.

To play recorded video

1. Drag and drop a camera from the Live video pane into the panel.

2. Hover the mouse at the bottom of a panel over live video. A tool bar appears. 
MAXPRO®VMS R670 Operator’s Guide 83



Figure 2-10    Web Client - Playback

3. Click .

4. Select the date and time in the date and time calendar box 

and then click . The video recording is played from the selected date and time.

Navigation Tip. At any point of time, click  to go back to the Live video view.

Note: When an Operator (non-admin) logs into the Web Client and tries to view playback for 
any video then an error message “Four Eye authentication Privilege Failure” is 
displayed.

Viewing Presets
Preset can be viewed in web client if the camera is a camera. To view Presets in web 
client you need to define the presets in MAXPRO VMS. To configure presets in 
MAXPRO VMS, refer to MAXPRO® VMS Installation and Configuration Guide.

To View Presets
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1. Hover the mouse at the bottom of a panel over live video. A tool bar appears.

Figure 2-11    Web Client - Presets

2. Click  and then select the required preset from the drop-down list 
to view the configured preset.

Note: To view Presets in web client you need to define the presets in MAXPRO VMS. refer to 
MAXPRO® VMS Installation and Configuration Guide.

Taking a Snapshot
You can take snapshot of the single video panel in a salvo and also all video panels 
in a salvo.

Note: Snapshot feature is not supported on Mac and print screen feature in Mac can be 
used alternatively.

To take a snapshot of all the video panels in a salvo
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1. Click  on the rightmost pane of the web page. A confirmation message 
appears.

Figure 2-12    Confirmation dialog - All Salvo Views

2. Click OK to save the snapshot.

To take snapshot of the single video panel

1. Hover the mouse at the top of a panel over a live a video. A tool bar appears.

2. Click . A confirmation message appears

Figure 2-13    Confirmation dialog - Single Video Panel

3. Click OK to save the snapshot.
Caution:  For better security, close the browser upon logout.

Creating Self Signed Certificate
Note: Honeywell recommends you to use a valid certificate from a Certificate Authority that 

would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.
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Self signed certificate is required if you want to access the MAXPRO VMS server 
using your domain name. You should create a certificate, bind it to the https and 
then install the certificate to access the server using the web browser (Internet 
Explorer, Chrome, Firefox and Safari).

To create self signed certificate

1. Open the Internet Information Manager (IIS) window.

2. Select the server node under Connections pane.

3. Under IIS, double -click the Server Certificate option as shown below.

Figure 2-14    Server Certificate.

The Server Certificate window is displayed as shown below.
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Figure 2-15    Server Certificate

4. Click the Create Self-Signed Certificate on the rightmost pane. The Specify 
Friendly Name dialog appears.

Figure 2-16    Specify Friendly Name

5. Type a friendly name for the certificate and then click OK. A new certificate is 
generated and listed under server certificates list as shown below.
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Figure 2-17    Generated Certificate

Binding the generated certificate with https
To bind the generated certificate with the https

1. In the Internet Information Manager (IIS) window, expand the server node 
under Connections pane.

2. Navigate to Sites > Default Web Site.

3. Click Bindings in the rightmost pane. The Site Bindings dialog appears.
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Figure 2-18    Site Bindings Dialog

4. Select the type as https and then click Edit. The Edit Site Bindings dialog 
appears.

Figure 2-19    Edit Site Bindings

5. Select the Demo SSL certificate from the SSL Certificate drop-down list.

6. Select All Unassigned from the IP Address drop-down list. 

Note: Ensure that you select All Unassigned option from the IP Address drop-down list and 
the port should be 443.

7. Type the port number as 443. 

8. Click OK.
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Installing the Certificate
Once you have created a self signed certificate you need to install the certificate in 
the Internet Explorer on machines accessing the web client. If you do not install the 
certificate then the web browser displays the following error.

Note: Honeywell recommends you to use a valid certificate from a Certificate Authority that 
would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.

Caution:  For better security, close the browser upon logout.

Figure 2-20    Certificate Error

To view the error details, click on the Certificate Error message. A Untrusted Certifi-
cate message box is displayed as shown below.

Figure 2-21    Untrusted Certificate

To install the certificate

1. Click View Certificate as shown in figure 21. The Certificate dialog box appears

Note: You can install the certificate using Internet Explorer. Once the installation is done 
you can access the MAXPRO VMS server using other browsers on the same machine 
using your domain name.
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Figure 2-22    Certificate

2. Click the Install Certificate button. Certificate Import Wizard dialog box appears

Figure 2-23    Certificate Import Wizard

3. Click the Browse button and then select the Trusted Certificate Authorities 
option.

4. Click Next until Finish button is displayed.

5. Click the Finish button. A confirmation message “you want to add the new 
certificate” is displayed.
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Setting Preferences
The Preferences option in the user menu enables you to configure the general set-
tings and the On Screen Display (OSD) settings. In general settings, you can con-
figure the frame rate for panels that are not selected in the salvo layout, the video 
rendering settings, the video to be displayed for alarms, the alarm threshold set-
tings, the Event Handling mode settings and the SnapShot Clip Export Settings. 
The OSD settings can be configured to change the color for the text that appears 
over the video displayed in a panel.

You can also select the default values for the general and OSD settings using the 
Preferences option. MAXPRO VMS R310 and above versions supports three modes 
of encryption between client and server. On the Advance Settings tab you can 
select the options such as Default Encryption, Windows Authentication Encryption 
and Certificate Based Encryption under the Application Security Settings for 
secure communication.

Note: Honeywell recommends you to use a valid certificate from a Certificate Authority that 
would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.

Settings for Video Rendering
There are two types of rendering modes namely, Default and No Video Display. The 
Default rendering is the recommended mode which enables the user to view live 
video from multiple cameras at optimum quality. Selecting No Video Display will 
not display any video. You can also set the frame rate for panels that are not 
selected in the salvo layout. The frame rate for the panels that are not selected can 
be set to improve the video signal transmission over lower bandwidth networks.

To select the video rendering option 
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1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. By default, the General Settings tab is selected. 

Figure 2-24    Preferences

2. Click the Rendering Settings tab. 

Figure 2-25    Rendering Settings

3. In the Renderer Option drop-down list, select one of the options for video 
rendering. 

4. Select the Manage CPU Load (Throttle Frame Rate) check box if you want to 
throttle the frame rate if the CPU usage reaches 90 per cent. 

5. Select the Show Time Stamp For Live check box if you want the camera name 
and time to be displayed on the live video.

6. Select the Deinterlace Selected Panel check box if you want to deinterlace the 
selected panel.
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7. Select the Support 64 Bit Rendering check box if you want to render in 64 bit 
mode. To know about the improvised GPU rendering feature, refer to the 
MAXPRO® VMS Installation and Configuration Guide for complete details on 
How to configure the Registry value to experience the improved GPU rendering 
mode and to render video through GPU rendering mode.

Note: This feature is applicable only for NVR Driver 64 bit machines and for other machines 
32 bit rendering server is required. Scan Sequence with more than 16 cameras is not 
recommended with GPU Rendering.

8. Select the Enable Multicast Support check box to view Live video continuously 
in VMS clients despite of any interruption in NVR recorders. Refer MAXPRO® 
VMS Installation and Configuration Guide for more information on various 
configurations of Multicast.

Note: Ensure that you enable this option in NVR and in the Network switch to function. 
Refer MAXPRO® VMS Installation and Configuration Guide for more information

9. Select Show Stream Details check box to view the stream details in the video 
panel.

10. Select View Annotations When a Camera is Displayed check box if you want to 
view the annotated bounding boxes immediately when a camera is displayed in 
salvo. This is applicable for Mask Detection and Social Distancing Violation 
detection also.

11. Select the Switch to I Frame For Unselected Panel check box if you want to 
render I Frame video packets for the unselected panels.

12. In the FPS Limit box, select a frame rate. The default frame rate is 5 fps and is 
the recommended setting for unselected panels.

13. Under Advanced Rendering Settings:

• Rendering Mode: Select the required option from this drop-down list to 
change the rendering mode in combination with GPU and CPU. The 
available options are:

• CPU Decompress + CPU Render: This option executes low performance because 
entire video rendering process will be on CPU. This option is for debugging 
purpose and is recommended not to be selected.

• GPU Decompress + CPU Render: By default this option is selected and 
decompression/rendering process is shared between GPU and CPU.

• GPU Decompress + GPU Render: This option is for high resolution cameras and for 
cameras with 60 FPS on 4K monitors. Selecting this option may reduce the number 
of cameras but the video quality will be best. 

Note: GPU Decompress + GPU Render option has some limitations such as Flip/Mirror/
Digital corrections features may not be supported.

14. Select the Smooth Reverse Playback check box to enable and experience 
smooth reverse playback where reverse playback is supported in full frame rate 
up to 2x speed. The recommended FPS and GOP settings are 30 FPS 5 GOP, 30 
FPS 10 GOP and 10 FPS 10 GOP.
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15. Under Network Throttling Options:

• Manage Resolution: Select this check box to manage the fluctuations in the 
resolutions.

• Manage Frame: Select this check box to manage the frames per second in a 
video.

16. Click Apply.

17. Click OK to close the dialog box.

Pausing the Video Rendering
You can pause the video rendering to momentarily stop the rendering of video 
when a tab that does not display video is selected. For example, when the Report 
tab is selected, the video rendering can be paused to improve the application per-
formance. The rendering of video starts again when you select a different tab in the 
user interface.

To select the tab which pauses video rendering 

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. By default, the General Settings tab is selected.

2. In the Pause Video Rendering box, select the check box next to the tab names 
that you want to select. 

Figure 2-26    Pausing the Video Rendering

3. Click Apply.

4. Click OK to close the dialog box.

To enable the display of controller text on digital monitor 
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1. Click the OSD Settings tab.

Figure 2-27    Enabling Control text on Digital Monitors

2. Select the Enable Control Text on Digital Monitor check box to display 
controller text on digital monitor.

Camera Parking
To enable the camera parking feature 

1. Click the Preferences option in the user menu. The Preferences dialog box 
appears. By default, the General Settings tab is selected

Figure 2-28    Enabling the Camera Parking Feature
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2. Select the Enable Camera Parking check box to enable the Camera Parking 
feature. Click to clear the Enable Camera Parking check box to disable this 
feature.

Note: Use this feature while viewing live video from cameras. See "Camera Parking" on 
page 4-123 for more information.

Express Mode
This feature helps you to perform pan, tilt and zoom operations by marking an area 
of interest on the live video using the rubber band technique. You can perform only 
analog operations using this technique.

To enable the express mode

1. Click the Preferences option in the user menu. The Preferences dialog box 
appears. By default, the General Settings tab is selected.

Figure 2-29    Enabling the Express Mode

2. Select the Express Mode check box to enable the Express Mode feature.

Event handling Mode Settings
Event handling mode feature enables you to manage the load of the events at 
server level. It allows you to select the required mode option as follows:

Option Description

Notify Clients, Show in 
Reports and Execute Macros

click to notify the clients, display in reports and execute the 
macros.
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Note: Event Handling Mode feature is not applicable for Alarms.

To set the Event handling mode

1. Click the Preferences option in the user menu. The Preferences dialog box 
appears. By default, the General Settings tab is selected.

Figure 2-30    Event Handling Mode Settings

2. In the Event Handling Mode area, click the required mode option.

3. Click Apply.

4. Click OK to close the dialog box.

Settings for Alarm Preview Pane
When the video related to an alarm is played from the Alarm window, the salvo lay-
out changes to a four panel layout. You can define the video display for each panel 
namely, Pre Alarm, Post Alarm, Live, and On Alarm. The following table defines 
these options.

Show in Reports and Execute 
Macros

click to show only reports and execute macros.

Execute Macros click to execute only macros.

Option Description

Option Description

Pre Alarm The video before the occurrence of the event that triggered the alarm is 
played.
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Note: You can view video related to alarms only for the cameras connected to the Recorder. 
For Pre Alarm, Post Alarm, and On Alarm, the video is played only when the video 
recording pertaining to the date and time of alarm is available.

To define the video display for each preview panel 

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. By default, the General Settings tab is selected. 

Figure 2-31    Settings for the Alarm Preview Pane

2. In the Preview Pane area, select the video option for each panel. When you 
select Pre Alarm and Post Alarm, a dialog box appears. Select the time in 
seconds for which you want to view video related to pre alarm and post alarm in 
the dialog box and click OK.

3. Click Apply.

4. Click OK to close the dialog box.

Post Alarm The video after the occurrence of the event that triggered the alarm is 
played.

Live Live video is played.

On Alarm The video is played from the occurrence of the event that triggered the 
alarm.

Option Description
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Setting the Alarm Threshold Value 
When configuring the event settings for a recorder, camera, and switcher, you can 
specify a value known as the Severity Level for each event. When the event occurs, 
the Severity Level value is compared with the value in the Alarm Severity Threshold 
box in the preferences dialog box. The alarm is triggered only when the Severity 
Level value is greater than the Alarm Severity Threshold value.

For example, the alarm is triggered if the Severity Level for an event is 50 and the 
Alarm Severity Threshold value is 40. Use this feature to limit what alarms go to 
which client.

To set the alarm severity threshold value 

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. By default, the General Settings tab is selected. 

2. In the Alarm Severity Threshold box, type a value.

3. Click Apply. 

4. Click OK to close the dialog box.

SnapShot Clip Export Settings
This feature allows you to capture a snapshot for clip export before and after the 
time specified in the Pre/Post box. You can specify a time prior and post to which a 
snapshot for clip export is captured.

To set the snapshot clip export time

1. Click the Preferences option in the user menu. The Preferences dialog box 
appears. By default, the General Settings tab is selected.

Figure 2-32    Snap Shot Clip Export Settings
MAXPRO®VMS R670 Operator’s Guide 101



2. In the Snapshot Clip Export Settings area, type or select the required value in 
the Pre/Post box.

Configuring the Timeline Settings 
To configure the timeline settings

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. 

2. Click the Timeline Settings tab. 

Figure 2-33    Timeline Settings

3. Under Timeline Jump Control Configuration, set the time for the intervals. 

4. Under Incident Management Mode Settings, choose the following times for clip 
creation.

• From the PreOverlapped Time drop down list, select a time that appends to the 
start time of clip creation for a camera.

• From the Post Overlapped Time drop down list, select a time that appends to the 
end time of the clip creation for a camera.

Note: This time allows camera recorded time to automatically have an overlap when 
marking in and marking out.

5. Click Apply in the Preferences dialog box.

6. Click OK to close the Preferences dialog box. 

Configuring the OSD Settings
You can configure the OSD settings to change the color of the text that appears 
over the video displayed in a panel.
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To set the font properties 

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed.

2. Click the OSD Settings tab.

Figure 2-34    OSD Settings

3. Click Edit and select the color properties in the dialog box.

4. Click OK to close the font properties dialog box.

5. Click Apply in the preferences dialog box.

6. Click OK to close the preferences dialog box.

Configuring Diagnostic Settings
To configure the diagnostic settings

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. 

2. Click the Diagnostic Settings tab. 
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Figure 2-35    Diagnostic Settings

3. Under Change log level settings, select the required log. 

4. Click Apply in the Preferences dialog box.

5. Click OK to close the Preferences dialog box. 

Configuring the Launch Pad Settings
You can configure the Launch Pad settings to launch the application of your 
choice from MAXPRO VMS.

To configure the launch pad settings 

1. Click the Preferences option in the user menu. The name of the currently 
logged in user is displayed as the user menu on the top right of each screen. 
The Preferences dialog box is displayed.

2. Click the Launch Pad tab.

Note: Users (other than Administrators) does not have permission to edit the Launch Pad 
configuration.
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Figure 2-36    Launch Pad Settings

3. Under Display Name, type the name of the application you want to launch from 
MAXPRO VMS.

4. Under Application Path, select the application path that points to the 
application to be launched.

5. Under Working Directory, select the working directory that points to the 
application to be launched.

6. Under Application Parameters, type the parameters if any to launch the 
application.

Note: Click Add More... to add more than three applications.

7. Click Apply and then OK to save the data.

Note: Click on the toolbar on the top of the salvo layout, and then select the application 
that you want to launch from MAXPRO VMS.

Configuring the Clip Export Settings
You can configure the Clip Export Settings to change the default naming conven-
tion for the clips that are created from the recorded video.

To configure the clip export settings 

1. Click the Preferences option in the user menu The name of the currently logged 
in user is displayed as the user menu on the top right of each screen.. The Pref-
erences dialog box appears.

2. Click the Clip Export Settings tab.
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Figure 2-37    Clip Export Settings

3. Select the Default Format check box to apply the default naming convention for 
the clips.

4. To change the default naming convention: 

• Select the desired formats for Month, Date, and Year. 

• Use the  to arrange the Month, Date, and Year in the order of your choice.

5. Click Apply and then OK to save the data.

Configuring the Advanced Settings
Encryption secures the communication between server and client. You can encrypt 
the data between client to server using encryption feature. MAXPRO VMS supports 
three types of encryption modes to communicate with NVR box through client. 
Each encryption has specific pre-requisites. The following are the pre-requisites 
for each encryption mode.

Note: Honeywell recommends you to use a valid certificate from a Certificate Authority that 
would ensure robust security along with integrity and authenticity, instead of using 
self-signed certificate. Refer to the 800-23557-E - Securing MAXPRO VMS_NVR 
Technical Notes.

• Default Encryption: None
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• Windows Authentication Encryption:

• System clock time should be synced between client and server machine. It also 
recommended to use the time sync utility to sync the time between client and 
server.

• Workgroup: If the machines are in workgroup then the password used by a client to 
log on as a windows user should be the same as Server PC.

• Domain User: All valid domain users are allowed to login.

• Certificate Based Encryption (Recommended):

• System clock time should be synced between client and server machine. It also 
recommended to use the time sync utility to sync the time between client and 
server.

• Certificate needs to be installed in all Client and Server PCs. A client without a 
certificate is not allowed to login.

• Internet connection is required to Install the certificate. 

• Certificate Based Encryption works across workgroup and domain.

Note: VeriSign Class 3 Code Signing 2010 CA issued certificate is tested for certificate 
based encryption. Honeywell recommends you to use a valid certificate from a 
Certificate Authority that would ensure robust security along with integrity and 
authenticity, instead of using self-signed certificate. Refer to the 800-23557-E - 
Securing MAXPRO VMS_NVR Technical Notes.

Also MAXPRO VMS supports Low bandwidth Stream and Optimize Stream Usage 
settings to optimize and view the live video in Low bandwidth sites. It optimizes the 
stream usage while switching between the salvo view. If it is a single salvo a high 
resolution video is displayed and if it is a multiple salvo layout then low resolution 
video is displayed. However, user need to configure the resolution in NVR camera 
page.

To configure the Advanced settings

1. Click the Preferences option in the User menu  . The Preferences dialog 
box appears.

2. Click the Advanced Settings tab.
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Figure 2-38    Advanced Settings Tab

3. Click Certificate Based Encryption option (Recommended), a certificate is used 
for encrypting the data between client and server. To encrypt the data using 
Certificate Based Encryption, perform the following:

a. Browse the certificate (.pfx file).
b. Type the Certificate Password and then click the Import Certificate button to 
import the certificate.

Tip: You can also import the certificate from the following link. http://technet.microsoft.com/en-
us/library/cc776889(v=ws.10).aspx

Or

Under Application Security Settings, select the Default Encryption or Windows 
Authentication Encryption options as applicable.

Note: Honeywell recommends you to opt for Certificate Based Encryption and use a valid 
certificate from a Certificate Authority. The CA certificate would ensure robust 
security along with integrity and authenticity, instead of using self-signed certificate. 
Refer to the 800-23557-E - Securing MAXPRO VMS_NVR Technical Notes on how to 
Secure Communication between Client and Server for MAXPRO NVR & VMS section.

4. Click OK. Application security settings message box is displayed. 
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Figure 2-39    Application security settings 

5. Click OK to restart the Trinity Services. A services restarting progress bar is 
displayed. Its takes several minutes to restart all the services.

Note: All services will be restarted and all clients will be auto-reconnected.

6. Under Low Bandwidth Settings:

• Use Low Resolution Stream: Select this check box to render video the low 
resolution video in any format of salvo layout. User needs to configure the 
low resolution (for any Primary or secondary stream) in MAXPRO NVR 
camera page. Refer to MAXPRO® VMS Installation and Configuration Guide 
for more details on how to configuring Low bandwidth stream.

• Receive Only I Frame: Select this check box to view only I Frame considering 
the bandwidth at the site.

• Use Extended timeouts: Select this check box to increase the default time 
outs for NVR connections, stream connections and snapshots retrieval.

7. Under Optimize Stream Usage Settings:

• Enable Stream Switch: Select this check box to automatically switch between 
low and high resolution streams in the salvo layout based on the users 
selection.

8. Click Apply to close the Preferences dialog box.

The following figures depicts the Encryption certificate deployment scenarios:
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Default Settings 
1. Click Reset to apply default settings while setting preferences.

2. Click System Defaults to apply the system default settings while setting 
preferences.

Setting Custom Profile
After logging in to the MAXPRO VMS user interface, you can adjust the floating 
windows to your desired position in the MAXPRO VMS user interface using the 
“Custom Profile” option. The profile settings that you have made persist when you 
switch between the different tabs in the user interface and while logging on and 
logging off the MAXPRO VMS user interface.

To set a custom profile 

1. Choose the Profile>Custom Profile option in the user menu.

Figure 2-40    Custom Profile

2. Adjust the floating windows to your desired position in the user interface.

3. Choose Profile>Save Existing Layout to save the changes.

Note: At any point of time, you can reset the floating window to its default position by 
choosing the Profile>Default Profile option.
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CHAPTER

4

MAXPRO®VMS R
MONITORING A SITE
Overview
This chapter explains how to monitor a site using MAXPRO VMS application. It also 
describes how to use various features and options to perform surveillance opera-
tion.

Salvo Layouts and Panels
The salvo layout is arrangement of panels that displays video. You can view the 
salvo layout when you select the Viewer tab. At a time, you can select one of the 
salvo layouts from the toolbar on the top of the screen. For example, if you want to 
view video from two cameras, select a salvo layout with two or more panels from 
the drop-down list. 

Following are the features of the salvo layout.

Easy video source selection
You can drag and drop a video source such as a camera or scan sequence from the 
Site window on the Salvo layout. The video is displayed in the panel of the salvo lay-
out. You can also double-click the video source name to select it.

Salvo Layout Drop down with Preview
You can select the required salvo layout from the drop-down list available on the 
tool bar. This also includes preview to view the salvo layout next to the list. Hover 
the mouse on the required salvo layout and the corresponding preview is displayed 
on the right pane.
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Multiple video source selection
You can drag and drop multiple video sources from the Site window on the salvo 
layout. The salvo layout starts displaying video from the devices in different panels

Note: Ensure that enough panels are available before you drag and drop multiple video 
sources on the salvo layout. This is necessary to avoid automatic closing of the 
present video display. For example, if a salvo layout consists of only one panel 
displaying video, select another salvo layout containing more panels before dragging 
and dropping multiple video sources.

Multiple panel selection
You can select multiple panels on the salvo layout. This enables you to perform 
actions on multiple video displays simultaneously. For example, you can select 
multiple video display and start playing of video, apply color correction, and per-
form other similar actions. See Video Control Options in Panel Toolbars. 

Use of joystick controller
You can use the joystick controller (Ultrakey keyboard) to perform actions such as 
panning, tilting, and zooming of camera, selecting a salvo layout, selecting a cam-
era, playing a sequence, and selecting a monitor. The keys in the joystick controller 
can be associated with the intercept keys to perform these actions.

Context menu commands
When you right-click on a panel, a context-menu appears. The commands in the 
context-menu vary based on the type of video display such as live or recorded. See 
Viewing Live Video.

Enlarged display
You can double-click a panel to maximize its size and view an enlarged display of 
the video. Double-click the panel again to restore the panel to its original size.

Surrounding Cameras
The Surrounding Cameras feature allows you to associate a group of cameras to 
each camera. This feature is particularly useful when you want to view video from a 
group of cameras at the same time. For example, when you want to view video from 
cameras located in the same area. See Surrounding Cameras for more information.

Salvo Views
Salvo views enable you to save a salvo layout. The cameras and scan sequences 
displaying video in a salvo layout is saved in a salvo view. When you want to view 
video from the same cameras and scan sequences again, you can select the corre-
sponding salvo view.
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Corridor View
MAXPRO VMS allows you to discover and add a camera with Corridor view option. 
You should enable the Corridor view option in camera page to use this feature. This 
feature is supported only for MAXPRO® NVR recorders.

AspectRatio Stretch
AspectRatio stretch feature enables a salvo layout to display a view by maintaining 
same aspect ratio. This option is available on the tool bar and it supports three 

stretch view namely Default S, AspectRatio 16:9 and AspectRatio 4:3. Click  to 
shuffle between aspectratio stretch view.

Identifying the type of video display
The type of video displayed in a panel is indicated. For example, Live for live video 
and Rec for recorded video.

Swapping of video display between panels
The video display in a panel can be dragged and dropped on another panel. This 
feature lets you swap the video display between panels.

Adding devices to My Devices window
The video display in a panel can be dragged and dropped on My Devices window. 
This adds the video source such as the camera or sequence to the tree structure in 
My Devices window.

Panel Toolbars
Hovering the mouse over a panel displays a toolbar. The toolbar that appears on 
top of a panel enables you to view the name of the video source and close the video 
display. The toolbar that appears on the bottom of a panel consists of icons that 
enable you to flip the video display, view the mirror image of the video display, can-
cel the digital PTZ effects on the video display, and perform color correction on the 
video display. You can also move the camera to a preset position, save a preset 
position, and start recording of video. See Video Control  in Panel Toolbars.

salvo View

Creating a Salvo View
1. Click the Viewer tab.

Note: Before you create a salvo view, select the salvo layout you want and the preferred 
cameras and scan sequences. The selected salvo layout, cameras, and scan 
sequences are saved in the salvo view.
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2. Right-click on the toolbar, and then click Create Salvo view or Click  on the 
toolbar on the top of the salvo layout. A drop down box appears.

3. To create a salvo view, in the Enter salvo view name box, type a name for the 
salvo view and click OK. Goto step 5.

4. To create a shared salvo view, in the Enter salvo view name box, type a name for 
the salvo view, and then click Shared Salvo check box. Goto step 6.

5. The salvo view is created and appears in the My Salvo Views under Views 
window.

6. The salvo view is created and appears in the Shared Salvo Views under Views 
window.

Selecting a Salvo View
To select a salvo view

•     In the Views window, double-click the salvo view or drag and drop the salvo view 
on the salvo layout or right-click the salvo view in the Views window, and then click 
Show. 

Renaming the Salvo View
To rename the salvo view

1. Right-click the salvo view in the Views window, and then click Rename. 

2. Type a new name for the salvo view in the Site window and press ENTER.

Editing the Salvo View 
To edit the salvo view

You can edit the salvo view when you want to, 

• change the cameras in the existing salvo view 

• change the salvo layout for the existing salvo view

Changing Cameras in the Existing Salvo View 

1. In the Views window, double-click the salvo view or drag and drop the salvo view 
on the salvo layout or right-click the salvo view in the Views window, and then 
click Show. 

2. Realign the cameras or add new cameras in the same salvo view layout. 

3. Click Save Salvo View in the salvo view pane. 

Changing the Salvo Layout for the Existing Salvo View 
Method one 
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1. Select a salvo layout and re-align cameras if you want.

2. In the Views window, right-click the salvo view for which you want to change the 
layout, and then click Save. 

Method two 

1. Select a salvo layout and re-align cameras if you want. 

2. Click  on the toolbar on the top of the salvo layout. A drop-down list 
appears. 

3. In the Enter salvo view name box, type the salvo view name for which you want 
to change the layout, and then click OK. A message asking for confirmation 
appears.

4. Click Yes to save. 

Note: The above procedures for Selecting a Salvo, Renaming a Salvo, and Editing a Salvo 
remains the same for the Shared Salvo View.

Capturing Salvo Image
You can capture the entire salvo view as an image and store. The image is stored in 
the images and clips directory. 

To capture salvo image

• Click  on the toolbar on the top of the salvo layout. The salvo image is 
created. 

Deleting a Salvo View
To delete a salvo view

• Right-click the salvo view in the Site window to display a context menu. Click 
Delete. The salvo view is deleted

Salvo Bar 
A salvo bar appears on top of a salvo view. The salvo bar indicates the name of the 
salvo view. You can save a salvo view after you realign the cameras using the Save 
option on the Salvo Bar. You can also use the Save As option to save an existing 
salvo view with a different name. The context menu options on the salvo bar 
include Send Message, Create Salvo View, and FullScreen.
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Extended Salvo layouts drop-down
Additional 10, 13 grid salvo layout combinations are introduced in this release with 
preview. Hover the mouse on the required salvo layout, the corresponding preview 
is displayed on the right side pane. Below image displays the additional salvo lay-
outs with preview.

Figure 3-1    Extended Salvo Layouts

AspectRatio Stretch
AspectRatio stretch feature enables a salvo layout to display a view by maintaining 
same aspect ratio. This option is available on the tool bar and it supports three 

stretch view namely Default S, AspectRatio 16:9 and AspectRatio 4:3. Click  to 
shuffle between aspectratio stretch view.

Surrounding Cameras 
You can associate a camera to a group of cameras using the “Surrounding Cam-
eras” feature. This feature enables you to view video from a group of related cam-
eras at the same time. For example, when you want to view video from cameras 
located in the same area. 

To define the surrounding cameras for a camera 
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1. Click the Viewer tab.

2. Click  on the toolbar on the top of the salvo layout. The surrounding 
cameras salvo layout appears.

3. Select the camera for which you want to associate a group of cameras from the 
Devices window or My Devices window. You need to drag and drop the camera 
in the central panel of the salvo layout. The panel starts displaying video from 
the camera.

4. From the Site window or My Devices window, select the cameras you want to 
associate with the camera selected in the previous step. The panel starts 
displaying video from the cameras.

5. Click  to save the surrounding cameras salvo layout. 

Switching to the Surrounding Camera View for a Camera

•    Click  on the toolbar. The surrounding cameras salvo layout appears. Select 
the camera from the Site window or My Devices window. The surrounding cameras 
salvo layout starts displaying video from the camera and the associated cameras.

or

•    Hover the mouse over the panel displaying video from the camera. A panel tool-

bar appears. Click  in the panel toolbar. The surrounding cameras salvo layout 

starts displaying video from the camera and the associated cameras.

Switiching AspectRatio
To switch between the aspect ratio

• Click  on the toolbar to shuffle between Aspectratio stretch view as shown below: The 

following views are displayed as shown below:

• Default Stretch View figure 2.

• AspectRatio 16:9 View figure 3.

• AspectRatio 4:3 View figure 4.
MAXPRO®VMS R670 Operator’s Guide 117



Figure 3-2    Default Stretch View

Figure 3-3    AspectRatio 16:9 view
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Figure 3-4    AspectRatio 4:3 view
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Live Video
You can view live video and play any selected sequence using the options available 
in MAXPRO VMS. It also include Anonymized video.

Viewing Live Video
The panels in the salvo layout display video. You can select the video source such 
as cameras or sequences from the Site or My Devices window. 

To view live video 

1. Click the Viewer tab.

2. Double-click the video source in the Site window or My Devices window. You 
can also drag and drop the video source on a panel in the salvo layout. The live 
video is displayed in the panel and the label Live appears over the video display.

Note: If the Text overlay of the camera added in the panel, displays FO on the top right 
corner then the camera is active under Failover mode.

Figure 3-5    A panel displaying live video

Note: The video source can also be selected using the virtual keyboard and joystick 
controller.

You can select multiple video sources and view live video in different panels of the 
salvo layout. When you hover the mouse over a video display, toolbars appear over 
the panel. The toolbars enable you to perform actions such as flipping the video 
display, applying color correction, and so on. See Video Control Options in Panel Tool-
bars.
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Undo and Redo
Use the Undo and Redo options to undo and redo the drag and drop operation of 
video sources to the salvo layouts.

To undo and redo the drag and drop of a video sources 

1. To undo the drag and drop operation of video sources, click  on the toolbar 
on the top of the salvo layout or press CTRL + Z keys. 

2. To redo the drag and drop operation of video sources, click  on the toolbar 
on the top of the salvo layout or press CTRL + Y keys.

Note: This undo and redo feature is applicable for changing the salvo layouts, switching 
between cameras and closing the camera operations only.

Context Menu Options
When you right-click on a panel displaying live video, a context menu appears as 
shown below. 

The following table lists the commands in the context menu.

Command Click to... 

Full Screen maximize the salvo layout to full screen. Alternatively, 
you can click in the toolbar on the top of the salvo layout.
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Remove Text Overlay to remove text overlay displayed on the video.
Alternatively, you can click in the toolbar on the top of 
the salvo layout.

Digital PTZ enable digital PTZ. See Panning Tilting and Zooming for 
information on digital PTZ.

Local PTZ to perform PTZ operation in camera by bypassing the 
trinity controller. See Panning, tilting, and zooming for 
information.
Note: You can access Local PTZ, if you have permissions 
to analog PTZ

Add Bookmark add a bookmark in the timeline. You can also add a 
bookmark by pressing the CTRL + B keys. 

Add Bookmark to All add bookmarks to all the cameras displayed on the salvo 
layouts.

Bookmarks navigate to any bookmark and select to play the video 
related to that bookmarks time. You can also choose 
Remove to remove the bookmark from the context 
menu.

Send Message send message to an operator or to another monitor. See 
Operator messaging for more information.

Start Recording start the recording of video.
Alternatively, you can click in the panel toolbar to start 
recording of video. 

Mark In add a mark in point in the timeline. You can also add a 
mark in point by pressing the CTRL + I keys. 
See Video Recording and Viewing for more 
information.

Mark Out add a mark out point in the timeline. You can also add a 
mark out point by pressing the CTRL + O keys.
See Video Recording and Viewing for more 
information.

Save Image save the frame displayed in the panel as an image in the 
BMP format. 
Alternatively, you can click in the toolbar on the top of 
the salvo layout to save the image in BMP format. See 
Saving Images.

Save Image As save the frame displayed in the panel in different image 
formats such as JPG, PNG, and GIF.
See Saving Images for more information.

Preview view the preview of live video

Calender view the recording in calender format based on date and 
time

Smart Motion Search configure the smart motion search on live video. See 
Smart Motion Search for more information.

Command Click to... 
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Camera Parking
Camera Parking is applicable only for selected PTZ cameras. This feature overrides 
the Home Preset location of a PTZ camera. Using this feature, you can explicitly 
park a camera at a particular location of your choice.

To use the Camera Parking feature 

1. On the panel displaying live video, use the pan, tilt, and zoom options to posi-
tion the camera to a location of your choice.

2. Right-click the panel, and select Park Camera in the context menu as shown 
below.

Show Surrounding Cameras to view video from the associated cameras. See 
Surrounding Cameras for more information.

3D Mode This feature is applicable only to New EquIP PTZ model 
cameras. Select this option to enable the 3D view. You 
can also center the field of view by clicking on any object 
in the live video.
See How to Enable/Use 3D Mode View on page 
124section for more information.

Save Profile Camera As Save the camera view as a profile and this profile camera 
will be displayed under the Devices tree.
Profile camera created in MAXPRO® NVR cannot be 
discovered in MAXPRO® VMS and in VMS in VMS 
scenario.

Enable Square Select select a rectangular area on the video display. The 
selected area is automatically zoomed in or enlarged.

Park Camera enable the camera parking feature. This is only for 
selected PTZ cameras. See Camera Parking for more 
information.

Stop Recording Alternatively, you can click in the panel toolbar to stop 
recording of video.

Reset 3D This option is displayed when you enable 3D Mode. Click 
this option to reset the 3D view.See How to Restore 3D 
Mode view for more information. 
Note: Rest 3D option resets the 3D view only at the first 
level.

Command Click to... 
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3. To define a new location, use the pan, tilt, and zoom options to select a new 
location.

4. Right-click the panel, and then click Update Parked Location in the context 
menu. The camera is parked to the selected location.

How to Enable/Use 3D Mode View
This feature is supported only for New EquIP PTZ (HDZ302DE, HDZ302D, 
HDZ302DIN) camera models.

To enable 3D mode view:
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1. Right-click on the live video, the context menu options are displayed as shown 
below.

Figure 3-6    3D Mode option

2. Click the 3D Mode option. 3D positioning for that camera is enabled.

3. Use the mouse to draw a rectangular region on any object in live video as 
shown below.

Figure 3-7    3D Rectangle Region
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4. Release the mouse control immediately after drawing a rectangle. Only the 
object in the rectangular region is zoomed and positioned to center as shown 
below. You can also draw more regions on top of existing one to have a better 
view.

Figure 3-8    Region Positioned 

Positioning the Field of View
After enabling the 3D Mode option in live video, you can also center any object in 
the scene with a mouse click.

For example. In a live video, if you want to center an object which is located on top 
right corner then you can simply click on that object. The object will be positioned 
to center as shown below. Similarly you can center any corner objects.

To center the any object in the scene
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1. Click on any object in the scene. For example in this below image a Camera is 
highlighted.

Figure 3-9    Camera Object Highlighted

2. Click on any object in the scene then the object is positioned to the center of the 
salvo pane as shown below.

Figure 3-10    Camera Object is Centered
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How to Restore 3D Mode view
Restore3D Mode option is displayed only when you enable 3D mode.

To restore the 3D mode view:

1. Right-click on the same live video onto which the 3D mode is enabled.A context 
menu options are displayed as shown below.

Figure 3-11    Context Menu Options

2. Click Restore 3D option.

Note: Restore3D option resets only 1 level of previous view. For example if you had drawn a 
rectangular region twice to view the object closely, then this option resets only the 
view of second rectangle region.

Playing a Sequence
A sequence is a set of live video streamed one after the other from cameras for a 
specified time interval. Refer to the MAXPRO VMS R630 Installation and Configu-
ration Guide for information on how to create sequences.

To play a sequence 

1. Click the Viewer tab. 

2. Click the Sequences window. 

3. Double-click the sequence you want to play or select the sequence, and then 
click Play Sequence. You can drag and drop the sequence on a panel in the 
salvo layout. 
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You can also play a sequence using the joystick controller (Ultrakey keyboard). 

Saving a Profile Camera View
Profile camera feature is supported only for MAXPRO NVR Recorders. Save the 
camera view as a profile and the saved profile camera is displayed under the 
Devices tree. Profile camera created in MAXPRO® NVR cannot be discovered in 
MAXPRO® VMS and in VMS in VMS scenario.

To save a Profile camera view

1. Right-click on the required camera in the salvo layout which is displaying live 
video and then choose Save Profile Camera As as shown below.

Figure 3-12    Profile Camera View

2. Type a name for the Profile View and then click . The created profile camera 
is added and displayed under the device tree.

Tip: You can also perform Pan, Tilt and Zoom operations on the required camera in the salvo to 
set a better view and then save as Profile view. 

Viewing Anonymized Video
Ensure that you have associated the required cameras with suitable masking type 
in the Configurator tab > Anonymization screen. Refer MAXPRO® VMS Installation 
and Configuration Guide on how to configure.

• In the Viewer tab, drag and drop the associated camera on to the panel. The 
specific camera video with the type of masking is displayed as shown below. 
The available masking types are 
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• Blur: Blurs the Identifiable object

• Pixelize: Pixelizes the Identifiable object

Note: Only an Administrator can provide access to this feature to an Operator.

The following images display the views of maskings:
For Blur:

For Pixelize:
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Video Recording and Viewing

Video Recording
In the Configurator tab, you can configure the settings to record video for the cam-
eras connected to the recorder. Four types of record settings are available for the 
cameras connected to the recorder. They are user activated, background/ continu-
ous recording, motion detected recording, and scheduled recording. The above 
settings are also applicable on the Redundant recorders or backup recorders which 
can be configured for failover scenarios. 

A new authentication feature called Four Eye Authentication is introduced in R500 
release. This feature is for Privacy Protection setting and to meet the EU GDPR 
compliance standards easily. This is to restrict all users in a surveillance system to 
perform Playback operation. While performing playback operation at least two 
people from different roles should authenticate. See Four Eye Authentication section 
for more information.

Note: This feature is license based and it is not supported in Viewer Edition. For R500 
Enterprise Edition 60 days of trial license is applicable for both (GDPR) features. For 
R500 Viewer Edition these features are not available in the permanent demo license.

Refer to the MAXPRO® VMS Installation and Configuration Guide for more informa-
tion on configuration.

Note: In MAXPRO VMS, the settings for video recording cannot be configured for the 
cameras connected to the Rapid Eye, Fusion, Intellex and Embedded recorders. You 
cannot start the recording (user activated recording) of video from cameras 
connected to these recorders. However, you can play the recorded video saved in 
these recorders. In addition, you can also view live video from the cameras connected 
to these recorders. See Viewing Live Video for more information.

About the Recording Settings for Recorder
User Activated

You can configure the user activated settings for recording moments of interest 
while viewing live video from the camera. After configuring the user activated set-
tings, the operator can start recording of video when needed. The video is recorded 
for the time period specified in the settings for user activated recording. 

See Video Control Options in Panel Toolbars for information on how to start the user acti-
vated recording of video from a camera.

Background Recording 

After configuring the background recording settings, the camera continuously 
records video. 

Motion Detected Recording 
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After configuring the motion detection settings, the camera starts recording video 
when motion is detected. 

Scheduled Recording 

After configuring the scheduled recording settings, the camera starts recording 
video on specified date and time.

Viewing Recorded Video
You can use the following to play recorded video of primary or redundant recorders.

Timeline 

You can easily retrieve and view recorded video using the timeline and the date and 
time controls in the Timeline window. When you select a camera from the Devices 
window to view video, a timeline appears in the Timeline window. The name of the 
corresponding camera appears on the left of each timeline. You can add comments 
and mark points of interest in the timeline using the bookmark feature. The book-
marks are helpful for future review of recorded video.

You can also add mark in and mark out points in a timeline. Recorded video 
between a mark in and mark out point can be played repeatedly. This feature is 
referred to as loop playback of video.

You can view the frames from the recorded video as thumbnails in the timeline. You 
can also create clips from recorded video.

Player Controls 

You can play recorded video at speeds ranging from 1/64X to 256X. You can also 
forward and reverse play the video. The frames from the recorded video can also be 
viewed one at a time in the panel.

Using the time jump feature, you can skip time intervals while viewing recorded 
video. This feature is helpful when viewing recorded video that spans across a long 
time interval. 

See Playing Recorded Video Using the Timeline for more information on timeline and 
player controls. 

Note: If you are viewing the recordings from backup recorder then FO is displayed on the 
top right corner of the panel. During playback, when the control is moving from 
primary recording to Redundant recording then Connecting to Failover Box message 
is displayed.
MAXPRO®VMS R670 Operator’s Guide 133



Timeline

Playing Recorded Video Using the Timeline
Timeline enables you to play recorded video from a particular date and time. A 
timescale is displayed in the lower part of the Timeline window. You can refer to the 
divisions in the timescale to locate a video recording in the timeline. Using the Date 
and Time calendar box in the Timeline window, you can select a date and time from 
which you want to play recorded video.

You can add comments and mark points of interest in the timeline using the book-
mark feature (See Marking Points of Interest in the Timeline Using Bookmarks for more 
information). This enables you to locate moments of interest when reviewing 
recorded video. You can also add mark in and mark out points in a timeline (See 
Playing Recorded Video Using Mark In and Mark Out Points in Timeline for more information) 
to play a selected part of video repeatedly. 

Note: While performing playback operation ensure to follow GDPR (General Data 
Protection Regulation) standards. At least two people must authenticate. For an 
Administrator user, authentication is not required and can perform any playback 
operation. For a non Administrator user, an Administrator user and a User from some 
other group needs to authenticate. See Four Eye Authentication section for more 
information.

To play recorded video using the timeline 

1. Click the Viewer tab.

2. Select the camera. To select the camera, double-click the video source in the 
Site window or My Devices window. You can also drag and drop the camera on a 
panel in the salvo layout. The video is displayed in the panel. Alternatively, you 
can click on a panel displaying video to select the corresponding camera from 
which you want to view video. A timeline appears in the Timeline window with 
the name of the camera on the left in full timeline mode.

Note: To view recorded video from multiple cameras, you can select more than one camera 
at a time. The cameras can also be selected using the virtual keyboard and joystick 
controller.

3. Play the recorded video from a date and time in one of the following ways.

• Click on the timeline from where you want to view video. You can refer to the 
divisions on the timescale that is displayed in the lower part of the timeline 
window to locate the date and time.

Note: You can set any timescale between seconds and days using the  slider. 
Move the slider towards left or right as required. This helps you to locate the video 

recording in the timeline. Click  to view the divisions on the left of the timescale. 

Click  to view the divisions on the right of the timescale.

or
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• Select the date and time in the date and time calendar box 

 and then click OK or use the  

buttons corresponding to day, month, year, hours, minutes, and seconds to 
select the date and time. The video recording is played from the selected date 
and time.

Note: In the Calendar box, select the Adjust time for DST check box to synchronize the time 
to the Daylight Savings time. Daylight Saving Time (or summer time as it is called in 
many countries) is a way of getting more light out of the day by advancing clocks by 
one hour during the summer.

Timeline Color Indicators
The color indication for the type of recording on the timeline can be identified 
using Legends. Legends in the timeline window represents the type of recording 
(Continuous, Event or User and the type of Archival (Continuous or Event) status 
with specific color. Based on your settings you can identify which type of recording 
or archival.

For Recording

For Archival

Color Indicates...

Continuous recording.

Event based recording.

User based recording.

On Device

Synced from Device

Redundant

Color Indicates...

Archival of Continuous recording
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Note: Archival timeline colors are only visible if the Continuous/Event/User based recording does not exist for
that timeframe.

In the timeline, the time duration for which recording is available is indicated in 
green color. The time duration for which recording is not available is indicated in 
white color. This helps you to locate the video recording in the timeline. 

Note: The timeline shows the green color and gray color only for the cameras connected to 
the recorder. Presently, this feature is not supported for cameras connected to other 
recorders. However, you can click the timeline to play the recorded video. The timeline 
also shows pink color during the failover mode. The following table lists the colors 
that appear in the timeline.

Note: If you are viewing the recordings from backup recorder then FO is displayed on the 
top right corner of the panel. During playback, when the control is moving from 
primary recording to Redundant recording then Connecting to Failover Box message 
is displayed.

Viewing Thumbnails
To view the thumbnail frames 

•    Expand the camera name in the left of the timeline. The thumbnail frames 
appear.

Player Controls
You can do the following actions using the player controls.

Archival of Event based recording

Color Indicates...

Color Indicates...

recording is available for the corresponding date and time.

recording is not available for the corresponding date and time.

the timeline for the camera connected to other recorders. The 
green and white color appears only for the cameras connected to 
the recorder.

Indicates the recording available from the Redundant recorder 
during Failover mode.
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• Play the video

Click  to play video. The icon changes to . 

You can click this icon to pause the playing of video.

• View frames in the recorded video

Click  to view the forward frames or click .  

to view the reverse frames.

• Play video that is paused 

Click or to forward play video. 

To reverse play the video, click .

• Change the playing speed

Hover the mouse over the while video is playing and 

move the slider to change the playing speed.

Note: To move the slider you can use the mouse scroll wheel. Scrolling up increases the 
speed and scrolling down decreases the speed. 

The speed appears in the icon when you move the slider. For example, 1x in the 
icon indicates the playing speed.

• Skip time intervals using the time jump control 

Skipping enables you to easily locate the portion you want to view in a video 
recording. This is particularly useful when the video recording spans across a long 
time intervals.
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Click the drop-down arrow on the while video

is playing and select a time interval. Click the to jump backward or click

the  to jump forward. The video jumps to the selected time interval.

Note: When you jump forward or jump forward, the video jumps to the selected time interval 

and is paused. You must explicitly click  to view the recorded video from the 

selected time interval.

• Sync video across the recorders

Sync video allows you to synchronize the display of video from multiple cameras 
across the recorders. In the Salvo layout, select the cameras, select the Sync play-

back check box on the timeline window or click on the tool bar above salvo lay-
out to enable sync playback mode. Any actions performed like jump, forward, and 
rewind is synced in the entire salvo layout. When a new camera is dragged and 
dropped, the video from that camera is also synched.

• Volume control 

Hover the mouse over the while video is playing and 

move the slider to change the volume. 

Click  to mute the volume. 

Note: To move the slider you can use the mouse scroll wheel. Scrolling up increases the 
volume and scrolling down decreases the volume.

Context Menu Options 
A context menu appears when you right-click on a panel displaying live video. The 
following table lists the commands in the context menu.
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Command Click to... 

Full Screen maximize the salvo layout to full screen. Alternatively, 

you can click  in the toolbar on the top of the salvo 

layout.

Enable Square Select select a rectangular area on the video display. The 
selected area is automatically zoomed in or enlarged.

Remove Text Overlay to remove text overlay displayed on the video.
Alternatively, you can click in the toolbar on the top of 
the salvo layout.

Digital PTZ enable digital PTZ. See Panning, tilting, and zooming 
for more information. 

Local PTZ to perform PTZ operation in camera by bypassing the 
trinity controller. See Panning, tilting, and zooming for 
information.
Note: You can access Local PTZ, if you have 
permissions to analog PTZ.

Add Bookmark add a bookmark in the timeline. You can also add a 
bookmark by pressing the CTRL + B keys. 

Add Bookmark to All add bookmarks to all the cameras displayed on the 
salvo layouts.

Bookmarks navigate to any bookmark and select to play the video 
related to that bookmarks time. You can also choose 
Remove to remove the bookmark from the context 
menu.

Send Message send message to an operator or to another monitor. See 
Operator messaging for more information.

Start Recording start the recording of video.
Alternatively, you can click in the panel toolbar to start 
recording of video. 

Stop Recording Alternatively, you can click in the panel toolbar to stop 
recording of video. 

Mark In add a mark in point in the timeline. You can also add a 
mark in point by pressing the CTRL + I keys. 
See Video Recording and Viewing for more 
information.

Mark Out add a mark out point in the timeline. You can also add a 
mark out point by pressing the CTRL + O keys.
See Video Recording and Viewing for more 
information.
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Playing Recorded Video Using Mark In and Mark Out Points in 
Timeline

Mark in and mark out feature is useful when you want to play a portion of video 
repeatedly. You can add a mark in point to mark the start date and time in the time-
line. To mark the end date and time, add a mark out point in the timeline. The por-
tion of the timeline between a mark in and mark out point is referred to as loop. 

You can add bookmarks between a loop to identify moments of interest in the 
video. The video in a loop can also be saved as a clip. See Creating Clips for more 
information.

Creating a Loop by Adding a Mark In and Mark Out Point in the Timeline
To create a loop

1. Click to select the timeline in the Timeline window in which you want to add 
mark in and mark out points.

or

Click a panel displaying video to select the corresponding timeline.

2. To set the start date and time of the loop, add a mark in.

To add a mark in

Click the point in the timeline where you want to add a mark in and click . Alter-
natively, you can right-click the point in the timeline where you want to add a mark 
in and click Add Mark In in the context menu. The mark in can also be added from a 

Save Image save the frame displayed in the panel as an image in the 
BMP format. 

Alternatively, you can click  in the toolbar on the 

top of the salvo layout to save the image in BMP format. 
See Saving Images for more information.

Save Image As save the frame displayed in the panel in different image 
formats such as JPG, PNG, and GIF.
See Saving Images for more information.

Show Surrounding Cameras to view video from the associated cameras. See 
Surrounding Cameras for more information.

Alternate Camera to view the video from the alternate camera. The video 
displayed from the alternate camera would sync wit the 
date and time of the video that was being displayed by 
the previous camera. 

Command Click to... 
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panel displaying video. Right-click the panel and click Add Mark In in the context 
menu. Alternatively, click  in the panel toolbar that displays recorded video. The 
mark in is added at the corresponding date and time in the timeline.

Note: To remove the added mark in, right-click the mark in and click Remove Mark In in the 
context menu.

3. To set the end date and time of the loop, add a mark out.

To add a mark out

To add a mark out, click the point in the timeline where you want to add a mark out 
and click . Alternatively, you can right-click the point in the timeline where you 
want to add a mark out and click Add Mark Out in the context menu. The mark out 
can also be added from a panel displaying video. Right-click the panel and click 
Add Mark Out in the context menu. Alternatively, click  in the panel toolbar that 
displays recorded video. The mark out is added at the corresponding date and time 
in the timeline.

Note: You can add multiple mark in and mark out points in the same timeline. However, you 
cannot add two mark in points in succession. A mark out point needs to be added 
after each mark in point.

Removing a Loop
To remove a loop

1. Right-click a loop in the timeline window. A context menu appears.

2. Click Remove Loop.

Note: Click Remove All Loops in the context menu to remove all the loops in the timeline.

Playing Video from the Loop
To play video from the loop

1. To select the loop, click anywhere between the mark in and mark out points. 

Note: A tool tip appears when you hover the mouse over a loop. The tool tip indicates the 
start time and end time of the loop.

2. Click  to play the loop. You can also right-click on a loop to display a context 
menu and click Play Loop. 

To Stop Playing of Video
To stop playing video

1. In the Timeline window, click to select the loop.

or
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Click the panel displaying video pertaining to the loop. The corresponding timeline 
is selected.

2. Click . Alternatively, you can right-click the loop to display a context menu 
and click Stop Loop.

Marking Points of Interest in the Timeline Using Bookmarks
You can add bookmarks in a timeline to mark points of interest in a video recording. 
For example, if you notice an event in the video and you want to review the portion 
later, you can add a bookmark. You can also add comments to the bookmarks and 
browse from one bookmark to the other in the timeline. In addition, you can cut and 
copy a bookmark and paste it at a different point in the timeline. The bookmark 
comments appear as tool tips in the timeline at marked points and are helpful 
while reviewing recorded video. 

Adding a Bookmark
You can add a bookmark in any of the following ways:

• Click the point in the timeline where you want to add a bookmark and click 

• Right-click the point in the timeline where you want to add a bookmark and click 
Add Bookmark in the context menu.

• Right-click on the panel displaying video and click Add Bookmark in the context 
menu. You can also select a panel and press the CTRL + B keys to add a 
bookmark. The bookmark is added at the corresponding point in the timeline.

Adding Comments to a Bookmark
To add comments to a bookmark

1. Right-click the bookmark in the timeline and click Add Comments in the con-
text menu. A dialog box appears.

2. Type your comments and click OK. The comments are saved and appear as 
ToolTip when you hover the mouse over the bookmark.

Note: To edit the comments, right-click the bookmark and click Edit Comments in the 
context menu. Modify the comments in the dialog box and click OK.

Adding Bookmarks to all the Cameras Displayed in the Salvo Layout
To add bookmarks to all the cameras displayed in the salvo layout

• Right-click the bookmark for a particular camera in the timeline and then 
click Apply To All in the context menu.

Or
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• Right-click on the panel displaying video and click Add Bookmark to All in the 
context menu.

Note: To add a bookmark to a selected panel, right-click a bookmark in the timeline and 
then click Apply to Selected in the context menu.

Removing a Bookmark for a Camera displayed in the Salvo Layout
To remove a bookmark from a camera displayed in the salvo layout

• Right-click the bookmark for a particular camera in the timeline and then 
click Remove Bookmark in the context menu.

Note: If you want to all the bookmarks for a camera, right-click the bookmark and then click 
Remove All Bookmarks in the context menu.

Browsing from one Bookmark to the Other
Using this feature, you can skip those portions in the timeline that are not book-
marked. This enables you to selectively view video only from bookmarked portions 
in the timeline.

To browse from one bookmark to the other 

1. Select a timeline by clicking it in the Timeline window. You can also click on a 
panel displaying video to select the corresponding timeline.

2. Click the icon to view video from the next bookmarked point or click the icon to 
view video from the previous bookmarked point. 

or

Right-click a bookmark in the timeline to display a context menu. Click Next Book-
mark to view video from the next bookmarked point or click Previous Bookmark to 
view video from the previous bookmarked point in the timeline.

Cut, Copy, and Paste Bookmarks
To copy, copy and paste bookmarks

1. Right-click a bookmark in the timeline to display the context menu. Click the 
Cut or Copy command in the context menu as needed.

2. Right-click the point in the timeline where you want to paste the bookmark and 
click Paste in the context menu.

Deleting a Bookmark
You can delete a bookmark in any of the following ways:

• Right-click the bookmark you want to delete. A context menu appears. Click 
Remove Bookmark in the context menu.
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• Click to select the bookmark you want to delete and then click  or press the 
DELETE key.

Four Eye Authentication
This feature is also part of Privacy Protection setting and to meet the EU GDPR 
compliance standards easily. This is to restrict all users in a surveillance system to 
perform Playback operation. While performing playback operation at least two 
people from different roles should authenticate. For an Administrator, authentica-
tion is not required and can perform any playback operation. However, using 
license; authentication for an administrator can be configured. 

For a non Administrator user, by default a popup is displayed and an Administrator 
user or a User from some other group needs to authenticate to perform playback 
operation. 

Note: This feature is license based and it is not supported in Viewer Edition. For R500 
Enterprise Edition 60 days of trial license is applicable for both (GDPR) features. For 
R500 Viewer Edition these features are not available in the permanent demo license.

The following table explains the Four eye authentication based on the user and 
roles

How to enable Four Eye Authentication
Note: Only an Administrator can provide access to this feature to an Operator.

• In the Preference Tab > General Settings, select the Enable Four Eye 
Authentication check box as highlighted below.

User Authenticating User Valid 
Authentication

User 1[of Group 1] User 1[of Group 2] Yes

User 1[of Group 1] User 2[of Group 1] No
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How Four Eye Authentication feature Works
For an Non Administrator user

1. When an Non Administrator user (Operator) tries to perform a playback opera-
tion then the following dialog box appears on the screen.

Figure 3-13    .Four Eye Authentication box
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2. Enter the credentials of Administrator user or a User from some other group.

Note: For authentication, the logged in user and the Administrator user should not be from 
the same group

The following table explains the Four eye authentication based on the user and 
roles

3. Click the Authenticate button to view the playback video. After authentication 
the Four eye authenticated user and logged in user icons are displayed on the 
top right corner of the screen as highlighted below. For example: In the below 
image for Worker user, a Manager authenticates and the corresponding users 
are created.

• Until the four eye authenticated user is available the operator can perform 
any playback operation.

Figure 3-14    Authentication success

• If the four eye authenticated user logs off as highlighted below then again for 
any playback operation the Admin authentication is required.

User Authenticating User Valid 
Authentication

User 1[of Group 1] User 1[of Group 2] Yes

User 1[of Group 1] User 2[of Group 1] No
146 MAXPRO®VMS R670 Operator’s Guide 



Video Control

Video Control Options in Panel Toolbars
The panel toolbars appear when you hover the mouse over the video displayed in a 
panel. The toolbar that appears on top of a panel enables you to view the name of 
the video source and close the video display. 

Figure 3-15    Toolbar on the right of the panel 
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Figure 3-16    Toolbar on the bottom of the salvo panel

The toolbar that appears on the bottom and on the right of a panel consists of 
icons that enable you to perform the following actions.

Icon Click to...

zoom in to the video.

zoom out of the video.

flip the video display. Alternatively, you can click this icon in the toolbar 
on the top of the salvo layout.

view the mirror image of the video display. Alternatively, you can click this 
icon in the toolbar on top of the salvo layout.

reset the digital PTZ effects on the video display

display the color correction window. Move the sliders to set the 
brightness, contrast, hue, and saturation. You can select the Blur 
checkbox to blur the video display and the Sharpness check box to 
increase the image sharpness or clarity.
Alternatively, you can click this icon in the toolbar.
Select the Apply color changes check box to save the settings. Clicking 
the Reset button sets the color correction settings to default values. 
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displays a drop down box of presets. You can select a preset for the 
camera. 
The drop down list is disabled when digital PTZ is enabled. You need to 
disable the digital PTZ feature to select a preset. See Panning, tilting, 
and zooming for information on enabling and disabling the digital PTZ 
feature.

move a preset camera position. 
To move a preset, select a preset number from the drop down list and 
then click the icon. The camera position (pan, tilt, and zoom) is moved to 
the selected preset. 
The icon is disabled when digital PTZ is enabled. You need to disable the 
digital PTZ feature to move a preset. See Panning, tilting, and zooming 
for information on enabling and disabling the digital PTZ feature.

store a preset camera position.
To store a preset, select a preset number from the drop down list and 
then click the icon. The camera position (pan, tilt, and zoom) is saved in 
the selected preset.
The icon is disabled when digital PTZ is enabled. You need to disable the 
digital PTZ feature to store a preset. See Panning, tilting, and zooming 
for information on enabling and disabling the digital PTZ feature.

start recording of video. You can click the icon again to stop recording of 
video. This initializes user activated recording. 
Right-clicking on a panel displays a context menu. You can click the 
Start Recording command to start recording of video. This initializes 
user activated recording. 

view video from associated cameras. See Surrounding Cameras.

pan left.

pan right.

tilt up.

tilt down.

Icon Click to...
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Panning, tilting, and zooming
You can pan, tilt, and zoom (PTZ) the video displayed in a panel. You can perform 
three types of PTZ namely, analog PTZ, Digital PTZ and Local PTZ.

Analog PTZ is the panning, tilting, and zooming of PTZ cameras. 

Using the digital PTZ feature in MAXPRO VMS, you can perform panning and tilt-
ing on live and recorded video and clips. The digital PTZ feature when enabled 
allows you to perform panning and tilting on the video display that is zoomed or 
enlarged.

Local PTZ feature can be used when normal PTZ does not work. You can switch to 
client side PTZ using Local PTZ feature. 

Zooming the Video Display 
Use the mouse scroll wheel to enlarge (zoom in) or reduce (zoom out) the video dis-
play in the panel. Alternatively, hover the mouse over the video display. A toolbar 
appears in the lower part of the panel. You can click to zoom in and to zoom out the 
video display.

Panning and Tilting
To perform analog PTZ 

1. Click the Viewer tab.

2. Center-click anywhere on the video panel. A point is highlighted.

open iris.

close iris.

focus far.

focus near.

Icon Click to...
150 MAXPRO®VMS R670 Operator’s Guide 



3. Move the mouse to the preferred location, and then click and hold left mouse 
button to perform pan and tilt. A arrow appears in the direction where the 
mouse is being moved. 

4. Center-click again to stop panning and tilting. 

Note: The digital PTZ must be disabled to use analog PTZ. To disable the digital PTZ feature, 
click and clear Digital PTZ in the context menu.

5. Click the video display and drag the mouse pointer in the direction to pan or tilt. 
An arrow appears on the video display indicating the pan or tilt direction. 

To perform digital PTZ 

1. Right-click on the video display in a panel. A context menu appears.

2. Select Digital PTZ. The digital PTZ feature is enabled for the video display in the 
panel.

3. Zoom the video display.

4. Center-click anywhere on the video panel. A point along with left, right, up, and 
down arrows appear. 

5. Move the mouse in the required direction to pan and tilt.

6. Center-click again to stop panning and tilting. 

You can also use the joystick controller (Ultrakey keyboard) to perform panning, 
tilting, and zooming.

To perform Local PTZ 

1. Right-click on the video display in a panel. A context menu appears.

2. Select Local PTZ. The local PTZ feature is enabled for the video display in the 
panel.

3. Center-click anywhere on the video panel. A point is highlighted.

4. Move the mouse to the preferred location, and then click and hold left mouse 
button to perform pan and tilt. A arrow appears in the direction where the 
mouse is being moved. 

5. Center-click again to stop panning and tilting. 

Note: The digital PTZ must be disabled to use Local PTZ. To disable the digital PTZ feature, 
click and clear Digital PTZ in the context menu.

6. Click the video display and drag the mouse pointer in the direction to pan or tilt. 
An arrow appears on the video display indicating the pan or tilt direction. 
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Images and Clips

Saving Images
While viewing video in the panel, you can save a frame of the video as an image. 
The image can be saved in Bitmapped Graphics (BMP), Joint Photographic Experts 
Group (JPG) format, Portable Graphics format (PNG), and Graphics Interchange 
Format (GIF).

To save a frame displayed in a panel as an image 

1. Click the Viewer tab.

2. Right-click the panel to display a context menu.

3. Select Save Image to save the image in .BMP format. Alternatively, you can click   
on the toolbar on top of the salvo layout. The images are saved in the 
ImagesAndClips folder at the location in the hard drive in which MAXPRO™ 
VMS files are installed. For example, X:\Program 
Files\Honeywell\TrinityFramework\ImagesAndClips. Here, X: is the hard drive.
Or
Select Save Image As to save the image in other formats. The Save As dialog box 
appears when you select the Save Image As command. You can select the 
format in the Save As Type box and type the name for the image in File Name 
box. You can also select a folder to save the image.

To save the salvo layout as an image 

•    Click on the toolbar on top of the salvo layout.

The salvo layout is saved as an image (.BMP format) in the ImagesAndClips folder. 

Note: The images saved in the ImagesAndClips folder appear in the Image/Clip window. 
See Viewing Images and Clips for information on how to view images.

Creating Clips
Clips can created and exported from both primary and redundant recorder cam-
eras. You can create clips from the recorded video. These clips can be saved with 
digital signatures. Digital signatures ensure authenticity of clips. Digital signa-
tures are primarily used to authenticate videos that are produced in courts as evi-
dence. A digital signature generates a unique string for the clip using algorithms 
recommended by the W3CThe World Wide Web Consortium (W3C) is an interna-
tional consortium where member organizations, a full-time staff, and the public 
work together to develop Web standards. If the video in the clip is modified, a verifi-
cation check for the unique string fails indicating that the content is tampered. 
When a clip is saved with the digital signature, a package file with the .PKG exten-
sion is created to save the clip.
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To create a clip

1. Click the Viewer tab.

2. Specify the loop for which you want to create a clip.

3. Click in the Timeline window. A dialog box appears with the name of the 
cameras from which video is displayed in the salvo layout.

or

Right-click a loop in the Timeline window and select Export Clip in the context 
menu. The Create Clip dialog box appears.

Figure 3-17    Creating a Clip

4. Select one of the following options in the dialog box.

Option Select to...

Include only marked area and 
Auto split on recording gap

save one or more loop in the timelines as clips.

Create clip for entire duration specify the time duration of video that you want to save 
in the clip. After selecting this option, the date and time 
(start and end) can be specified in the From and To 
boxes. 
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5. Under Streams, select the cameras. Only the video from the selected cameras 
are saved as clips. 

6. In the Format drop-down list under Streams, select the required format. The 
formats supported by the recorders are listed in the following table.

7. In the Job Name box, type a name for the job or retain the default name 
assigned by MAXPRO VMS. 

8. In the Location box, you can select the folder in which you want to save the clip. 

The default folder location is displayed in the Location box. You can click  to 
select another folder location

9. Select the Archive and Digital Signature check box, to archive the clip with the 
digital signature.

10. In the Comments box, type the required comments for the job to be created.

• If MPVC format clip is selected to export then a Password field is displayed. 
You can provide a password if required.

11. Select the Include MPVC Clip Player check box to play the recordings of MPVC 
format files. This player is to playback only MPVC format clips.

12. Select the Split Clip Size check box and then select the required size and units 
from the corresponding drop down boxes. This option is applicable only for ASF 
and MPVC formats.

Note: The Estimated Clip Size box displays the total size of the clip that is being exported. 
Based on this you can split the clip to optimize the CPU. You can split the clip size 
upto 4.7 GB. This option is applicable only for ASF and MPVC formats.

13. Click OK to create the clip. The clip creation status is indicated in the status bar. 
The clip is saved with an automatically generated name.

Recorder Format Supported

MAXPRO NVR WMV,, .ASF, MPVC

Embedded Recorders DAV
Note: You can play the DAV files using Windows Media 
Player after installing KLite Codec. You can also play 
DAV files with a 3rd party DAV players such as 
Amcrest's Smartplayer.

ADPRO XO HBOX
Note: MAXPRO VMS integration with ADPRO XO 
recorder allows user to export clip (HBOX format) along 
with the HBOX clip player. See How to export
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Note
• The Clip Preview pane is not visible for recorders that do not support previewing of clips in 

the Clip Preview window.
• For only few recorders, the playback session is closed while creating a clip from the 

cameras connected to the recorder with playback limitation. You have to restore playback 
session manually after the clip creation is complete. 

To cancel the clip creation 

1. Click the clip creation status indicator in the status bar. The Clip Export Status 
dialog box appears. 

2. Right-click the job name that you want to cancel, and then select Cancel. To 
cancel all the jobs, select Cancel All. 

Naming Convention for Clips
The following table explains the automatic naming convention for a clip using an 
example

Example of a clip name-080109125809_CameraDoor_(1).MP4.

Note: You change the default naming convention for clips. See Setting Custom Profile for more 
information.

WMV, ASF and MPVC Formats
Clips can be exported in either WMV, ASF or MPVC formats. When compared to 
WMV format, the ASF format is much faster and more reliable. MPVC format is spe-
cifically designed The following table describes the WMV and ASF formats.

Note: 1. ASF format clips are supported as of NVR version 3.1 SP1. This format is 
recommended for clip durations longer than an hour for exporting as backup clips.
2. WMV format clips are recommended for clip durations that are less than an hour 
for exporting as evidence clips.

Clip Name Description 

080109 The first two digits indicate the year, the next two digits indicate the 
month, and the last two digits indicate the date of clip creation.

125809 The first two digits indicate the hour, the next two digit indicates the 
minutes, and the last two digits indicate the seconds.

CameraDoor The name of the camera.

MP4 The file extension for the clip.
The file extension can be MP4 or WMV, ASF or MPVC
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Viewing Images and Clips
From the Images/Clip window, you can view the images and clips saved in the 
ImagesAndClips folder at the location in the hard drive in which MAXPRO VMS files 
are installed. This path includes the clips of both primary and redundant recorders.

To view the list of saved images and clips

1. Click the Viewer tab, and then click the Images/Clip tab. 

2. In the Images/Clip window, expand the Images and Clips folder. Folders with 
names indicating the date in which the images and clips are created appears. 
The first two digits of the folder indicate the date, the next two digits indicate 
the month, and the last digits indicate the year.

3. Expand the folder corresponding to the date on which the image or clip you 
want to view is saved. Inside the folder, the clips are saved in the Clips sub-
folder and images are saved in the Images sub-folder.

4. You can refresh the list of images and clips in the Image/Clip window to update 
the list. Refreshing the list displays the latest images and clip names. To 
refresh, right-click in the Image/Clip window to display a context menu and 
click Refresh.

WMV Format ASF Format MPVC Format

WMV is traditional and slow. ASF format is faster at 
exporting a clip. It takes 50 
minutes to export a 24 hour 
clip without much 
difference in the size of the 
clip.

Its Honeywell 
Proprietary format.

Text overlay is not 
supported in the NVR 
viewer with ASF formats.

WMV format converts the packets 
into MPEG formats and then 
displays the video.

ASF format takes the raw 
data from the packets and 
displays the video directly 
without conversion. This 
makes the ASF format 
faster in processing the 
video.

ASF format does not 
display the Time Stamp on 
the clip. To view the Time 
stamp it is recommended 
to play the clip with the VLC 
Player. (http://
www.videolan.org/vlc/
index.html)

You can playback the 
MPVC format using 
MAXPRO Clip player 
which is designed 
only for MPVC format 
clips.
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Images
To view the images 

In the Images/Clip window, right-click the image to display a context menu and 
select Image View. The salvo layout changes and the image is displayed on the 
screen.

Note: You can click on the toolbar to view the salvo layout again. To view the image 

again from the salvo layout, click .

Viewing options for images

Viewing Video Related to an Image 
If video recording is available, you can view video from the date and time of saving 
the image.

• In the Image/Clip window, right-click the image to display a context menu and 
click Show Video. The video is played from the starting date and time of saving 
the image.

Clips
To view the clips 

• In the Images/Clip window, right-click the clip to display a context menu and 
select Show Video. The video is displayed in the salvo layout.

or

• Double-click the clip. 
or

• Drag the clip on a panel in the salvo layout.

To view the clips folder 

• In the Images/Clip window, right-click the Clips folder or any clip to display a 
context menu and click Show In Folder to view the folder in which the clips are 
saved. 

You can view the first frame of video in a clip as an image.

To view the first frame as an image 

Option Description

Image Size On the toolbar, you can select the image size in the box. The image sizes 
available are Small, Medium, and Large.
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• In the Images/Clip window, right-click the clip to display a context menu and 
select Image View. The salvo layout changes and the first frame from the clip is 
displayed on the screen.

Deleting Images and Clips
In the Image/Clip window, you can delete the images and clips that you do not 
need. 

To delete an image or clip 

1. Click the Viewer tab.

2. Expand the folder in which the image or clips is saved in the Images/Clip 
window. 

3. Right-click the image or clip which you want to delete. A context menu appears.

4. Click Delete.

Bookmarks
The Bookmarks feature allows user to create bookmarks on a live video and save 
under the bookmarks tab. The bookmarks window displays only those bookmarks 
created by specific user based on the privileges. It also allows you to filter and view 
the bookmarks. You can perform the following on this window:

• Create Bookmarks

• Play the video from the Bookmark time

• Send a message to any user under MAXPRO VMS. You can send Operator 
and Monitor messages.

• View the list of Bookmarks from the context menu.

• Delete a Bookmark 

• Configure the Bookmark settings in Preference window to retain/recycle. 

A typical Bookmarks pane is highlighted in the below screen.
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Figure 3-18    Bookmarks tab

The Bookmarks pane contains the following fields as explained in the below table:

Creating Bookmarks
• On a live video, right-click to view the context menu options and then select 

Add Bookmarks. A bookmark is created from that date and time and 
displayed under Bookmarks list as highlighted below.

Option Description

BookMark 
Time

Time and date of bookmark created

Device ID Device ID number.

Bookmark 
Description

Description of the bookmark

Camera 
Name

Name of the camera on which the bookmark is created.

Bookmark 
Filters

to search and fine the bookmarks of Today, Yesterdays, Last 7 days and 
Last 30 days.
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.

Figure 3-19    Add Bookmarks

Filtering the Bookmarks
1. In Bookmarks pane > BookMarks Filter drop-down list, select the required dura-

tion from which you want to view the list of bookmarks. The available option are:

• Today

• Yesterday

• Last 7 Days

• Last 30 Days

2. Click  to view the list.

Playing the video from the Bookmark time
1. In Bookmarks pane, click on the required bookmark that you want to play.

2. Perform any one out of the following:

• Right-click on the bookmark and then select Play Bookmark as highlighted 
below.
Or
Drag and drop the required bookmark on to the video panel. The video is 
displayed from the selected duration.
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Figure 3-20    Play Bookmark

Sending Bookmark as a message
1. In Bookmarks pane, right-click on the required bookmark and then select Send 

Message as shown in figure 20 above. The Message Sender dialog box appears.

2. Perform the following:

• Message Type: Select the type of message you want to send. The available 
options are Operator and Monitor message. Based on this selection the 
Operator list or Monitor list is displayed.

• Send To Me: Select this check box if you want to receive a message.
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• Operator: If you have selected Operator as Message type then from the list of 
operators, select the required operator check box to whom you want to send 
message.
Or
Monitor: If you have selected Monitor as Message type then from the list of 
monitors, select the required monitor check box to which you want to send 
message.

• Comments: Add additional comments if any.

3. Click Send. A message is sent and you can see the list of messages sent in the 
Messages window.

Viewing the list of Bookmarks from the context menu
• On a live video, right-click to view the context menu options and then choose 

Bookmarks. The list of bookmarks are displayed as shown below.

Figure 3-21    Context Menu Bookmarks

Deleting a Bookmark
• On a live video, right-click to view the context menu options and then choose 

Bookmarks > Remove Bookmarks as shown in figure 21. The selected 
bookmark will be removed from the list.
Or
In Bookmarks pane, right-click on the required bookmark to delete and then 
select Delete as shown in figure 20. The bookmark will be deleted from the list.
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Configure Bookmark Settings
To configure the bookmark settings:

1. Click the Preferences option in the user menu. The Preferences dialog box is 
displayed. By default, the General Settings tab is selected. 

Figure 2-22    Preferences

2. Click the Bookmark Settings tab. 

Figure 3-23    Bookmarks Settings tab

3. Under Bookmark Configuration Settings:

• BookMarks Retention Period (Days): Specify the number of the day that you 
want to retain the bookmarks. Post this date the bookmarks will be deleted.

• No. of BookMarks (On Screen Limit): Specify the number of the bookmarks 
that you want to view under the bookmarks pane.

• Click Apply and then click OK.
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Monitoring Redundancy Recorders
After you configure the Redundancy recorder in the Configurator tab, you can 
monitor or trigger the Failover manually/Automatically in the following scenarios:

• ‘Scenario 1: For maintenance purpose: If you want to perform any 
maintenance activities on the existing primary recorders then click Manual 
option under Failover and then click the Trigger Failover in the Configurator 
tab. The Manual Failover successful message is displayed in the status bar 
and the Trigger Failover button turns to Trigger Failback. 

The following indications can be identified when the Failover is successful:

• In the Devices tree, under a specific recorder for all the cameras R is displayed. It 
means the recorder and cameras are under redundancy.

• If you drag and a drop a camera in redundancy mode, the top right corner of the 
camera panel displays FO (Failover).

• In Alarms window, Manual Failover and Manual Failback alarms are generated for 
Manual Failover.

• If a primary recorder camera is rendering continuously and if you trigger Failover for 
1 day then the timeline displays the recording indication as: First green color for a 
primary recording and then Pink color during failover mode and then green color for 
rest of the days.

Once the maintenance activity is done you can click the Trigger Failback button to 
shift to primary recorder.

• Scenario 2: While upgrading a build: If you want to upgrade the Primary 
recorder with the latest version of VMS then you can trigger the failover 
manually to backup recorder and then upgrade the primary recorder. The 
Trigger Failover button turns to Trigger Failback. Once the upgrading is done 
then you can switch back to primary recorder. The failover indications are 
same as explained in scenario 1 and can be identified when the failover is 
successful.

Refer to MAXPRO® VMS Installation and Configuration Guide for more information 
on how to configure Redundancy Controller, Redundancy Pool and Failover Con-
straints.

Automatic Failover Alarms
The Alarms for Automatic Failover are different when compared to manual Failover. 
For Automatic Failover the reason for Failover is displayed such as CPU Fail, high 
Bitrate, Low FPS and so on.
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Incident Management Mode
The Incident Management Mode feature helps in creating a story line of a particu-
lar incident that is captured using the video recorded from one or more surveil-
lance cameras. You can create a clip for the incident that is triggered, and view it as 
a story line. You can save the clip with digital signature and send it for further evi-
dence. You can create a story line from a maximum of 16 cameras.

To start the Incident Management Mode 

1. Click the Viewer tab.

2. Drag and drop the cameras to the salvo layout or drag and drop a salvo view to 
the salvo layout.

3. Click  on the toolbar on the top of the salvo layout. The Incident 
Management Mode is activated.

Note: You can drag and drop a new camera after starting the Incident Management Mode.

Figure 3-24    Incident Management Mode Activated

Note: The cameras displayed on the salvo layout automatically enter into the playback 
mode after the Incident Management Mode is activated. All the cameras display the 
same time in the Incident Management mode

4. Create loops for the each of the cameras. You can mark in multiple cameras at a 
time in the Incident Management Mode.

Note: Marking in multiple cameras automatically marks out all the previously marked in 
cameras.
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Figure 3-25    Creation of Loops

5. Click  in the Timeline window a to create a clip for the incident that is 
recorded. The Create Clip dialog box appears displaying the loops created for 
all the three cameras.

Figure 3-26    Create Clip dialog box

Loops created for all 
the three cameras
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6. Select one of the following options in the dialog box:

Note: The total clip time for a particular camera is calculated as follows: pre overlap time + 
loop time + post overlap time. For example, you mark in at 10.10:00 AM and mark out 
at 10:11:00 AM. The loop time is 1 minute. The pre overlap and post overlap times 
configured are 10 seconds respectively. The total clip time is 10 seconds + 60 
seconds + 10 seconds = 80 seconds. The clip starts playing at 10:09:50 AM and ends 
playing at 10:11:10 AM.

7. Select the Adjust Time for DST check box to adjust the selected time with the 
day light savings time.

8. Under Streams, the list of cameras for which you created the loop are displayed. 
You can change the From Date, To Date, From Time, To Time, and rename or 
change the clip name according to your requirement. MAXPRO VMS assigns a 
name for the clip by default.

Note: Select a camera and use the buttons to move it up or down.

Note: Select a camera to view its video on the Viewer window located on the right of the 
Create Clip dialog box. Use the First Frame, Last Frame, and Pause buttons to 
customize the viewing of the video.

9. In the Format drop-down list under Streams, select the required format. The 
formats supported by the recorders are listed in the following table.

Option Select to...

Include only marked area and 
Auto split on recording gap

specify the time duration of video that you 
want to create in the clip. After selecting this 
option, the date and time (start and end) 
can be specified in the From and To boxes.

Create clip for entire duration specify the time duration of video that you 
want to save in the clip. After selecting this 
option, the date and time (start and end) 
can be specified in the From and To boxes. 

Recorder Format Supported

MAXPRO NVR WMV,, .ASF, MPVC

Embedded Recorders DAV
Note: You can play the DAV files using Windows Media 
Player after installing KLite Codec. You can also play 
DAV files with a 3rd party DAV players such as 
Amcrest's Smartplayer
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10. The Remember Salvo Layout check box is selected by default. The clip is played 
exactly in the salvo layout in which the cameras were dragged and dropped. 
Click to clear the Remember Salvo Layout check box if you want to play the clip 
sequentially as a storyline from one camera at a time.

11. The Job Name box automatically displays the package name.

12. In the Location box, you can select the folder in which you want to save the clip. 

The default folder location is displayed in the Location box. You can click  
to select another folder location.

13. Select the Archive and Digitally Sign check box, to archive the clip with the 
digital signature. A package would be created with all the exported clips and 
stored in the specified location.

14. In the Comments box, type the required comments for the job to be created.

15. Click OK to create the clip. The clip creation status is indicated in the status bar.

Note: For only few recorder, the playback session is closed while creating a clip from the 
cameras connected to the recorder with playback limitation. You have to restore 
playback session manually after the clip creation is complete.

Viewing Packages
To view packages 

• In the Images/Clip window, drag and drop the package to a salvo layout. The 
video is displayed in the salvo layout.

ADPRO XO HBOX
Note: MAXPRO VMS integration with ADPRO XO 
recorder allows user to export clip (HBOX format) along 
with the HBOX clip player. See How to export

Recorder Format Supported
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Figure 3-27    Dragging and dropping of packages

Instant Salvo Export
Instant Salvo Export feature is similar and a scaled down version of the Incident 
Management Mode feature. The only difference is that you need not mark in and 
mark out a camera explicitly while doing instant salvo export. The system automat-
ically marks in and marks out a camera based on the pre overlap time and post 
overlap time.

To do an Instant Salvo Export 

1. Click the Viewer tab.

2. Dag and drop the cameras to the salvo layout or drag and drop a salvo view to 
the salvo layout.

3. Click  on the toolbar on top of the salvo layout. The Create Clip dialog box 

appears.

4. Follow the steps 6 through 15 in the "Incident Management Mode" on page 4-
165 to complete the clip creation.
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Alarms
Alarms notify the occurrence of events to the operators. You can configure alarms 
to be triggered when events such as adding a camera to a recorder, recorder disk 
space nearing full, motion detection, and others occurs. The events that trigger an 
alarm can be selected while configuring the recorders, failover recorders, video 
inputs, and switchers. Few alarms are considered as events if the severity level is 
low. You can set the severity of the alarm in Preference tab. See "Setting the Alarm 
Threshold Value" on page 3-101.

The configured Failover recorder alarms are also displayed as: 

• Recorder Manual Failover: When a failover is triggered manually.

• Recorder Manual Failback: When manual failover failback.

• Recorder Automatic Failover: When a failover is triggered automatically

• Recorder Automatic Failback: When automatic failover failback.

Each alarm goes through the following states:

New or Unacknowledged 

When an alarm is triggered it appears in the Alarm window. The state of the alarm 
after it is triggered is referred to as unacknowledged. You can view the list of all the 
unacknowledged alarms in a table in the Alarm window. For each unacknowledged 
alarm, the following details are listed.

Column Indicates... 

Description name of the event that triggered the alarm. For example, camera 
motion detected.

Event Details name of the event attribute. Only the key event attribute is 
displayed in this column. For example, If an Encoder is 
disconnected, the encoder name would be displayed.

Device Name name of the device such as recorder, camera, or switcher 
associated with the event. For example, the name of the camera 
that detected motion.

IO Status  status of the input and output

Date Time date and time when the alarm is triggered. 

Master Device 
Name

recorder description

Severity severity of the alarm. 

Site site name where the device is located.

Global 
EventID

global unique identification number of the event. 
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The number of unacknowledged alarms is displayed in a blinking mode in the sta-
tus bar red color. For example, Alarms (10) indicate that there are ten unacknowl-
edged alarms.

Acknowledged 

An acknowledged alarm indicates that the operator has taken the necessary action. 
After acknowledging the alarm, it is moved to the acknowledged alarms list in the 
Alarm window.

Cleared 

After the response action is taken, you can remove or clear the alarms from the 
acknowledged list in the Alarm window.

Acknowledging alarms
You can acknowledge an alarm to accept that the necessary response action is 
being taken.

To acknowledge an alarm 

1. Click the Viewer tab, and then click Alarm tab.

2. Click to select the alarm you want to acknowledge in the Alarm window. The 
unacknowledged alarms are listed in the first table in the Alarm window.

Note: To select more than one unacknowledged alarm, press the CTRL key.

3. Click Acknowledge. The acknowledged alarm appears in the second table in the 
Alarm window.

If you have selected multiple alarms, all the alarms are acknowledged and appear 
in the second table in the Alarm window. 

Note: If the active alarm count reaches 150, 000, a warning message appears on Alarms 
Indicator on the task bar. If the alarm count reaches 50,000 then it will be moved to 
backup table.

Context Menu Options
When you right-click on the list of unacknowledged alarms in the first table, a con-
text menu appears. 
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The following table lists the commands in the context menu.

Command Click to....

Ack acknowledge the selected alarm. 

Clear on Ack automatically clear the alarms when they are acknowledged. 

Ack All acknowledges all the alarms displayed in the Alarm window.

Show Video view video from the time corresponding to the occurrence of the 
event that triggered the alarm. The video is played in the currently 
selected panel in the salvo layout. 
The video is played only when the video recording is available.

Show Preview 
Pane

view video related to the alarm in a four panel salvo layout. This 
feature is available for cameras connected to the recorder only. 
See Setting Preferences for more information.

Show Details view the details of the alarm. This feature lists the device from 
which the alarm was triggered, description, date time when the 
alarm was triggered, status of the alarm, global event ID, and the 
event attribute associated to the alarm. You can also use the 
previous and next buttons to view the details of the alarms listed in 
the alarms window. 

Freeze stop receiving the new or unacknowledged alarms in the Alarm 
window. You can click this command again to start receiving the 
alarms. This feature is useful when the Alarm window contains 
many unacknowledged alarms and it becomes difficult to mange 
them. You can stop receiving the alarms momentarily and start 
receiving again when needed. 
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Clearing acknowledged alarms
You can clear the acknowledged alarms after taking the necessary action.

To clear an acknowledged alarm 

1. Click the Viewer tab.

2. Click to select the alarm you want to clear in the Alarm window. The 
acknowledged alarms are listed in the second table in the Alarm window.

Note: To select more than one unacknowledged alarm, press the CTRL key.

3. Click Clear. The alarm is removed from the list of acknowledged alarms.

If you have selected multiple alarms, all the alarms are cleared.

To clear all the acknowledged alarms 

• Click Clear All. All the acknowledged alarms are cleared and removed from the 
list of acknowledged alarms.

Context Menu Options 
When you right-click on the list of acknowledged alarms in the second table, a con-
text menu appears. 

Receive 
Alarms Only 

list only the alarms in the Alarm window. Alarms are listed only 
when the severity level of the corresponding event that triggered 
the alarm is greater than or equal to the alarm severity threshold 
value. See Setting Preferences for more information

Receive 
Events Only

list only the events in the Alarm window. Events whose severity 
level is greater than or equal to the alarm severity threshold value 
are listed. See Setting Preferences for more information. 

Receive Both 
Alarms and 
Events 

to list both alarms and events in the Alarm window. 

Command Click to....
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The following table lists the commands in the context menu.

Command Click to....

Clear Clears the selected acknowledged alarm. 

Clear All Clears all the acknowledged alarms.

Show Video view video from the time corresponding to 
the occurrence of the event that triggered 
the alarm. The video is played in the 
currently selected panel in the salvo layout. 
The video is played only when the video 
recording is available.

Show Preview Pane view video related to the alarm in a four 
panel salvo layout. See Setting Preferences 
for more information.

Show Details view the details of the alarm. This feature 
lists the device from which the alarm was 
triggered, description, date time when the 
alarm was triggered, status of the alarm, 
global even ID, and the event attribute 
associated to the alarm. You can also use 
the previous and next buttons to view the 
details of the alarms listed in the alarms 
window. 
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Controlling Alarm/Message Flashing
User can disable/enable the continuous alarm/message flashing for a workstation 
in the VMS application.

To enable/disable alarm flashing/blink

1. Navigate to the Bin folder and then locate MmShell.exe.config file.

2. Open the config file using Notepad.

3. Locate the below parameters and change the value to False or True for alarm 
blink and message blink accordingly. 

Note: Alarm blink is disabled or set to False by default.

• <add key="AlarmBlink" value="False" />

• <add key="MessageBlink" value="True" />

Freeze stop receiving the new or unacknowledged 
alarms in the Alarm window. You can click 
this command again to start receiving the 
alarms. This feature is useful when the 
Alarm window contains many 
unacknowledged alarms and it becomes 
difficult to mange them. You can stop 
receiving the alarms momentarily and start 
receiving again when needed. 

Receive Alarms Only list only the alarms in the Alarm window. 
Alarms are listed only when the severity level 
of the corresponding event that triggered 
the alarm is greater than or equal to the 
alarm severity threshold value. See Setting 
Preferences for more information.

Receive Events Only list only the events in the Alarm window. 
Events whose severity level is greater than 
or equal to the alarm severity threshold 
value are listed. See Setting Preferences 
for more information.

Receive Both Alarms and Events to list both alarms and events in the Alarm 
window. 

Command Click to....
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Operator messaging

About operator and monitor messaging
Operator messaging is a feature that enables you to send video displayed in one or 
more panels or the whole salvo layout to other operators and digital monitors. The 
digital monitors are connected to the MAXPRO VMS client workstations. The MAX-
PRO VMS user interface is installed on client workstations. You can include your 
comments in the message and send it to operators and to yourself. The comments 
are not included when you send the message to digital monitors.

This feature is useful when you notice an event in the video and you want to com-
municate it to others. The other operators can view the video and watch the event 
you noticed.

The number of new messages sent to you appears in the blinking mode in the sta-
tus bar. For example, Messages(3) in green color indicates three new messages.

Sending message to operators, and to yourself

1. Click the Viewer tab.

2. Click to select the panel. To select multiple panels, press the CTRL key.

3. Right-click on the panel and select Send Message in the context menu. A dialog 
box appears.

4. In the Message Type box, select Operator. The list of operators appear in the 
Operator group.

5. Select the check box next to the operators to select them. The message is sent 
only to the selected operators. You can select the check box next to the Name 
column to select all the operators.

6. Select the check box next to Send to me to send the message to you.

7. In the Comments box, type your comments or remarks.

8. Click Send to send the message. When the operators receives the message, it 
appears in the Messages window. The number of messages also appears in the 
blinking mode in the status bar.

Sending the Message to Digital Monitors
Note: When message is sent to a digital monitor (client workstation), the video is displayed 

in a panel that is selected in the salvo layout.

1. Click the Viewer tab. 

2. Click to select the panel. To select multiple panels, press the CTRL key. 

3. Right-click on the panel and select Send Message in the context menu. A dialog 
box appears.

4. In the message type box, select Monitor.
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5. Select the check box next to the monitors to which you want to send the 
message. 

Note: You can select the check box next to the Name column to select all the monitors.

6. Click Send to send the message.

Forwarding a Received Message
You can forward the messages in the Messages window to operators and digital 
monitors.

To forward a message 

1. Click the Viewer tab.

2. Right-click the message you want to forward in the Messages window. A context 
menu appears.

3. Select Send To in the context menu. A dialog box appears.

4. Do one of the following: 

• To forward the message to operators, select Operator in the Message Type box. 
You can select the check box next to the operators to select them or select the 
check box next to the Name column to select all operators.

• To forward the message to digital monitors, select Monitor in the Message Type 
box. You can select the check box next to the monitors to select them or select the 
check box next to the Name column to select all monitors.

5. Click Send to forward the message.

Sending the whole Salvo Layout you are Viewing as a Message
You can send the whole salvo layout as a message to operators, to you, and to digi-
tal monitors. When the message is opened, the salvo layout you have sent appears 
with the video display in panels.

To send the whole salvo layout as a message 

1. Click the Viewer tab.

2. Right-click on the toolbar on the top of the salvo layout and click Send Message 
in the context menu. A dialog box appears. Perform one of the following:

• To send the salvo layout to you, select the Send to me check box.

• To send the salvo layout to operators, select Operator in the Message Type 
box. You can select the check box next to the operators to select them or 
select the check box next to the Name column to select all operators.

• To send the salvo layout to digital monitors, select Monitor in the Message 
Type box. You can select the check box next to the monitors to select them or 
select the check box next to the Name column to select all monitors.

3. Click Send to send the message.
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Viewing Live Video 
You can view live video from the messages. 

To view live video 

1. Click the Viewer tab. 

2. Click the Messages window. Select the message from which you want to view 
live video, right-click and then select Show Live. 

Reviewing Messages 
To open a message and review video 

1. Click the Viewer tab. 

2. In the Messages window, right-click the message, and then click Review in the 
context menu. The video is displayed in a panel based on the time the message 
was sent. 

To open a message and view live video 

1. Click the Viewer tab.

2. Right-click the message in the Messages window and click Show Live in the 
context menu. The live video is displayed from the camera from which the 
message was sent. 

Note: By default, message is in “Show Live” mode when you double-click or drag it. 

Viewing and Deleting Messages
The messages sent by other operators to you are listed in the Messages window. 
You can open the message to view the video and read the comments. You can also 
send the messages in the Messages window to other operators and digital moni-
tors. The digital monitors connected to the MAXPRO VMS client workstations. The 
MAXPRO VMS user interface is installed on client workstations. In addition, you 
can delete the messages from the Messages window.

Viewing Video and Comments in a Message
The following icons appear next to a message in the Messages window.

Icon Click to view...

video from all the panels in a salvo layout. 

video from a panel.
178 MAXPRO®VMS R670 Operator’s Guide 



To open a message and view video

1. Click the Viewer tab. 

2. Perform one of the following:

• In the Messages window, right-click the message, and then click Review in the 
context menu. The video is displayed in a panel on the salvo layout. 

• In the Messages window, right-click the message, and then click Show Live or 
drag and drop the message on the salvo layout or double-click the message. The 
video is displayed in a panel on the salvo layout. drop the message from the 
Messages window to a panel in the salvo layout. The video is displayed in the 
panel.

• Double-click the message in the Messages window. The video is displayed in a 
panel.

To view the comments in a message 

• Right-click the message in the Messages window and click Show Details in the 
context menu. The comments appear as a ToolTip.

Note: You can hover the mouse over the message icon to view the comments in a tooltip.

Sending the Messages to other Operators and Digital Monitors
To send messages to other operators and digital monitors

1. Click the Viewer tab.

2. Right-click the message in the Messages window and click Send To in the 
context menu. A dialog box appears.

3. Perform one of the following: 

• To send the message to operators, select Operator in the Message Type box. You 
can select the check box next to the operators to select them or select the check 
box next to the Name column to select all operators.

• To send the message to digital monitors, select Monitor in the Message Type box. 
You can select the check box next to the monitors to select them or select the check 
box next to the Name column to select all monitors.

4. Click Send to send the message. 

Deleting Messages
To delete a message in the Messages window 

• Right-click the message you want to delete and click Clear in the context menu.

video from more than one panel. 

Icon Click to view...
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To delete all the messages in the Messages window 

• Right-click a message and click Clear All in the context menu.

Searching for Recorded Video 
You can search for video recorded clips and Archived clips from cameras con-
nected to the various recorders. You can filter the search for recorded video based 
on search conditions like video recorded today, yesterday, and others.

To search for recorded video

1. Click the Search tab. 

Figure 3-28    Search

2. In the Search for drop down list, select one of the following:

• Events

• Clips

• Bookmarks

3. The list of recorders are displayed under Recorders in the Filter window. You 
can select more than one recorder by selecting the check box corresponding to 
it. If you want to reload the recorders, click the Reload button

4. The list of cameras that are connected to the selected recorder is displayed 
under Cameras section in the Filter window. Select the check box next to the 
cameras from which the video is recorded.

Note: Select the Select all check box to select all the cameras for the selected recorder(s).
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5. Select one of the following search conditions in the Date time filter drop-down 
list.

6. If you are doing an “Event” search, then under Type select the check box 
corresponding to the events that you want to search.

Or

If you are doing a “Clip” search, then under Type select the check box correspond-
ing to the recording you want to search.

Or

If you doing a “Bookmark” search, then under Type, type the bookmark to be 
searched in the Enter Bookmark text box.

7. Select the Include Archived Clips check box to search for archival clips.

Note: To get the exact Archived clip count in the result window ensure that VMS and NVR 
server is upgraded to R500 SP1.

8. Click . The recorded video is searched based on the search conditions. The 
search results are listed in the Results window.

Or

Click  to cancel the search operation.

Condition To search for...

Today video recorded today.

Yesterday video recorded yesterday.

Last 7 Days video recorded in the last seven days.

Last 30 Days video recorded in the last 30 days.

On video recorded on a particular date. The From box to select 
the date is enabled when you select On.

On or Before video recorded up to a particular date. The From box to 
select the date is enabled when you select On or Before.

Between video recorded between a time duration. The From and To 
boxes are enabled when you select Between. You can 
select the start time and date in the From box. The end 
time and date can be selected in the To box.
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Playing Video after Searching
• Drag and drop the search result from the Results window on the salvo layout. 

The panel starts displaying the recorded video.

Note: To select more than one search result, press the CTRL key.

How to search for Archived clips
Pre-requisite:

To get the exact Archived clip count in the result window ensure that VMS server 
should also be upgraded to R500 SP1.

• Perform the steps as mentioned in Searching for Recorded Video section. Based 
on the search criteria the archived clips are displayed in Grey color as shown 
below.

Playback Archival Clips
• Drag and drop the archival clips from the result window to panel. The camera 

name and clip status REC is displayed as shown below.

• If Archived clips are played in MAXPRO clip player then the camera name and 
clip status is also displayed.

Note: In Discovery Wizard, Select the Use NVR Unique System Number as Callup Number 
check box before discovering the devices for Archival Playback. Refer to the 
MAXPRO® VMS Installation and Configuration Guide for details.
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Viewing Primary and Archived Location
The location of Archived clips is displayed in the Result windows in Location col-
umn as highlighted below. The type of status is explained below.

• Archived: The clip is available only in Archived path.

• Primary, Archived: The clips is available in both primary storage and Archived 
path.

Deleting the Recorded Video
Caution:  Deleting the recorded video from the search result also deletes it from the recorder.

To delete the recorded video 
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1. Select the recorded video from the list of search results.

Note: To select more than one search result, press the CTRL key. 

2. Click . The recorded video is deleted from the recorder.

Archiving and Restoring video

1. Select the recorded video from the list of search results. 

2. Click . 

To restore an archived video 

1. Select the archived video from the list of search results. 

2. Click . Refer to MAXPRO® VMS Installation and Configuration Guide on how 

to perform Manual Archival for Primary and Redundant Recorder.

Note: The archived videos appear in black.

Intellisense search 
The Intellisense search option makes the search of cameras simpler and easier. 
When a part of the camera name is types in the text box, the Intellisense search 
displays the list of cameras that are connected to various recorders in the Devices 
window. For example, if you are searching for Camera 2 connected to particular 
recorder, then type Ca in the text box, the list of camera names that contain 'ca' are 
displayed. 

Intellisense search also supports wild characters while searching. For example, 

• ca* — camera names that begins with 'ca' are displayed. 

• *ca — camera names that ends with 'ca' are displayed. 

• *ca* — camera names that contain 'ca' are displayed. 

• ! ca — cameras that does not have 'ca' in their name are displayed. 

Select the required filter string and click on the filter button.You can toggle 
between the Filter On and Off mode using the option or right-click , and select 
between Filter ON and Filter OFF. The hot key to activate intellisense search is F4.
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About Remote Monitor 
The Remote Monitor Mode feature helps you to remotely control the digital moni-
tors from a single workstation. This feature is particularly useful for controlling the 
display of video on wall mounted digital monitors.

To control the remote monitors 

1. Click the Viewer tab.

2. Click the Monitors tab. The Monitors window displays the available list of 
monitors.

Figure 3-29    List of monitors and initial state of salvo in monitor2

You can control monitor 1 from monitor 2 by activating the remote monitor mode

3. Click  on the toolbar on the top of the salvo layout. The Remote Monitor 
Mode is activated.

4. Drag and drop monitor 1 to monitor 2.
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Figure 3-30    Dragging of monitor 1 to monitor 2

5. Perform an operation such as pausing the video from monitor 2.

Figure 3-31    Pausing video in Monitor 2

Pause button is 
clicked
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This action also pauses the video in monitor 1.

Note: The list of actions that you can perform in remote monitor mode include the 
following: selecting the cameras from which video is displayed, selecting the salvo 
layouts, creating salvo views and starting the recording of video.

About Image View 
You can view images or frames from the video recording.

To view the images from a video recording 

1. Click the Viewer tab. 

2. Right-click the camera from which you want to view the images in the Devices 
window. A context menu appears. Click Image View to display the images.

Figure 3-32    Image view

You can move the timeline Slider to view images from different times. You can also 
use the Date and Time Control to view images from different times.

You can view the images in different sizes by selecting an option in the drop down 
box on the top. For example, Small, Medium, and Large. 

Note: You can click on the toolbar to view the salvo layout again. To view the images 
again, click  from the salvo layout.
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Persistence
Persistence is the ability to retain the data that was stored while using the applica-
tion which otherwise is lost as it is stored on a temporary memory. MAXPRO VMS 
supports persistency for some of the operations in the viewer. The settings stored 
in the viewer during your current log on is stored and can be used when you log on 
next time. 

Persistence for Cameras
Persistence for cameras allows you to store the camera details, salvo view details, 
and message details, so that you can use the same details during your next log on. 
For example, if you have set mirror image for all the cameras on a four-panel salvo 
layout and log off, the same would be displayed when you log on next time. The fol-
lowing camera digital parameters are persisted. 

• Flip 

• Text Overlay 

• Mirror

• Brightness 

• Hue 

• Contrast 

• Saturation 

• Sharpness 

• Blur

• Deinterlace 

• Video Display Type

See "Video Control Options in Panel Toolbars" on page 4-147 for details on the 
above parameters.

Viewer Window Size and Position Persistence 
You can preserve the size and position of the viewer window. The size and position 
details are stored based on the monitor ID and Workstation. 

Log on Persistence 
Log on persistence allows you to store the previous user credentials. For example, 
if you have logged on using windows authentication and log off from MAXPRO 
VMS, the same user credentials would be preserved when you launch MAXPRO 
VMS to log on. 
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Persistence for Sort Options 
The sort options in Devices tree, My Devices tree, Monitors tree, Shared Devices 
tree, My Salvo View tree, Shared Salvo View tree, Sequence tree, Group By options 
in Device tree, and Partition selection in Devices tree is persistent based on the 
user. The devices that are listed using the Sort by Name and Group By options are 
preserved in the MAXPRO VMS Viewer. 

Smart Motion Search
Smart motion search feature is supported for all the versions of MAXPRO® NVR 
recorders (NVR 3.1, NVR 3.5 and NVR 4.0) from MAXPRO® VMS. The Smart Motion 
Search feature allows you to search motion of an object in a recorded clip. This fea-
ture overcomes the traditional way of searching for an object in recorded clips. It 
enables you to filter the search in a recorded clip based on Year, Month, Day, Hours, 
Minutes and Seconds. You can view the recordings of before and after the exis-
tence of an object. You can perform the search on a recorded clip which is in the 
system drive. This feature is not applicable for exported clips.

You need to configure a region of the object in the recorded clip and then define 
the date and time range to search for the motion of the selected object. 

Note: From a single workstation, only one smart motion search operation can be performed 
at any point of time.

Configuring the Search criteria
1. Select the required camera panel.

2. Click the Smart Motion Search icon on the toolbar as shown below.

Figure 3-33    Smart Motion Search icon

Or
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Right-click the camera on the salvo panel and then click Smart Motion Search as 
shown below.

Figure 3-34    Right-clicking the camera in the salvo panel

The Smart Motion Search window is displayed as shown below.

Figure 3-35    Smart Motion Search View

3. In the Step 1: Configure Search Region, click the Add button to create region(s) 
for search as shown below. 
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Figure 3-36    Regions Defined

4. Select the required region to display from the Region drop-down. Available 
options are All, None or (Region 1, 2, 3 and so on)

5. In the Step 2: Select Date & Time Range, define the start and end date/time 
from the calender.

6. In the Step 3: Search, click Search. The progress bar displays the progress of the 
search A list of recordings for the particular date and time is displayed in the 
lower pane as shown below.
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Tip: While the search is in progress you can cancel and modify your search criteria. Such as add one more 
region, select a different date and time. You can also refresh the image for a better results.

Figure 3-37    Recordings for the date and time

Note: By default, medium sized recordings are displayed.

• To view small or large snapshots (recording), select the appropriate option 
from the drop-down list as shown below.

Figure 3-38    Selecting the Large/Small options for the Recordings
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Navigation Tips
• At any point of time, click the Live view icon as shown below to go back to the 

Live video view.

Figure 3-39    Returning to Live Video

Status of Devices
The following table lists the status of the devices as they appear in Devices and My 
Devices window. 

Status Description 

Suggests that the Recorder is available.

Suggests that the Recorder is not available. 

Suggests that the fixed camera is not available. 

Suggests that the fixed camera is available

Suggests that the fixed camera recording is enabled. 
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Virtual Keyboard
Virtual keyboard is feature that enables you to select monitors, salvo layouts, pan-
els, and cameras using the keyboard. To perform an action such as panel or cam-
era selection, you need to type a command in the virtual keyboard box. The virtual 
keyboard box is activated when you click Virtual Keyboard in the status bar or when 
you press F3. 

You can enter the following commands in the virtual keyboard box.

Suggests that the PTZ camera is available. 

Suggests that the PTZ camera is disabled. 

Suggests that PTZ camera recording is enabled. 

Status Description 

Command Description 

M To select a monitor.
To select a monitor, type “M” and the monitor call up number and 
press ENTER. For example, type “M1” and press ENTER. The monitor 
with the call up number 1 is selected.
Each monitor is assigned a unique number called the callup number 
while adding the monitor. 
To view the monitor callup numbers in the Site window
1. Right-click the Site or Devices branch. A context menu appears. 
2. Select Show Device ID in the context menu. The monitor call up 
numbers appear next to the monitor name.
After, you select a monitor, the commands that you type in the virtual 
keyboard box are executed on the selected monitor. For example, 
after you select a monitor with callup number one, and type the 
command to select a salvo layout. The salvo layout is selected and 
displayed in the monitor with the callup number one. 

L To select a salvo layout. 
To select a salvo layout, type “L” and the position number of the salvo 
layout in the toolbar and press ENTER. For example, to select the 
second salvo layout from the left of the toolbar, type “L2” and press 
ENTER. 

W To launch a salvo view. To launch a salvo view, type “W” and the View 
ID and press ENTER. For example, if the View ID of a salvo view is 1, 
then type “W1” and press ENTER. The salvo view with View ID 1 is 
launched. 
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The current command that is being used is displayed on the left of the virtual key-
board. For example, if you select a camera using the virtual keyboard, then the let-
ter C is displayed on the left of the virtual keyboard indicating that it is in the 
camera mode. 

The following table lists the shortcuts to perform various tasks using the keyboard.

V To select a preset for the camera that is displaying video. To select a 
preset, type “V” and the camera preset number and press ENTER. For 
example, if you want preset 1 for the camera, then type “V1” and press 
ENTER.

P To select a panel in the salvo layout. To select a panel in the salvo 
layout, type “P” and the panel position number in the layout and press 
ENTER. For example, type “P1” and press ENTER to select the first 
panel in the layout. 

C To select a camera from the Devices window. The video from the 
camera is displayed in the panel that is selected in the salvo layout. 
To select a camera, type “C” and the camera call up number (Device 
ID) and press ENTER. For example, type “C1” and press ENTER. The 
video from the camera with the call up number 1 is displayed in the 
selected panel. 
Each camera is assigned a unique number called the callup number 
while configuring the camera. See Configuring a Camera.
To view the camera callup numbers in the Site window
1. Right-click the Site or Devices branch. A context menu appears. 
2. Select Show Device ID in the context menu. The camera call up 
numbers appear next to the camera name. 

O To activate the surrounding cameras for a particular camera. To 
select a camera, type “O” and the camera number and press ENTER. 
For example, type “O1” and press ENTER. The surrounding cameras 
for the camera 1 is activated. 

Command Description 

Shortcut keys Description 

Shift + Delete To close all the panels in the Salvo view.

Shift + Up arrow To zoom in

Shift + Down arrow To zoom out.

CTRL + Delete To close the Salvo view or the Message.

CTRL + M To select all cameras.

CTRL + P To perform analog PTZ.

CTRL + D To perform digital PTZ.

CTRL + Right arrow, CTRL + Left 
arrow, Shift + Left arrow, and Shift 
+ Right arrow keys

To perform panning operations.
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Video Viewing Options 
New EquIP Fisheye Camera (HFD6GR1) is capable of delivering Fisheye view of the 
surrounding and which can also be dewarped to different view types depending on 
the mounting position. To dewarp the video you need to configure the camera Gen-
eral > 360 Settings pane in MAXPRO NVR 4.1 Software application.

Right-click the panel displaying live video (for a New EquIP model camera) and 
then select Panorama settings. Select any mode to view live video in that mode.

The following table and figures display various views of New EquIP model camera 
based on the mounting position:

CTRL + Up arrow, CTRL + Down 
arrow keys 

To perform tilt operations. 

Space key To reset PTZ. 

Arrow keys To increase and decrease the speed for reverse and 
forward playing of video. 

Delete key To close the selected panel in the salvo layout.

CTRL + SPACE or F6 To enter the playback mode

CTRL + ENTER To enter the live mode.

Shortcut keys Description 

 Modes
FishEye 
View
(figure 40)

Quad View

(figure 41)

1 Panorama 
& 3 Quatro 
View
(figure 43)

Panorama 
2x 180 
Views
(figure 42)

1 Fish Eye & 
3 Quatro 
View
(figure 44)

Mounting
Position

Wall Mounting Supported Supported Supported Not Supported

Ceiling 
Mounting

Supported Supported Not Supported Supported Supported

Ground 
Mounting

Supported Supported Not Supported Supported Supported
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Figure 3-40    EQUIP-Fish Eye View

Figure 3-41    EQUIP - Quad View
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Figure 3-42    EQUIP - Panorama 2X180 View

Figure 3-43    Equip - 1 Panorama & 3 Quatro View
198 MAXPRO®VMS R670 Operator’s Guide 



Figure 3-44    EQUIP - 1 Fish Eye 3 Quatro View

MAXPRO Status Monitor
MAXPRO Status Monitor application allows you to monitor the status of system 
and Recording Engine in a network.You can manually add or auto search the 
required NVRs and then connect to a single or multiple NVRs (System or Recording 
Engine) to monitor the status of various parameters. 

How to access the application
• MAXPRO Status Monitor is part of NVR 4.0 package. It is installed along with 

the NVR

4.0 software only solution. Double-click  on your desktop.
Or
Click Start > All Programs > Honeywell > Maxpro NVR Tools and then click 
MAXPRO Status Monitor. By default the status monitor starts searching the 
NVRs in your network.
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Tool bar options

Monitoring the status of a System
To monitor the system status:

1. Launch the MAXPRO Status Monitor as explained in How to access the application  
By default the status monitor starts searching and displays the available NVRs 
in your network. The application is displayed as shown in figure 45. 

Note: By default the status monitor starts searching and displays the available NVRs in

your network. If you want to manually search, click  and then under Add

NVR, type the IP Address/Host name and then press Enter. See Monitoring the status of a System
Manually on page 202.

Icon/
Option Description

Remove: Removes the NVRs from the list. 

Interval: You can set time intervals under this option. It allows you 
to set the Refresh Intervals during which you want to monitor the 
status. The intervals vary from 1 second to 30 second. You can set 
the required time interval for the system to refresh the status.

Views: This option enables you to switch between views. Available 
options are list view and table view. Select the required one to view 
the data accordingly.

Refreshes the monitoring status and searches for the new NVRs 
in the network.
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Figure 3-45    MAXPRO Status Monitor Home screen

2. Select the required Or multiple NVR check boxes and then click the Connect 
button. The status of system is displayed as shown below.

Figure 3-46    System status of NVR

Note: By default the System status is displayed.
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To switch between views:

1. Click  on the tool bar. The status is displayed as shown below.

Figure 3-47    System Status

Monitoring the status of a System Manually
To monitor the status of a system manually:
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1. Launch the MAXPRO Status Monitor as explained in How to access the application 
. By default the status monitor starts searching the NVRs in you network. as 
shown below. 

Figure 3-48    MAXPRO Status Monitor Home screen

2. Under Add NVR, type the IP Address/Hostname that you want to monitor and 
then press Enter. The status of specific NVR is displayed in list view as shown 
below.

Figure 3-49    Status of NVRs

3. Select the required NVR check boxes and then click Connect to view the status.
MAXPRO®VMS R670 Operator’s Guide 203



How to set the Refresh Interval
Refresh intervals can be set while you are monitoring the status in List or Table 
view.

To set the refresh intervals:

1. On the tool bar, click . The Refresh Interval options are displayed based on 
your selected view.

Figure 3-50    Refresh Intervals

2. Click on the required time interval on the scale of 1 to 15 seconds. The status is 
displayed accordingly.

Profile-G or Edge Recording Sync
Introduction

Profile-G or Edge Recording Sync feature allows you to sync the recordings from 
the camera SD card to MAXPRO NVR. Camera SD card contains recordings that are 
configured on demand. This features enables the user to playback only those 
recording which are saved in the SD card after they are synced to MAXPRO NVR. 
User can enable the Edge Sync option in Camera page and then configure the day/
time for Edge Sync in the System window to get the recordings from the camera. 
Edge Sync feature is applicable only to the cameras with SD card. This feature is 
supported only for Mercury model cameras for now.
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Below table details the camera models and firmware details for Profile G supported 
cameras. 

Note: Only the below Profile G compliant camera models with Firmware supports the Edge 
Sync feature.
Profile-G compliant camera time should be in sync with NVR time.
Ensure you configure the NTP server to avoid Time Sync related issues.

Camera Models Details Firmware

H4W2GR1 Outdoor Dome 2MP 
2.7-12mm

V1.000.HW00.6, build: 2017-10-16

H4W2GR2 Outdoor Dome 2MP 
7-22mm

H4W4GR1 Outdoor Dome 4MP 
2.7-12mm

H3W2GR1 Indoor Dome 2MP 
2.7-12mm

H3W2GR2 Indoor Dome 2MP 7-
22mm

H3W4GR1 Indoor Dome 4MP 
2.7-12mm

HBW2GR1 Bullet 2MP 2.7-
12mm

HBW2GR3 Bullet 2MP 4.7-
47mm

HBW4GR1 Bullet 4MP 2.7-
12mm

HCW2G Box 2MP

HCW4G Box 4MP

HCL2G Box 2MP low light
V2.420.HW01.19, build: 2017-10-
16H4L2GR1 Outdoor Dome 2MP 

2.7-12mm low light

HBL2GR1 Bullet 2MP 2.7-
12mm low light

HDZ302LIW IR PTZ wiper, low light Base Firmware Version: 
V1.000.0024.0, build:
2017-10-17
PAN/TILT Firmware Version:
V1.000.000.20170914
Module Version: 01.06.0A
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How to Configure Profile-G or Edge Sync Feature
To configure the Profile-G or Edge Sync feature, perform the following in the order 
mentioned.:

1.  Upgrade the Camera Firmware.
• Enable SD card recording with required settings

1. Upgrade MAXPRO NVR to the latest version

2. Configure the Edge Sync Settings

• Enable the Edge Sync feature

Upgrade the Camera

Before Upgrading
• If there are critical recordings available in SD card, please take back up using 

camera web page before upgrading the firmware.

• Upgrade to the Camera Firmware versions to latest versions as mentioned in 
the above table.

• It is recommended to use IPC utility to upgrade the Camera Firmware.

Note: Ensure that there is no Camera power fluctuations during the upgrade procedure. 
This is to ensure smooth camera firmware upgrade.

Post Upgrade (Camera Settings)
1. Before adding the Profile-G camera into NVR, delete all the existing recording 

available in SD card.

2. Configure the required SD card recording configuration in the camera 
Webpage 
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Note: Irrespective of the length/size of clips, maximum number of clips supported on SD 
card is 700 only. 

If user want to use secondary channels resolution for SD card recording they have to 
set SD card recording settings as per the stream selected.

3. Ensure that the Camera Timezone is adjusted to match with the MAXPRONVR 
machines time zone. 

4. Select the Synchronize with check box to sync the NTP time server with Camera 
time and MAXPRO NVR time.

Upgrade MAXPRO NVR
• Install the MAXPRO NVR 4.5 Build 162 on top of NVR 4.1 Build 123. Refer 

MAXPRO® VMS Installation and Configuration Guide for more information on 
how to upgrade.

Configure the Edge Sync Settings
Edge Sync settings enables you to set the schedule for synchronizing the record-
ings from the camera SD card. This feature is supported for Profile-G compliant 
cameras where the recordings are stored at the camera level.

Note: Profile-G compliant camera time should be in sync with NVR time.
Ensure you configure the NTP server to avoid Time Sync related issues.

To configure the Edge Sync Settings:
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1. In MAXPRO NVR, navigate to Configurator > Systems tab. The Systems screen 
is displayed as shown below.

2. Under Edge Sync Settings:

• Click Every option and then select the time in minutes or hours to edge sync 
the recordings. 
            Or 
Click Every Day at option and then select the specific time in hours during 
which the edge sync should trigger. 

• Limit Past Sync: This option allows you to stop the synchronizing process at 
certain point of time. You can set time in minutes. The synchronizing process 
starts once it overshoots the limit time.

Note: The default Archival Schedule configured and recommended is Every Day at 12:00 
AM. This is recommended versus the Auto [24/7] option for optimal performance and 
load on NVR.

Enable the Edge Sync
This option is supported for Profile-G compliant cameras and used for checking 
whether the camera is really Profile-G compliant. Click the Get Configuration but-
ton, if the camera is a Profile-G compliant camera then the Get Configuration but-
ton disappears and Enable Edge Sync check box is enabled. 

To enable the Edge sync option:
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1. Navigate to Configurator > Camera tab. The Camera screen is displayed as 
shown below.

2. Click the Get Configuration button. If the camera is a Profile-G compliant 
camera then the Get Configuration button disappears and Enable Edge Sync 
check box is enabled as shown below.
If the camera is not Profile-G compliant then NVR application displays Edge 
Sync not supported or enabled for this device message at the bottom of the 
screen.

Note: For Profile-G compliant cameras the Streaming Mode is defaulted to UDP. If you want 
to switch from UDP to TCP mode then you need to update the .config file. After 
modifying the .config file for TCP mode you need to restart the Trinitybackfill service.

3. Select the Enable Edge Sync check box and then click Save.

4. Under Schedule tab > Recording Settings, select None from the drop-down list 
for both Continuous and Event based recording for the camera as shown below.
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Once the Edge syncing is enabled you can see the recordings available in SD card 
and in MAXPRO NVR (after Edge syncing) as highlighted below:

Note: You can Playback only the Edge synced clips (synced clips from camera SD card to 
MAXPRO NVR) from the MAXPRO NVR clients.
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How to Enable Low Bandwidth Streaming 
To Enable Low bandwidth streaming from MAXPRO NVR cameras to MAXPRO 
VMS:

1. In MAXPRO NVR > Configurator> Camera > Primary Stream tab, click Add 
Stream to add a secondary stream for the camera as highlighted below. A new 
stream (Stream 2) is added.

2. Under Stream2 > Recording > Video Quality Setting, select the low Resolution, 
FPS and GOP from the corresponding drop-down lists as highlighted below.

3. Under General tab > Preferences > Stream Preference Settings, select Stream 2 
from the Low Resolution drop-down list to set the Low Resolution configuration 
to use Secondary stream as shown below. 
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4. Once you are done with the configuration in NVR, discover the same MAXPRO 
NVR recorder in the MAXPRO VMS Server.

5. In MAXPRO VMS Client, click the Preferences Tab and navigate to the Advanced 
settings tab. This tab allows you can configure to use necessary setting 
applicable for this client as highlighted below.

6. Under Low bandwidth Stream Settings: 

• Select Low Resolution Stream check box - To enable and use only low 
resolution stream from MAXPRO NVR.

• Select Receive only I Frames check box - It allows you to receive only I frames 
for the camera stream. (For example: If a Camera is configured with 5 FPS 
and 5 GOP and if you select this check box then this setting will pull only I 
frame for the camera stream. It excludes P frames for the camera stream. 
This setting can be used when the available bandwidth is too low for full 
frames rendering of Secondary streams.)
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• Select the Use Extended Timeouts check box - This helps in increasing the 
default time outs for NVR connections, stream connections and snapshots 
retrieval.

7. Click the Preferences tab and navigate to Rendering settings tab. This tab 
allows you can configure to the Network Throttling options for low bandwidth 
site.

8. Under Network Throttling Options: This feature automatically measures the 
latency in streams periodically and manages the stream with lower resolution 
and lower frame rate in low network bandwidth sites. This enables user to view 
smooth video without fluctuations.

• Manage Resolution: Select this check box to manage the fluctuations in the 
resolutions.

• Manage Frame: Select this check box to manage the frames per second in a 
video.

Note: These settings can be enabled and used in Winmag machines where VMS clients are 
installed. After using these setting low streams can be pulled from Winmag viewer as 
well.

Viewing Multicast Stream
User needs to perform the following configurations in the order as explained below 
to view the Multicast stream. Refer MAXPRO® VMS Installation and Configuration 
Guide for more information on how to configure Multicast:

1. Switch Configuration

2. Camera Configuration

3. MAXPRO® NVR Configuration
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4. MAXPRO® VMS Configuration

After performing the above four steps, in VMS Viewer user can identify the Multi-
cast streaming cameras as [M] on the top right corner as highlighted below. 

Figure 3-51    Multicast Stream

Video Anonymization
This feature allows you to configure or mask identifiable objects based on the 
scene environment. User need to select the required environment from the drop 
down list based on the camera mounting position. The following are the Environ-
ments supported in this T-Patch

• Variable Scene: If the scene contains both stationary and moving people or 
objects then select this option to anonymize the objects in the scene.

• High Motion Scene: To anonymize the objects in high motion in the scene.

• Still Scene: To anonymize the objects in a scene where the scene 
predominantly contains stationary people and objects.

How to Anonymize objects based on Environment
1. Click the Configurator tab.

2. Expand Devices in the navigation area, and then click Video Inputs. The Video 
Inputs screen appears in the display area, and displays the list of video inputs

3. Click Add. The Camera > General screen appears by default.
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4. Under Video Anonymization, select the required option from the Environment 
drop-down list to mask people in live video scene. The available options are: 

Following images display the type of video anonymization scenes based on the 
environment selection.

For Variable Scene 

Settings Description

Variable Scene Select this option if the scene contains both stationary 
and moving people or objects. 

High Motion Scene Select if you want to anonymize the objects in high 
motion scene

Still Scene Select to anonymize the objects in a scene where the 
scene predominantly contains stationary people and 
objects.
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For High Motion Scene

For Still Scene 
216 MAXPRO®VMS R670 Operator’s Guide 



MAXPRO®VMS R670 Operator’s Guide 217



Annotations
Annotations for Intrusion Trace and Loiter Trace in Live and Playback video is sup-
ported in MAXPRO® VMS with MAXPRO® NVR recorder integration. This feature 
helps to trace and locate the moving subjects in live/recorded video and generates 
an alarm if intrusion or loitering is detected. This is applicable for Mask Detection 
and Social Distancing Violation detection also. See Mask Compliance Detection 
and Social Distancing Violation Detection for more information.

Equip-S series camera supports Annotation feature along with Intrusion trace and 
Loitering Trace alarms. These alarms are in-built with Equip-S series camera and 
are made available by installing required analytics licenses. 

Annotation with Intrusion Trace alarm: This feature helps in detecting a subject, if it 
enters a predefined restricted area. The system will annotate and detects the object 
with Green rectangular box. If the object is detected in the restricted area then the 
annotated Green rectangular box turns to Red and an alarm is generated.

Annotation with Loitering Trace alarm: This feature helps in detecting an object If 
loitering beyond the specified duration of time in a predefined region. The subjects 
is bounded by the box along with the duration (time in seconds) for which it is iden-
tified in the region of interest. If the subject is loitering in the region beyond a pre-
defined time then the annotation boxes turns to Red and an alarm is generated.

Refer to the MAXPRO® VMS Installation and Configuration Guide on How to enable this 
feature and use.

Note: Currently Annotation feature works with only with old GPU rendering modes.

Annotation feature is supported with the following camera models and firmware 
version

.

S.No Camera Model Firmware Loiter Intrusion

1 H4D8GR1 2.420.HW00.9, Build Date: 2018-12-17 V1.20.60 V1.20.60

2 HCD8G

3 HBD8GR1

4 HFD6GR1 1.000.HW00.9, Build Date: 2018-12-17 V1.20.60 V1.20.60

5 HFD8GR1

6 HDZ302DE 1.000.0043.3, Build Date: 2019-01-07 V1.20.60 V1.20.60

7 HDZ302D

8 HDZ302DIN
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Enabling Annotations in VMS
In Preference

• In Preference > Rendering Setting tab, select the View Annotations when a 
camera is displayed check box to enable annotations for all the supported 
cameras (Equip-S Series)

• In Video panel, hover the mouse in the bottom of the panel to view the 
options and then click on Show Annotations icon for that particular camera 
as highlighted below. You can also click the same icon to Hide annotation s 
only for that camera.
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Annotation with Intrusion Trace in VMS (Live/Playback)
After the Annotation feature is enabled for Intrusion trace, rectangular bounding 
boxes will be accompanied with any moving object in the scene. If any object is 
moving within the predefine area then the object is highlighted with Red rectangu-
lar box and an alarm is generated a shown below.

Annotation with Intrusion Trace (Live) with out alarm

Annotation with Intrusion Trace (Live) with alarm
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Annotation with Intrusion Trace (Playback) without alarm

Annotation with Intrusion Trace (Playback) with alarm
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Annotation with Loitering Trace in VMS (Live)
If an object loiters with in the predefined zone then a Green colored rectangular 
bounding box are displayed. If the same object loiters beyond the Maximum Loi-
tering Time, then the object will be highlighted with Red Rectangular box as shown 
below.

Object with in the Maximum Loitering Time (Live)

Object beyond the Maximum Loitering Time (Live) with alarm
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Loitering Trace in Playback with out alarm

Loitering Trace in Playback with alarm
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ADPRO XO Recorder Integration Support
ADPRO XO Recorder integration is now supported in MAXPRO VMS R550 and 
above version. In MAXPRO VMS user can avail the features of XO recorder includ-
ing the Annotation bounding boxes. User needs to update with new license to avail 
the features of XO recorder in VMS.

Note: It is recommended to change the default username and password after the first login.

The following are the qualified XO Recorder models and the Firmware versions 
supported with MAXPRO VMS R550.

Following are the features supported with ADPRO XO Recorder integration.:

# XO Recorder Model (Version) Firmware 
Version

1 ADPRO IFT IFT XO 04.02.0010

IFTE XO 04.02.0010

2 Fast Trace 2 XO 04.02.0010

3 ADPRO IFT Gateway XO 04.02.0012

# Features Supported

1 Add/delete/modify AdproXO recorder in VMS

2 Discover Cameras, Relays and Sensors

3 Live Video
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Snapshots with Annotations
Capturing snapshots with Annotation bounding box in Live and Recorded video is 
supported. User can find the captured snapshots under Snapshots/Clips pane.

Export HBOX clip player with clips
MAXPRO VMS integration with ADPRO XO recorder allows user to export clip 
(HBOX format) along with the HBOX clip player. A clip player extractor.exe file is 
exported to the defined path and user can execute the exe to view the video. This 
helps the user to play the clip in any machine without depending on supported clip 
format player.

4 Multi Stream

5 Snapshot save, digital correction, Mirror and Flip.

6 PTZ operations

7 Playback Operations
Note: Reverse playback operation is not supported. 
Playback operation may start a few seconds behind the 
selected time because of GOP settings.

8 Camera Status/Alarms

9 Events Search

10 Anonymization

11 HVA

# Features Supported
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How to export a clip in HBOX format
1. Perform the step 1 through step 10 as explained in Creating Clips section in cre-

ate clip dialog box is as shown below.

2. In the Format drop-down list under Streams, select the HBOX format. 

3. Select the Include HBOX Clip Player check box to play the recordings of HBOX 
format files. This player is to playback only HBOX format clips.

4. Click OK to create the clip. The clip creation status is indicated in the status bar. 
The clip is saved with an automatically generated name including 
ClipPlayerExtractor.exe file as shown below.
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5. Double-click the ClipPlayerExtractor.exe file. The XOClipPlayer is extracted and 
the video clip starts playing.

Playback associated videos for Input Alarms 
This feature enables user to playback the associated video with input alarm. User can view the video 
for an input alarm from all the associated cameras. User can associate one camera to one input alarm 
or multiple cameras and view the video feed. The configuration for associating cameras should be 
done in the XO recorder. This feature is support only from ADPRO XO recorder integration with VMS.

How to view Input alarm video feed in VMS
Pre-requisite:

• Ensure that the required number of cameras are associated with the input 
alarms in XO recorder.

1. In Viewer > Alarms pane, locate the required XO recorder input alarms.

2. Right click on the inputs alarm and then click Show Video.
Or
Drag and drop the required input alarm on the salvo pane as shown below.
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The video feed from the associated camera is displayed as shown below.

To view the details of the input alarm and the camera associated.

• Right click on the required inputs alarm and then click Show Details. The 
Alarm details dialog box appears as shown below.
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Smooth Reverse Playback
This is an enhancement to the existing reverse playback feature in MAXPRO VMS. 
Smooth reverse playback allows user to view the reverse playback operation with-
out any jerk in the playback video. Depending on the FPS and GOP setting in NVR 
camera properties, smooth playback video is displayed. Its is recommended to set 
the GOP value in the range of 5 to 10 to experience smooth reverse. This helps to 
view the best in class playback video during site monitoring and investigation with-
out dropping video frames. This enhancement is supported only with MAXPRO 
NVR recorder. Refer to the MAXPRO® VMS Installation and Configuration Guide on 
how to enable and use this feature. User can perform the following reverse play-
back functions smoothly.

Note: For smooth reverse playback, it is recommended to use lower GOPs (i.e less than FPS. 
For Example: 30FPS/5GOP, 30/10,10/10 and so on)

• Smooth playback in reverse direction for speeds upto 2x

• Key frame reverse playback at 4x, 8x and 16x speed

• Reverse playback on slow speed (1/8x to 1/2x)

• Reverse playback for multiple cameras

• Reverse playback for multiple cameras in Sync mode (Sync playback)

• Step reverse for cameras (frame-by-frame)
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How to enable Smooth Reverse

1. In the Preference dialog box, click the Rendering Settings tab as shown below.

2. Under Advanced Rendering Settings:

• Select the Smooth Reverse check box to enable.

License Plate Recognition (LPR) 
Enhancements has been made in LPR feature to support events with cropped 
images, categorization and details pane. LPR scans can be monitored through a 
dedicated window in MAXPRO thick client. This new windows also supports filter-
ing and searching events based on camera and category (White/Black listed/
unknown).In addition you can also view the specific event video from the LPR feed.

Note:  Cropped image is displayed in report if NVR and camera is in latest version of 
MAXPRO version. In addition, the camera firmware should also be in latest version 
dated 17-06-2019. In older version of NVR or camera the report is displayed without 
cropped images.

Following are the enhancements in LPR tab:

• New dedicated tab for LPR event monitoring

• Search LPR events

• Filter LPR events

• Viewing, acknowledging and clearing blacklisted and white listed alarms in VMS 
Alarm viewer

• Viewing video from Alarm window

• Live LPR view 
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• Details pane

• Cropped Image of the license plate

• Camera Name

• Event Date and Time

• Geographical location details

• Category details such as White Listed.Black Listed and Unknown with 
varying color

• Confidence Level: The maximum percentage value that a number plate is 
matching with the specific category

• Recorder Name

• Site Name

Note: Arabic number plates are also supported in English OS with Arabic locale.

Reference
To configure and use the LPR feature in MAXPRO VMS and NVR, refer to the 800-
24023-A_MAXPRO_ LPR_User Guide.

How to View LPR events Details and Video

1. From the LPR feed pane, select the required event.

2. Click Details link, a License details pane is displayed as shown below
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3. You can do any one of the following to view video specific to event

• Drag and drop the event from LPR feed pane to salvo view as shown below

Or

• In Alarms window, select a panel and double click on the required event to 
play.
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How to Filter LPR Alarms

1. In LPR tab click , the LPR Filter dialog box appears as shown below.

2. In LPR Filter pane:

• Type the LPR Number.

• Type the Category (White/Black listed/Unknown.

• Type the Country details of plate

• Select the required option from Watch list drop-down

3. Click Apply to view the specific events in LPR Feed pane.
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How to Search LPR Alarms

1. In LPR tab click , the LPR Search dialog box appears as shown below.

2. In LPR Search dialog box:

• Type the Camera Name, LPR Number, Category, Country, Owner details in the 
box provided.

• Select the Type and Sub Type (Blacklisted or Whitelisted/Unknown) from the 
drop down list.

• From the Scan Time drop down list, select one of the following search 
conditions.

• Today: events of today.

• Yesterday events of yesterday.

• Last 7 Days events generated in the last seven days.

• Last 30 Days events generated in the last 30 days.

3. Click Search to view the list of events based on search criteria

LPR - Viewing Persona Based Events 
In R600 release LPR camera and events can be configured and viewed by a specific 
user based on the privileges granted. Earlier all the LPR alarms are displayed to 
logged in user irrespective of user privileges. In R600 user need to configure parti-
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tions and associate the required cameras to the partitions. These partitions can be 
assigned to specific user. The user will only be able to monitor the associated cam-
era and the events accordingly.

Secure video communication with Series 30 Cameras
Refer to the 800-25609-A_Honeywell 30 Series IP Cameras Network Security 
Guide for complete details.

MPEG2 Encoder Support with MAXPRO NVR and VMS
R600 supports legacy MPEG2 Encoders with Live and playback, Alarms and VMS in 
VMS functionalities. The following encoders are supported. 

• ENC8M2 

• VE8M2

Supported Firmware Version: 1.2.261
Supported Features are:

• Live

• Playback

• Export 

Mask Compliance Detection 
Mask Compliance Detection feature detects the people who are with and without 
Masks in a given scene. This feature detects in a real time scenario and generates an 
event for People with/without mask. It helps in monitoring the people those who are 
violating the compliance of not wearing a mask in public places. This feature 
requires dedicated license to configure and use. 

Recommended Operating Conditions For Mask Detection
Mask Detection algorithm is developed to detect people who are with and without 
Masks in live video.
This section provides recommended specifications that can provide good or better 
mask detection accuracies.
Recommended Operating Conditions

Parameter Specification

Camera height from the ground 8 – 10 feet
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Configuration parameters:

Note: To avoid false alarm please follow the operating condition and keep confidence level 
more the 80%.

Note: For VM machines it is recommended to use Xeon E5-v3, E5-v4, Bronze, Silver, Gold 
VM machines.

Camera field of view and 
orientation/tilt

Mounting should be suitable to obtain frontal face images. 
H-FOV should not more than 60 degrees.
Ceiling mounted or overhead mounted cameras which have 
near vertical view of faces looking down is not 
recommended for the application.
Bright light in the background or sunlight which results in 
poor image quality of face in not recommended.
Wide angle camera with long field of view is not 
recommended.

Image quality Full HD 2M pixel camera video streams with high bitrate (5 
to 8 Mbps for 30fps) with no blur and good focus. For 3MP 
cameras the recommended bit rate 10 to 15 Mbps.
Good quality video encoding should be used (H.264/H.265)

Illumination 100-150 lux (uniform illumination on both sides of face)

Face pose for MD Frontal pose can have +/-45 deg variation

Detection Distances Maximum distance from camera 15 feet along the ground. 
Highly preferred that people enter into the field of view from 
distances not more than 15 feet and there is no clutter or 
moving objects (prefer a static background such a wall so 
that false detections are avoided)

Parameter Specification

Minimum Size of the face with 
Mask

50 x 50 Pixels

Minimum Confidence level 
recommended

40%
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How to configure Mask Detection in NVR
1. Navigate to the Camera tab > camera properties and then click the Configure 

Analytics button as highlighted below.

The Analytics Configuration dialog box is displayed as shown below:

2. From the Analytics Type drop-down list, select Mask Detection.
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3. Select the Enable Mask Detection Analytics check box as shown below.

4. Type the Confidence Level in the box provided.

5. Type the Alarm Setting > Hold Time (Sec).

6. Under Event Settings, select the Include an event if mask is detected check and 
then click Save. By default this is not selected. User can select this check box if 
event is required only with mask.

7. Navigate to NVR Preferences > Rendering Setting tab and select the View 
Annotations When a Camera is displayed check box as shown below.

A sample configured Mask detection feature is shown below.
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Recommended field of view examples:
Following series of images represents the sample FOV with different resolution and 
FPS combinations.
Figure 1: 

Figure 2: With 1920x1080
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Examples of Not Recommended Operating Conditions
Below series of figures explains the non recommending conditions for Mask detec-
tion.
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Condition 1: Bright background with face is recognized as rear due to insufficient 
light on face. (Also people at distances won’t be detected due to smaller size and this 
can be perceived as failures).

Condition 2: Generally poor lighting on face and one of the faces recognized as rear 
due to insufficient lighting.
Condition 3: Nearly overhead view causing missed detection

Social Distancing Violation Detection 
Social Distancing Violation detection feature detects distance between two people 
and raises an alarm if the social distance norm is violated. This feature helps to 
ensure social distancing is followed in your premises. This feature requires dedicated 
license to configure and use.

Recommended Operating Conditions For Distancing Violation detection
This section provides specifications of the conditions that can provide a good or bet-
ter social distancing solution with respect to camera placement and operating con-
ditions requirements.
Required operating conditions can be divided in two sections as explained: 

• Conditions for person detection 

• Conditions for calibration selection of ground plane.

Person Detection Conditions
Below figures explains different preferred camera placements and conditions for 
person detection. It is to be noted that the numbers given in the figures are approxi-
mate and can vary:
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Placement 1: Normal Perspective View

This placement explains that the person recognition can be good till around 30 feet, 
when the camera placement is < 8 feet (given that average height of person is 
between 5-6 feet), and when the person is at approximately 20-30 feet from the 
camera. Also, lighting should be > 250 lux and the light should be falling on the per-
son with no back lighting for better accuracies.

Placement 2: Camera at a higher height or ceiling height
This placement explains the configuration wherein the camera is placed at a much 
higher height than the person. 
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If the camera height is as shown in the above figure, the FR accuracies can be 
reduced with distance. But at lesser distances from camera (<10-12 feet), FR can be 
accurate enough. Again, adequate amount of light falling on the face for good fea-
tures is an important requirement.

Placement 3: Camera at higher height from the ground

In this placement the camera height is nearly overhead, the person detection model 
is not tested when there is just head and shoulders view in the video stream. It is rec-
ommended that silhouette of the person is seen.

Calibration Conditions
Calibration is the most important step for distance measurement between two peo-
ple. The primary requirement of this step is that the ground plane on which distances 
between people are measured and the ground plane that is calibrated should be the 
same. Details of this statement in form of figures are given in this section.

Condition 1: Camera Perspective View with one ground plane

This condition details the meaning of ground plane being at the same level. The level 
of the ground where people are moving and the measurement for social distancing 
should one planar level. This is the most important requirement for accuracies of 
calibration. The configuration is done on Ground Plane Level 1 and Social distancing 
output will be done on this plane only. Stairs are not counted for the solution.
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Condition 2: Multiple ground planes
This conditions gives the sketch wherein there are people moving on the pathway 
(one ground plane level) and a staircase too. The staircase is of different ground 
plane level when compared to the pathway ground nearby. Hence the current solu-
tion calibration can be done on the pathway and NOT on the stairs. Our solution will 
not address output for people on the stairs

Condition 3: Multiple Ground Planes with slope as the second plane
This condition explains a sketch wherein the stairs in Condition 2 is replaced by a 
slope. Even in this situation, our solution will not give correct results on the slope. 
The calibration needs to be done on Ground Plane 1 and results also will be for 
ground plane 1.
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Alarm Generation for Social Distancing
Below are the general operating conditions during which the social distancing 
alarms are triggered.

• SD Violation Alarm: This is the first instance where violations are found in 
camera view. This alarm will be raised after 5 seconds of continuous violations 
only.

• Hold time: This alarm is raised when violations have been stable for 'hold time' 
seconds. This can be configured from the NVR camera settings page.

Note: The above alarms are NOT different types of alarms but are configured as 'Social 
Distance Violation' alarm.

Recommended Specifications
Below table summarizes the different discussions in above sections. These condi-
tions are important for deployment to get better recognition accuracies.
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How to configure Social Distancing in NVR
Note: For VM machines it is recommended to use XEON E5-v3, E5-v4, Bronze, Silver, Gold 

VM machines for better results.

1. Navigate to the Camera tab > camera properties and then click the Configure 
Analytics button.

2. From the Analytics Type drop-down list, select Social Distancing as shown 
below.

3. Select the Enable Social Distancing check box.
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4. Under Define Floor Area, click Edit link to define Floor area. The Mark Floor Area 
screen is displayed.

5. Select the Unit from the drop -down list.

6. Under Calibration, mark the points on the screen to define the Width and 
Length as per your requirement. For example: Click four points on the screen to 
mark an area using Mouse. The selected area will be highlighted in Red borders 
as shown in the Reference Image.

Note: When you select the 4 points on the floor area, the distance between first two points 
(Point 1 and 2) should be always considered as Width. The other two points will be 
Length.
Distance measurements on ground plane to be measured accurately to get better 
results.

7. Similarly mark other areas based on the requirement and then click Done.The 
selected Dimensions are displayed in Analytics Configuration dialog box. 

8. For creating Non-Complaint Social Distancing Regions in region of interest 
(ROI), see How to create Multiple ROI’s in a camera View section for more 
information.

9. Under Alarm Settings, set the Hold Time for alarms in seconds. This is the 
duration for which the alarms is displayed.

10. From the Analytics Server drop-down, select the required analytics server you 
have configured to fetch the alarms

11. Click Save. 

12. Navigate to NVR Preferences > Rendering Setting tab and select the View 
Annotations When a Camera is displayed check box as shown below.
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13. Click Apply and OK to complete configuration

Support for Remote Analytics Server 
MAXPRO R630 released support for Remote analytics Server configuration for Mask 
and Social Distancing on i8700 Machines. This configuration is required if the exist-
ing systems are not capable to take up the load of Analytics and to avoid overshoot 
of CPU memory. Refer to the MAXPRO NVR R630 Installation and Configuration 
Guide on how to configure.

People Counting VMS Dashboard Utility 
VMS Occupancy Dashboard Utility allows you to track the number of people entered 
or exited from a specific area or premises or pathway. This utility helps to manage the 
space in commercial buildings to take appropriate actions based on the number of 
people entered or exited. The Occupancy Dashboard displays the Occupancy Sum-
mary and Trend based on the cameras configured and duration. This utility needs to 
be used along with MAXPRO VMS and HVA.
The actions are:

• Monitoring/Managing parking area/building

• Space management in big stadiums/shopping mall

VMS Occupancy Dashboard Utility contains two parameters as explained below:

• Configuration

• Configure Data Source: Allows you to setup database to connect the Trinity 
database. User can login through Windows authentication or install the SQL 
server standalone to connect.

• Group Devices: Allows you to mange camera groups such as associate/
disassociate cameras, create new camera group.

• Overview
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• Occupancy Dashboard: Displays the occupancy summary and trend with 
real time data in graphical format based on duration.

Configurations
The VMS Occupancy Dashboard Utility configuration includes the following:

1. Configuring the HVA in VMS. Refer to the MAXPRO VMS R630 Installation and 
Configuration Guide on how to configure.

2. Configure the Data Source. Refer to the MAXPRO VMS R630 Installation and 
Configuration Guide on how to configure.

3. Configure or Group the Devices. Refer to the MAXPRO VMS R630 Installation 
and Configuration Guide on how to configure.

4. Viewing the Occupancy Dashboard

Viewing the Occupancy Dashboard
1. Ensure you have configured the following before viewing the occupancy dash-

board. Refer to the MAXPRO VMS R630 Installation and Configuration Guide on 
how to configure the following:

• Configure the HVA in VMS

• Step 3: Setting the Video Analytics (ActivEye) Configuration Tool

• Configure the Data Source

• Configure or Group the Devices

2. Under Overview, click Occupancy Dashboard node. The Occupancy Dashboard 
is displayed on the right pane. All the camera and groups configured are 
displayed.

3. Select the required camera under a group or select the camera group. The 
Occupancy Trend and Occupancy Summary is displayed as shown below.
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4. Select the required duration (In Minutes, Hours, Days and Custom Date) from 
the drop-down list. The Occupancy Trend graph and the Summary is displayed 
accordingly as shown below.

Tips:

• Click Refresh to refresh the camera list.

• Click Auto Refresh to refresh the camera and duration accordingly.
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VMS in VMS support for Mask and Social Distancing Detection
MAXPRO VMS R630 release supports Mask and Social Distancing Violation Detec-
tion support for VMS in VMS scenario with Bounding boxes. User can view bounding 
boxes in both Master and Child VMS recorders. This enhancement allows user to 
track the Mask and Social Distancing alarms and events in a wide range of recorders 
For Master VMS both Alarm and events along with attributes are supported. For 
Child VMS attributes are not supported.
User need to enable View Annotations in Preference dialog box after configuring 
VMS in VMS. A typical example of how VMS in VMS scenario looks with Bounding 
boxes is shown below.

Faster Drag and Drop for MAXPRO NVR cameras in MAXPRO VMS 
client 

The time taken for the video to render in VMS client after drag and drop on to the 
video panel has been considerably improved. This feature requires a configuration to 
be enabled.

To enable this feature user need to configure the values in config files based on 32/
64 bit rendering modes. Refer to the MAXPRO VMS R630 Installation and Configu-
ration Guide on how to configure

Non-Complaint Social Distancing Regions
This feature helps user to create multiple zones in a single Region of interest (ROI) 
and track the social distance violation alarms based on each regions in VMS. 
This feature helps user to identify the areas in which the sub regions/areas of cam-
era views where the most number of Non-complaint social Distancing violations are 
happening.
In order to generate this alarm, user need to create at least one region. The system 
monitors the Social distancing violations and then monitors in to each region how 
many social distancing violations are occurred. The algorithm calculates the most 
violated regions and raises an alarm. This alarm is displayed in percentage of viola-
tion for a given time. This alarm is generated periodically every 5 hours (Configu-
rable). A maximum of 6 ROI’s can be created.

Note: User has to configure the Social Distancing first in order to configure this alarm. 

How to create Multiple ROI’s in a camera View
1. Select the Social Distancing check box.

2. Under Define Floor Area, click Edit link to define Floor area. The Mark Floor Area 
screen is displayed.
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3. Select Enable ROI check box. 

4. Click Add ROI and then mark the points on the screen to define the Width and 
Length as per your requirement. For example: Click four points on the screen to 
mark an area using Mouse. The selected area will be highlighted in Blue 
borders as shown in the Reference Image.

5. If any point of time to clear the ROI’s then click the Reset ROI button.

6. Click Done to complete.
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Viewing Non Compliant Social Distancing Region alarms in VMS
In Analytics tab you can view the Non Compliant Social Distancing Regions alarms 
as shown below.

Configuring Social Distancing ROI Duration and Show
User can configure the Registry entries to increase the duration of alarms genera-
tion for a specific time and highlight the same using color indication.

Following are the two parameters that are allowed to configure:

• sdGraphicROIDuration : The Non-complaint Social Distancing Regions 
alarm is generated for every 5 hours (By Default). The Value of this key  is in 
Minutes (By Default 300 Mins (5 hours))

• sdGraphicROIShow: This key is used for displaying when alarm occurs then 
in live view user can see the regions in specific color coding based on 
number of violations occurred. For example 

• the highest violated region more than 80% is RED

• 20 to 80 percent region violated is YELLOW

• the succeeding less value (Les than 0) is displayed in GREEN

Perform the below steps to modify the values:

1. Navigate to Computer\HKEY_LOCAL_MACHINE\SOFT-
WARE\WOW6432Node\Honeywell\TrinityFramework\RenderingServer

2. Locate sdGraphicROIDuration and then change the value (By Default 300 Mins 
(5 hours)).

3. Locate the sdGraphicROIShow and then change the color code value.
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A sample images of configured social distancing feature is shown below.
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Analytic Alarms In NVR
The below screen displays the list of alarms that are generated in NVR for Mask 
Detection, Social Distancing violation and Non-Compliant Social Distancing 
Regions features.
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Analytics Alarm Details and Attributes
• Right-click on the required alarm and then select Alarm Details option to view 

the details and attribute of an alarm.

• For Social Distancing Violation alarm

• For Mask Detection
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• For Non- Compliant Social Distancing Regions
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Mask Detection and Social Distancing in VMS
To view the same camera Mask and Social Distancing detections in MAXPRO VMS.

• Navigate to NVR Preferences > Rendering Setting tab and select the View 
Annotations When a Camera is Displayed check box a shown below.

• Once the above check box is enabled the Mask and Social Distancing features 
can be monitored in VMS as shown below.
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Analytics Tab
In VMS R670 release LPR tab is changed to Analytics tab to display LPR, Facial 
Recognition and Social Distancing Violation alarms in one place. You can view real 
time alarms fetched from the Analytics camera and take specific actions on the 
alarms.

Improvements to Analytics Tab
As part of core improvement in Analytics tab, user can now view the Social Distanc-
ing Non-complaint social Distancing Regions alarms which is configured based on 
different region of interest (ROI).
You can configure multiple ROIs in a given scene and monitor the individual Non-
complaint social Distancing Regions based on interest. 
In addition user can also view AllgoVision Recorder alarms that includes NonFacial 
and LPR alarms. User can view these additional alarms based on the configurations 
performed in NVR and VMS

You can perform the below in Analytics tab for Social Distancing Violation, Non-
complaint social Distancing Regions ROI, Mask Compliance Detection and LPR 
alarms:

• Viewing Alarm Details and Video

• Filtering Alarms

• Searching Alarms
MAXPRO®VMS R670 Operator’s Guide 259



 How to View Alarm Details and Video feed

1. In the Live Feed pane, click on the any alarm, the alarm details pane is dis-
played as shown below

2. Click the View Feed link in Alarm Details pane to view the video feed.

3. Similarly, click on the required FR alarm. The FR alarm details are displayed as 
shown below.
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4. Click  to view the details of both LPR and FR alarm as shown below.
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How to Filter Alarms

1. In Analytics tab click , the Filter pane is displayed as shown below.

2. To Filter alarms:

• From Analytics list, select the required analytics option.

• From the Detection Type list select the Category. White/Black listed/
Unknown).

• From the Camera list select the required camera for which the alarms should 
be filtered.

• From the Detection Sensitivity indication bar, move the slider to set the 
sensitivity on the scale of 0 to 100 in percentage.

3. Click Apply. A message Filter applied successfully is displayed and the specific 
alarms in Live Feed pane is displayed.
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How to Search Alarms

1. In Analytics tab click , the LPR Search dialog box appears as shown below.

2. In Search dialog box:

• Search By Keyword: Type the keyword to search the alarms

• From Analytics Type drop down list, select the required check box.

• From the Detection Type list select the Category. White/Black listed/
Unknown).

• From the Camera list select the required camera for which the alarms should 
be filtered.

• From the date and Time drop down lists, set the From and To date/time.

• From the Detection Sensitivity indication bar, move the slider to set the 
sensitivity on the scale of 0 to 100 in percentage.

3. Click Search to view the list of events based on search criteria.

Viewing Non-Compliant Social Distancing Regions Alarm
In Analytics tab you can view the Non Compliant Social Distancing Regions alarms  
based on ROIs as shown below.
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CHAPTER

5

MAXPRO®VMS R
GENERATING REPORTS
Overview
You can generate the following reports in the Reports tab:

Event History Report
The event history report can be generated for cameras, monitors, recorders, and 
switchers. The event history report lists the events related to a device during a time 
period. For example, for a camera, you can generate the event history report to 
know the occurrence of events like enabling of camera motion detection, starting 
of background recording, and others. You can select the device and list of events 
that you want to view while generating the report.

Operator Log Report
The operator log report can be generated to view the activities performed by users. 
The operator log report lists the activities performed by users during a time period. 
For example, creating clips, adding bookmarks, sending messages and other 
actions performed by a user. You can select the users and the list of activities you 
want to view while generating the report.

Failover Report
Allows you to generate the Failover report to view the list of Failovers occurred or 
performed in the system.

Enterprise Reports
Allows you to generate the Enterprise report for Site Status Overview and Ringbuf-
fer overview cnnected to the system.

Configuration report
The Configuration report can be generated to view the configurations done by 
users on each recorders.
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Recorder Health Reports
The Recorder health report can be generated to view health of all recorders in a 
system.

Analytics Report
Allows you to generate License Plate Report, Mask, Social Distancing, FR and Non-
Compliant Social Distancing Regions report . You can configure the search criteria 
based Date and time range to generate the report.

Generating the Event History Report
To generate the event history report

1. Click the Report tab.

2. In the Reports window, select the Event History Report. 

3. Click Show Report. The Event History Report dialog box appears.

Figure 4-1    Event History Report
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4. In the Date box, select the date for which you want to view the list of events. The 
following table lists the options in the Date box

5. From the Site drop-down list, select the required site. 

6. In the Device Types box, select the check box next to the type of device for which 
you want to generate the event history report. You can select more than one 
type of device. You can select the Select All check box to select all the device 
types. Based on the selection in the Device Type box, the list of devices appear 
in the Devices box. For example, if you have selected Video Inputs in the Device 
Types box, all the camera names appear in the Devices box.

7. In the Devices box, select the device for which you want to generate the event 
history report. The selected devices appear in the Selected Devices box. 

• To select a device 

Select the check box next to the device name and click . You can 

select more than one device. To select all the devices in the Devices box, click 
..

• To remove a device 

Select the check box next to the device name and click . You can 

select more than one device. To remove all the devices in the Selected 

Devices box, click .

8. In the Events box, select the events that you want to include in the event history 
report. The selected events appear in the Selected Events box.

• To select a device 

Select the check box next to the event name and click . You can 

Option Description

Today event history report for today's events.

Yesterday event history report for yesterday's events.

Last 7 days event history report for seven day's events.

Custom Date Range event history report between a start date and end date. The From 
and To boxes under Custom Date Range are enabled when you 
select this option. You can select the start date in the From box 
and the end date in the To box. 
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select more than one event. To select all the events in the Events box, click .

• To select a device 

Select the check box next to the event name and click . You can select more 
than one event. To select all the events in the Selected Events 

box, click .

.

9. Click Generate Report. The event history report is generated and appears in the 
display area. 
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Generating the operator log report
To generate the operator log report

1. Click the Report tab.

2. In the Reports window, select the Event History Report. 

3. Click Show Report. The Event History Report dialog box appears.

Figure 4-2    Operator Log Report

4. In the Date box, select the date for which you want to view the list of events. The 
following table lists the options in the Date box.

Option Description

Today operator log report for today's events.

Yesterday operator log report for yesterday's events.

Last 7 days operator log report for seven day's events.
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5. In the Operators box, select the check box next to the operators for which you 
want to generate the operator log report. You can select the Select All check box 
to select all the operators. 

6. In the Workstations box, select the check box next to the client workstations 
used by the operators selected in the previous step. Only the activities done in 
the selected workstations are listed in the operator log report. You can select 
the Select All check box to select all the workstations.

7. In the Activities box, select the check box next to the activities which you want 
to view in the operator log report. You can select the Select All check box to 
select all the activities.

8. In the Output Type box, select the type of operator log report you want to 
generate. You can select Tabular to view the operator log report in a table or 
Graphical to view the operator log report in a graph.

9. Click Generate Report. The operator log report is generated and appears in the 
display area.

Viewing, printing, and saving the report
You can use the following options in the toolbar on top of the report.

Custom Date Range operator log report between a start date and end date. 
The From and To boxes under Custom Date Range are 
enabled when you select this option. You can select the 
start date in the From box and the end date in the To 
box. 

Option Description

Icon Click to...

save the report. By default, the report is saved in Crystal Reports (.rpt) 
format. You can also save the report in Adobe Acrobat PDF (.pdf), Microsoft 
Excel (.xls), Microsoft Excel Data Only (.xls), Microsoft Word (.doc), and Rich 
Text (.rtf) formats. 

print the report. 

toggle the display of report names on the left of the display area. 

view the first page. 
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Generating Analytics report
The Analytics report can be generated to view the list of analytics Events generated 
during a specific time period.

To generate the Analytics report

1. Click the Report tab.

2. In the Reports pane, select the Analytics Report check box. 

3. Click Show Report. The Analytics Report dialog box appears.

view the previous page.

view the next page.

view the last page.

go to a page number.

search for text in the report.

to enlarge (zoom in) and reduce (zoom out) the report view.

to close the current view.

Icon Click to...
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4. In Report dialog box:

• Search By Keyword: Type the keyword to search the alarms

• From Analytics Type drop down list, select the required check box.

• From the Detection Type list select the Category. White/Black listed/
Loitering).

• From the Select Camera list select the required camera.

• From the date and Time drop down lists, set the From and To date/time.

• From the Detection Sensitivity indication bar, move the slider to set the 
sensitivity on the scale of 0 to 100 in percentage.

5. Click Generate Report to the report.
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CHAPTER

6

MAXPRO®VMS R
MACRO COMMANDS
Macro commands for cameras
A camera command is a macro configured to trigger actions on the camera in 
MAXPRO VMS. 

Command Format 

C<Camera ID> =^ <Command ID> ; <Parameter 1>; <Parameter 2>; <Parameter 3>

Camera Commands 
The following table lists the camera commands in MAXPRO VMS. 

Camera 
Command 
LibraryID

Camera Command 
Library 
Description

Parameter 
Description Example Remarks

201 Start User Defined 
Recording

[C1^201]
Starts user 
defined 
recording 
on camera 
1.

Starts 
recording on 
the particular 
camera.

202 Stop User Defined 
Recording

[C1^202]
Stops user 
defined 
recording 
on camera 
1.

Stops 
recording on 
the particular 
camera.

203 Enable Source [C3^203]
Enables 
camera 3. 

204 Disable Source [C3^204]
Disables 
camera 3.
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205 Enable Events [C3^205]
Enables 
events on 
camera 3. 

206 Disable Events [C3^206]
Disables 
events on 
camera 3. 

207 Enable VMD [C3^207]
Enables 
VMD on 
camera 3.

208 Disable VMD [C3^208]
Disables 
VMD on 
camera 3. 

209 Call Preset Param1 - 
Preset number

[C5^209;2]
Calls 
preset 2 of 
camera 5.

220 Start Alarm Recording Param1 - 
Event Source 
ID 
Param2 - 
Event Source 
Description
Param 3 - 
Alarm Level 
Param 4 - 
Event Severity
Param 5 - 
Recording 
Duration 
Param 6 - Pre-
Recording 
Duration 

[C1^220;1
00;Motion
Event;70;6
0;20;10]
 Records 
for the 
duration of 
20 
seconds 
with10 
seconds 
pre-
recording 
duration 
on camera 
1 when 
event 100 
occurs. 

Starts the event 
based 
recording when 
an alarm is 
triggered. For 
example, 
motion 
detection.

221 Stop Alarm Recording [C1^221]
Stops 
event 
recording 
on camera 
1.

Camera 
Command 
LibraryID

Camera Command 
Library 
Description

Parameter 
Description Example Remarks
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222 Start Continuous 
Recording

[C8^222]
Starts 
continuou
s recording 
on camera 
8.

223 Stop Continuous 
Recording

[C8^223]
Stops 
continuou
s recording 
on camera 
8.

142 Add Bookmark [C5^142]
Adds 
bookmark 
for camera 
5 at the 
current 
recording 
position. 

225 Set home position [C5^225]
Sets 
camera 5 
to its home 
position.

Camera 
Command 
LibraryID

Camera Command 
Library 
Description

Parameter 
Description Example Remarks
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Macro commands for monitors
A monitor command is a macro configured to trigger actions on a MAX-
PRO™ VMS monitor. 

Command Format 

M<Monitor ID> =^ <Command ID> ; <Parameter 1>; <Parameter 2>; 
<Parameter 3> 

For example, 

Set Monitor 1 (Viewer configured as Monitor1) to full screen. 

M1=^110; 1 

Monitor ID = 1 (Monitor configured with ID 1 in MAXPRO™ VMS digital 
Monitor configuration). 

Command ID = 110 (Full screen command). 

Parameter 1 = 1 (1 – Full screen on, 0 – Full screen off). 

M1=^ 111 

Monitor ID = 1 (Monitor configured with ID 1 in MAXPRO™ VMS digital 
Monitor configuration).

Command ID = 111 (Toggle full screen command). 

Monitor commands 
The following table lists the monitor commands in MAXPRO VMS. 

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions

16 Load the 
Device

Param1-Salvo 
ID Param2-
Panel ID 
Param3-
Camera 
Number 

[M1=^16;2
;1;20] 
Monitor 1 
switches 
to 2x2 
salvo 
(SalvoID is 
2) and 
loads 
camera 
20 on 
panel1. 

Select the 
camera onto 
panel on the 
viewer. 



102 Unload the 
Device

Param1-
Panel ID

[M1=^102;
2]
Unloads 
camera on 
panel 2 in 
monitor 1

Close camera on 
panel. 

103 Run the scan 
Sequences 

Param1-Salvo 
ID Param2-
Panel ID 
Param3-
Sequence 
Number 

[M1=^103;
2;1;4]
Switches 
monitor 1 
to 2x2 
salvo and 
loads 
sequence 
4 on panel 
1. 

Load the scan 
sequence. 

104 Select a panel Param1-
Panel 
Number

[M1=^104;
2]
Selects 
panel 2 on 
monitor 1.

Choose the panel 
on the monitor. 

105 Select a salvo Param1-Salvo 
Number

[M1=^105;
2]
Selects 
second 
salvo 
(2x2). 

Set a specific 
salvo 
arrangement on 
monitor. 

106 Select next 
salvo 

- [M@M=^1
06]
Selects 
next salvo 
on the 
keyboard 
for the 
current 
monitor.

Choose the next 
salvo 
arrangement. 

107 Select 
previous salvo 

- [M@M=^1
07]
Selects 
previous 
salvo on 
the 
keyboard 
for the 
current 
monitor. 

-

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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108 Select next 
panel

- [M@M=^1
08;1]
Selects 
next panel 
on the 
keyboard 
for the 
current 
monitor. 

Choose the next 
panel in the 
current salvo. 

109 Select 
previous panel

- [M@M=^1
09;1]
Selects 
previous 
panel on 
the 
keyboard 
for the 
current 
monitor.

-

110 Full screen Full Screen 
On and Full 
Screen Off 

[M@M=^1
10;1] 
Go to full 
screen on 
the 
current 
monitor. 
[M@M=^1
10;0]
Exit full 
screen on 
the 
current 
monitor. 

Set the salvo to 
full screen.

111 Toggle full 
screen

Toggle 
between full 
screen

[M@M=^1
11]
Toggles 
between 
full screen 
and 
normal 
mode on 
the 
current 
monitor.

Toggles between 
full screen.

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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115 Play Param1-
Number

[M@M=^1
15;0]
Plays 
video from 
the 
camera on 
the 
selected 
panel on 
the 
current 
monitor.

-

116 Pause Param1-
Number

[M@M=^1
16;0]
Pauses 
video from 
the 
camera on 
the 
selected 
panel on 
the 
current 
monitor.

-

117 Stop Param1-
Number

[M@M=^1
17;0]
Stops 
video from 
the 
camera on 
the 
selected 
panel on 
the 
current 
monitor. 

-

118 PlayBack Param1-Salvo 
ID Param2-
Panel ID 
Param3-
Camera 
Number 
Param4-
yy:mm:dd:hh:
mm:ss 
Param5-
yy:mm:dd:hh:
mm:ss 

[M@M=^1
18;0;0;4;1
0:02:02:0
4:45:56]
Displays 
video from 
camera 4 
on the 
selected 
panel on 
current 
monitor. 

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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121 SmoothReever
sePlayBack

Param1-
Panel 
Number 
Param2-
Numerator 
Param3-
Denominator 

[M2=^121;
1;8;1] 
Smooth 
reverses 
the video 
on panel 1 
with 8X 
speed

For example, 
speed 32, 
Param2 is 32 and 
Param3 is 1. 

124 FrameReverse Param1 - 
Panel 
Number 
Param2 - 
Speed (int 
values) 

[M@M=^1
24;0;1]
Rewinds 
one frame 
of the 
selected 
video. 

125 FrameForward Param1 - 
Panel 
Number 
Param2 - 
Speed (int 
values) 

[M@M=^1
25;0;1]
Forwards 
one frame 
of the 
selected 
video. 

126 Forward Param1 - 
Panel number 
Param2 - 
Numerator 
Param3 - 
Denominator 

[M@M=^1
26;0;2;1]
Forwards 
video with 
2x speed. 

For example, for 
speed 1/32, 
Param2 is 1 and 
Param3 is 32 

127 Rewind Param1 - 
Panel number 
Param2 - 
Numerator 
Param3 - 
Denominator 

[M@M=^1
27;0;1;2] 
Rewinds 
video with 
1/2x 
speed
.

For example, for 
speed 1/32, 
Param2 is 1 and 
Param3 is 32 

128 Toggle Text Param1 - 
Panel number

[M@M=^1
28;5]
Toggles 
text on 
panel 5

Toggle text 
displayed inside 
the video panel. 

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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129 JumpAbsolute Param1 - 
Panel 
Number 
Param2 - 
yy:mm:dd:hh:
mm:ss If it is a 
clip, Param1 - 
Panel number 
Param2 - 
Param3 - 
Position (1 to 
100) 

[M@M=^1
29;0;&1;1] 
Where 
[&1= 
=2011:06:
08:00:40:
00]

130 JumpRelative Param1 - 
Panel 
Number 
Param2 - 
dd:hh:mm:ss 
Param3 - 
Direction 

[M@M=^1
30;00:00:
15:00]
Jumps the 
video 15 
minutes 
from the 
current 
time in 
which it is 
being 
played.

Param3 - 1 
(forward)
Param3 - 2 
(backward)

131 Digital Param1 - 
Panel ID 
Param2 - 
Type Param3 
- Speed 

[M@M=^1
31;0;1;5] 
Zoom out 
on 
selected 
camera 
happens 
with 
speed 5

Param2: 0 - Zoom 
In Param1 - 
Zoom Out 
Param3 - Pan 
Left Param4 - 
Pan Right 
Param5 - Tilt Up 
Param6 - Tilt 
Down Param7 - 
Reset_ Param8 - 
Halt 

133 Surrounding 
Camera 

Param1 - 
Camera 
Number

[M@M=^1
33;@C]
Shows 
surroundi
ng 
cameras 
of the 
selected 
camera on 
the 
current 
monitor.

Show 
surrounding 
camera of the 
camera number.

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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134 Alarm Preview Param 1 - 
Alarm 
Reference ID

[M@M=^1
34;150]
Shows 
alarm 
preview 
for alarm 
150 on 
the 
current 
monitor. 

135 Play the Scan 
Sequence

Param 1 - 
Scan 
Sequence 
Number

[M@M=^1
35;1]
Plays scan 
sequence 
1 on the 
current 
monitor. 

1. To play the 
paused scan 
sequence. This 
macro will not 
load the 
sequence
2. This macro can 
be used without 
1st parameter 
[M@M=^135].

136 Pause the 
Scan 
Sequence

Param 1 - 
Scan 
Sequence 
Number

[M@M=^1
36;1]
Pauses 
scan 
sequence 
1 on 
current 
the 
monitor.

137 Stop the Scan 
Sequence

Param 1 - 
Scan 
Sequence 
Number

[M@M=^1
37;1]
Stops 
scan 
sequence 
1 on the 
current 
monitor.

138 Enlarge the 
Panel

Param 1 - 
Panel 
Number

[M@M=^1
38;8]
Enlarges 
panel 8 on 
the 
current 
monitor.

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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139 Show Salvo 
View

Param1 - 
Salvo View ID

[M5=^139;
6]
Shows 
salvo view 
6 on the 
monitor 5.

Select the user 
configured salvo 
view. (Right-click 
Show Device ID 
in the Viewer 
Device tree to see 
salvo view ID).

140 Capture Salvo 
View Image

[M10=^14
0;0]
Captures 
salvo view 
image on 
the 
monitor 
10 and 
saves it in 
the 
default 
path. 

The image is 
stored in the 
default path if the 
shared folder 
path is not 
mentioned.

141 Save Image Param 1 - 
Panel 
Number 
Param 2 - 
Shared Folder 
Path

[M2=^141;
2;\\image
store\m2i
mages\\]
Saves 
panel 2 
image in 
\\imagest
ore\ path. 

144 Enables Sync 
Playback

Param 1 - Not 
Applicable
Param 2 - 
yy:mm:dd:hh:
mm:ss

[M@M=^1
44;1;2010
:01:25:16:
25:30]
Enables 
sync 
playback 
at 4 hours 
25 
minutes 
and 30 
seconds 
on 
January 
25 2010 
on the 
current 
monitor. 

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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145 Disables Sync 
Playback

- [M@M=^1
45;1]
Disables 
sync 
playback 
on 
monitor 1. 

150 Alternate 
Camera

Param 1 - 
Camera 
Number

[M@M=^1
50;@C]
Displays 
video from 
current 
camera's 
alternate 
camera. 

Monitor 
Command 
LibraryID

Monitor 
Command 
Library 
Description

Parameter 
Description Example Instructions
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Macro commands for devices
A device command is a macro configured to trigger actions on the devices in MAX-
PRO™ VMS. 

Command Format 

D<MasterDevice ID> =^ <Command ID> ; <Parameter 1>; <Parameter 2>; 

Device commands 
The following table lists the devices commands in MAXPRO™ VMS.

Device 
Command 
LibraryID

Device 
Command 
Library 
Description

Parameter 
Description Instructions

254 Command 
Template

Param1 -Command 
Template ID
Param2 -Station ID 

To execute the command 
template of Enterprise 
recorder.
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Macro error definition 
Macro errors are displayed as a warning message on the currently 
selected monitor for a period of two seconds following the error condition 
that occurred. It is recorded in a text file called ERRORLOG.MAX (on the 
system disk) together with a macro trail to help identify the cause of the 
macro error.

The following table lists the macro error numbers. 

Macro 
Number Error

1 Format error in extended command.

2 Format error in conditional command.

3 Unknown command in expression evaluation.

4 Unknown command in update expression 5 Numeric.

5 Numeric variable range error.

6 Scan sequence range error.

7 External alarm range error.

8 Auxiliary control output range error.

9 Invalid numeric evaluation error.

10 Macro timer range error.

11 Macro timer command error.

12 Macro timer period error.

13 System macro range error.

14 Unknown video output channel.

15 Unknown video input source.

16 Invalid external alarm control logic.

17 Invalid auxiliary output control logic.

18 Invalid camera disable logic.

19 Invalid speed.

20 Unknown system constant error.

21 Unknown text message command error.

22 Invalid operator sign used with commands.

23 Invalid keyboard identification number.

24 Invalid alarm stack entry that is not an alarm macro.

25 Invalid alarm display group (1 to 50) only.



26 Macro string exceeds 255 characters.

27 Conditional statement missing closed brackets.

28 Invalid real time clock time or date definition.

29 Invalid video source command.

30 String variable command format error.

31 String variable range error.

32 Unknown evaluate command for string.

33 Too many nested do-while loops.

34 Format error in do-while loop.

35 Maximum loop cycles has been exceeded.

36 Keyboard priority range error.

37 Invalid keyboard identity for macro numeric input command.

38 Invalid destination for keyboard macro numeric input command.

39 Too many digits requested for keyboard macro numeric input.

40 Invalid scan clear command.

41 No dynamic macro timer available.

42 User flag range error (0 to 8 only).

43 Keyboard operator range error (0 to 100 only).

44 User defined character range error, in direct comm port writes.

45 Undefined comm port number, in direct comm. port writes.

46 Internal change network source.

47 Internal change network source node command format error.

48 Scan sequence entry number is out-of-range that is greater than (99).

49 Error in command format received from a subrack/keyboard. 

50 Parity error in received data from a subrack/ keyboard. 

51 Range error in Blank Channel command (valid 0 - 3 only). 

52 Unknown Special WORD command. for example, <WARM-BOOT> etc.

53 Other errors detected during Cold/Warm Boot. Check ERRORLOG.

Macro 
Number Error
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Numeric system constants

Numeric System 
Constants

Description

@B Current Camera is or Not Return values: 0 -Fixed Camera 1- Camera.

@C Current video source selection, type/logical reference (0—
999999999).

@D Last used dynamic timer number (99 down to 0).

@E Last macro error number (0=none, to 53).

@F Alarm display group number, (0 to 50) . 

@H current logical alarm device number.

@I Current selected panel on Digital Monitor, if current monitor is 
analog it returns 0.

@I.X Current Camera on Panel X Return values: Camera that is playing on 
Panel X. Usage: [*E=I.2] displays camera number on panel 2. If panel 
doesn’t have a camera then displays 0. 

@K Current keyboard id number, (1 to 1001), (1001=alarm macro 
keyboard id).

@L Current Camera Signal type. Return values: none=0, analog = 1, 
digital = 2, hybrid = 3. 

@M Current monitor selection, READ-ONLY, (0=no monitor selected).

@N Current camera’s net-source network node number (0 —99).

@O Current keyboard operator number, (1 to 99), (0=logged off).

@P Current operator priority level, (0 to 64); (can not be changed from 
0).

@Q Current monitor menu status, TRUE=menu-display-active.

@R Current camera’s net-source type and logical reference (0.9999)

@S Scan status for the current monitor, TRUE=scanning.

@U Contains the number of the alarmed device. In case of camera and 
recorder it is the callup number. In case of I/O (Max/VB or TDI) it’s 
the Global ID. 

@V Macro event type, video-fail, site fail, VCR alarm, keyintercept, etc; 
Refer to the table in MAXPRO VMS Online Help for interpretation of 
@V.

@W Contains the type of the alarmed device. Camera is 1, Recorder is 4 
as per enum TDA_DEVICE_TYPE. I have added another device type 
to distinguish between Max/Vb IO and TDI IO. A new device type 
called ANALOG_INPUT = 22 has been added.
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@X Current Salvo Number on Digital Monitor, if current monitor is 
analog it returns 0 Return values: Salvo Number.

@Z  speed value (0 — 6).

Numeric System 
Constants

Description
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CHAPTER

7

MAXPRO®VMS R
UTILITIES AND TOOLS
Verifying the Digital Certificate for Clips
A clip saved with digital signature can be verified using the MAXPRO VMS Digital 
Certificate Verification Utility. 

The MAXPRO VMS Digital Certificate Verification Utility is installed by default 
along with all MAXPRO VMS Client. This utility can be installed on a computer that 
does not has MAXPRO VMS. A separate installation setup package for this purpose 
is provided in the tools folder of MAXPRO VMS DVD (\Tools\HVMS Digital Certifi-
cate Verification Utility\HVMS Digital Certificate Verification Utility.exe). You can 
install this utility and verify the digital certificate for clips on any computer.

To verify the digital certificate 

1. Choose Start>Program>Honeywell>MAXPRO™ VMS Package Verification Util-
ity. The MAXPRO™ VMS Digital Certificate Verification Utility dialog box 
appears. 

2. From the File menu, click Open Package or click Open Media File. 

3. Browse to the folder, select the package or the media file for which you want to 
verify the digital certificate, and then click Open. The default path would be 
C:\Program Files\Honeywell\TrinityFramework\ImagesAndClips.

4. The Authentic package: MAXPRO™ VMS digital certificate found message 
appears if the clip is saved with digital signature and if the digital certificate is 
valid.
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MAXPRO VMS Agent
MAXPRO VMS client Agent helps you to export log, launch monitors, and back up 
database (only on server). The MAXPRO Client Agent runs automatically during 
Windows startup. Exporting log includes exporting MAXPRO VMS log files, DVM 
log files, Windows System and Applications Event log, and General Workstation 
Configuration Info log. 

To launch monitors

1. Right-click  in the notification area, and then choose Launch >Monitor N 
(Where N represents the monitor number). If you want to launch all the moni-
tors, then click All. Monitors have to be configured using the options available 
in the Configurator tab.

Note: If a monitor(Monitor 1) is already launched and if you again launch the same monitor 
again from the Client agent, a new instance of the monitor is not launched; instead 
the focus is shifted to the same monitor, which is already running.

To export log 

1. Right-click in the notification area, and then choose Diagnostics >Export 
Log. A zip file named MaxproVMS_Log_Workstation_X (where X is the name of 
the computer) is exported to C:\Program Files\Honeywell\TrinityFramework.

Note: The disk drive might vary depending on the installation of MAXPRO VMS. 

To backup database 

1. Right-click  in the notification area, and then choose Diagnostics >Backup 
Database. The database file named TrinityDatabase_WorkstationName_Date-
Time.bak (where WorkstationName is the name of the workstation and Date-
Time is the date and time when the file is exported) is exported to C:\Program 
Files\Microsoft SQL Server\MSSQL.2\MSSQL\Backup. 

Note: The disk drive might vary depending on the installation of MAXPRO VMS. 
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